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Introduction

Technologies are constantly evolving, and as .NET developers we need

to cope with the latest or at least with what’s popular nowadays. At the
beginning, you might find yourself having a hard time catching up with the
latest technologies due to confusion about what sets of technologies to use
and where to start. There are tons of resources out there that you can use
as areference to learn, but you still find it hard to connect the dots in the
picture. Sometimes you might even think of losing the interest to learn and
giving up. If you are confused and have no idea how to start building an
iOS or Android mobile application from scratch and how to connect your
app with your database and API, then this book is for you.

Keep in mind that this book highlights only the basic implementation
of a mind/memory game type of mobile application. If you are looking for
an action, adventure, card, RPG, or sports type of game app development,
then this book is not for you.

Understanding Game Development with Xamarin.Forms and ASP.
NET will walk you through how to build a simple data-driven mobile game
application using the power of Xamarin.Forms and Web API. We will also
build a real-time leaderboard page using ASP.NET MVC and SignalR.

This book covers topics from creating a SQL database from scratch,
to building the Web API endpoints, to making a mobile application that
targets both iOS and Android, to building a real-time leaderboard page for
player rankings, deployment, and testing, and finally down to publishing
your code to GitHub.

The goal of this book is to guide .NET developers who might become
interested in mobile application development if they discover the need
for a simple working game application that requires some kind of feature
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that connects data from a mobile app to other services such as a REST
application or a web application.

This book is targeted for beginners to intermediate .NET developers
who want to jump into mobile application development with Xamarin and
get their hands dirty with practical examples.

I've written this book so that it’s easy to follow and understand by
providing step-by-step processes with as many detailed code explanations
as possible. As you go along to the end of the book, you will learn the basic
concepts and fundamentals of each of the technologies used for building
the whole application and how they connect to each other.
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Introduction

Technologies are constantly evolving, and as .NET developers we need to
cope with the latest or at least what’s popular nowadays. At the beginning,
you might find yourself having a hard time catching up with the newest
technologies due to confusion about what sets of technologies to use and
where to start. There are tons of resources out there that you can use as
areference to learn, but you still find it hard to connect the dots in the
picture. Sometimes you might even think of losing the interest to learn and
giving up. If you are confused and have no idea how to start building an
iOS or Android mobile application from scratch and how to connect your
app with your database and API, then this book is for you.

Keep in mind that this book highlights only the basic implementation
of a mind/memory game type of mobile application. If you are looking for
an action, adventure, card, RPG, or sports type of game app development,
then this book is not for you.

This book, Understanding Game Application Development with
Xamarin.Forms and ASP.NET, will walk you through how to build a simple
data-driven mobile game application using the power of Xamarin and
Web API. We will also build a real-time leaderboard page using ASP.NET
model-view-controller (MVC) and SignalR.

This book covers topics from creating a SQL database from scratch,
to building the Web API endpoints, to making a mobile application that
targets both iOS and Android, to building a real-time leaderboard page for
player rankings, and finally down to deployment.

© Vincent Maverick S. Durano 2019 1
V.M. S. Durano, Understanding Game Application Development,
https://doi.org/10.1007/978-1-4842-4264-3_1



CHAPTER 1  INTRODUCTION

The goal of this book is to guide .NET developers who might become
interested in mobile application development if they discover the need
for a simple working game application that requires some kind of feature
that connects data from a mobile app to other services such as a REST
application or a web application.

This book is targeted for beginners to intermediate .NET developers
who want to jump on mobile application development with Xamarin and
get their hands dirty with practical examples.

I've written this book so that it’s easy to follow and understand by
providing step-by-step processes with as many detailed code explanations
as possible. As you go along to the end of the book, you will learn the basic
concepts and fundamentals of each of the technologies used for building
the whole application and how each of them connects to each other.

Roadmap
Chapter 1

Chapter 1 presents an overview of who this book is for and a short
backgrounder about which sets of technologies will be used to build the
web and mobile applications as well as why we choose to use them. It also
gives a brief overview of “Working Memory,” which is the type of game
application that this book is going to cover. This chapter highlights the
topics of what the reader will learn from the book. It also highlights a brief
overview of Xamarin.Forms, ASP.NET Web API, MVC, SignalR, and Entity
Framework (EF) and discusses how to connect them all together to achieve
a goal. It also talks about the required tools and framework needed to build
the application as well as provides instructions on how to configure and
install them on your development machine.
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Chapter 2

Chapter 2 provides a game overview and discusses application flow,
creating and running the core mobile application projects using Xamarin.
Forms, and installing the required NuGet packages for the applications.
The application flow section discusses the process by which the system
handles the requests from one application layer to another starting from
account creation/login down to playing the game, syncing data in real
time, and ultimately persisting the changes in the database. The game
overview section deals with the mechanics and objective of the game.

Chapter 3

Chapter 3 contains information about data access configuration using EF
as well as building REST API endpoints using ASP.NET Web API. The first
section of this chapter discusses database creation. The second section
describes the steps to integrate EF into the Web API project and then set
up a data access layer for implementing create, read, update, and delete
(CRUD) operations. The third section of this chapter considers the creation
of REST API endpoints, how to enable cross-origin resource sharing
(CORS), and finally how to test the endpoints.

Chapter 4

Chapter 4 contains the actual implementation of the mobile application
using Xamarin.Forms. This chapter is the core of the book, as it discusses
the detailed steps and procedures for building the Working Memory game
application targeting both Android and iOS platforms. The step-by-step
procedure and breaking the code into sections with explanations should
give readers a better understanding of how the application works.
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Chapter 5

Chapter 5 discusses building a real-time leaderboard page using ASP.
NET MVC and SignalR, with a detailed explanation of how real-time
communication works for the project.

Chapter 6

Chapter 6 discusses the steps and procedures for how to deploy and test
the mobile apps in platform-specific device emulators using the Conveyor
plug-in and the SharpProxy tool.

Chapter 7

Chapter 7 walks you through how to push your application code to GitHub
using Visual Studio 2017, and it also contains the source code link and
resource references used in this book.

Background

Years ago, I was tasked to create a proof-of-concept application about
“Working Memory” in a form of a mobile app game and at the same time
provide a web app that displays leaderboard. I was a bit nervous and at
the same time curious about it, since building a mobile application isn’t
really my area of expertise. Having the opportunity to work with mobile
applications, particularly game development, is very exciting, as this is
getting more popular nowadays. Building mobile apps or even wearable
apps is not as complex as you may think. Using the right tools and
technologies makes life easier for us to build mobile apps and prototypes.

Ermm..., the right tools and technologies?

Yes! Specifically, I am referring to the awesome Xamarin.
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Xamarin allows you to build cross-platform apps for Android, iOS, and
UWP, and it uses C# as the back-end language. Xamarin also introduced
Xamarin.Forms, which allows you to easily create native user interface (UI)
layouts that can be shared across Android, iOS, and Windows phones. As
long as you know C#, creating the logic for your app is easy because you
will already be familiar with the syntax and most of all the .NET libraries.
The only learning curve when transitioning from web to mobile is that
you will need to know and understand how Android, i0S, and Windows
platforms work and how each framework interprets stuff. I have decided to
use Xamarin, ASP.NET, and Visual Studio for the following reasons:

o Xamarin is now fully integrated with the latest Visual
Studio release (VS 2017 as of this time of writing).

e Xamarin allows you to build cross-platform apps (iOS,
Android, and UWP) using C#.

e Iam an experienced C# developer.
e Tam an experienced ASP.NET developer.
¢ Tam more familiar with Visual Studio development tools.

o Idon’tneed tolearn how to use other frameworks,
editors, tools, or programming languages to build
native apps.

o I can take advantage of the cool features provided by
Xamarin, such as cloud testing and app monitoring.

e Xamarin and Visual Studio are quite popular and stable
platforms for building real-world apps.

e Xamarin has its own dedicated support site, so when
you encounter any problem during your development,
you can easily post your query to their dedicated
forums.
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I'm writing this book so anyone interested in mobile application
development can refer to it if they need a simple working game application
that requires features that connect data from a mobile app to other
services such as a REST application or web application. This book will
walk you through on building a simple Working Memory game application
using the power of Xamarin and ASP.NET.

Before we dig down further, let’s talk a bit about Working Memory.

WHAT IS WORKING MEMORY?

According to the documentation, Working Memory is a cognitive system with

a limited capacity that is responsible for temporarily holding information
available for processing. Working Memory is important for reasoning and the
guidance of decision-making and behavior. We can say that Working Memory
is a crucial brain function that we use to focus our attention and control our
thinking. For more information, please see the References section at the end of
this book.

What You Will Learn

This book is targeted for beginners to intermediate .NET developers who
want to build a data-driven mobile application that connects to other
services from scratch and get their hands dirty with practical examples.
I've written this book to be easy to follow and understand. As you go along
to the end, you will learn the following:

e The basic concepts and fundamentals of the relevant
technologies used for building entire applications.

e How to download and install the required tools and
development framework.


https://en.wikipedia.org/wiki/Working_memory
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How to set up a SQL Server database from scratch.

How to build a simple Working Memory game
application using Xamarin.Forms that targets both iOS
and Android platforms.

How to create an ASP.NET Web API project.
How to integrate EF as our data access mechanism.
How to create an ASP.NET MVC 5 project.

How to integrate ASP.NET SignalR within the ASP.NET
MVC application.

How to invoke a SignalR Hub client proxy from a Web
API project.

Deploying and testing the applications in platform-
specific device emulators.

Pushing your code to GitHub using Visual Studio 2017.

Prerequisites

Before you read any further, make sure that you have the necessary

requirements for your system and that your development environment

is properly configured. This demo uses the following platform and

frameworks:

Windows 10

Visual Studio 2017

SQL Server Express Edition 2017

SQL Server Management Studio (SSMS) 17.9

Xamarin 4.11
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e ASP.NET Web API 2
e ASPNETMVCS5
e ASP.NET SignalR 2.2
e« EFG6
Basic knowledge of the following languages and concepts is also required:
o C#
e SQL
e JavaScript/jQuery
e AJAX
e« HTML
o XAML (eXtensible Application Markup Language)
e HTTP Request and Response
¢« OOP

Development Tools Download Resources

You can download Visual Studio and SQL Server Express edition at the
following links:

Windows

e www.visualstudio.com/downloads/

e www.microsoft.com/en-us/sql-server/sql-server-
editions-express


http://www.visualstudio.com/downloads/
http://www.microsoft.com/en-us/sql-server/sql-server-editions-express
http://www.microsoft.com/en-us/sql-server/sql-server-editions-express
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Mac

o https://code.visualstudio.com/download

e www.visualstudio.com/downloads/ (Visual Studio
for Mac)

o https://database.guide/how-to-install-sql-
server-on-a-mac/

Installation Guide

For this demo, I'm going to develop the application on a Windows

10 machine, as I am more familiar and comfortable building .NET
applications in a Windows environment. If you are on Mac, then follow the
download link mentioned in the preceding “Development Tools Download
Resources” section.

Visual Studio 2017

Microsoft Visual Studio is an integrated development environment
(IDE) from Microsoft. It is used to develop computer programs as well as
websites, web apps, web services, and mobile apps. The latest version of
Visual Studio is now a full-featured IDE for Android, iOS, Windows, web,
and cloud, which makes it a comfortable and powerful choice for building
applications in the context of .NET.

Let’s go ahead and download Visual Studio via this link:
https://visualstudio.microsoft.com/downloads/. Once youland on
the download link, you should be presented with the following page:


https://code.visualstudio.com/download
http://www.visualstudio.com/downloads/
https://database.guide/how-to-install-sql-server-on-a-mac/
https://database.guide/how-to-install-sql-server-on-a-mac/
https://visualstudio.microsoft.com/downloads/
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% Oownioads | IDE, Code & Tesm % | +p

<« C @ hitps//visualstudio.micresoft.com/downloads/

B Microsoft | Visual Studio eroducts . Downloads  More - Al Migraset

Sign in

Downloads

Visual Studio 2017
n Full-featured integrated development environment (IDE) for Andreid, 105, Windows, web, and cloud
Version: 158 Community Professional

Enterprise
Release notes Powerful IDE, free for students, open- Professional IDE best suited to small Scalable, end-to-end solution for teams
source contributors, and individuals teams of any size
Compare editions

How to install offline

Cownioad Preview Cownicad Preview Download Preview

Visual Studio Code
w The fast, free and open-source code editor that adapts to your
needs 2

xading and using % Studio
1o the bcense terms and

-

]

2

-]

3

¢
R nat g
Release notes 4

Figure 1-1. Visual Studio official download site

Choose the version that you want to use and click the download

button; it should download one of the following Visual Studio installers
into your machine’s drive:

o vs_enterprise.exe for Visual Studio Enterprise
o vs_professional.exe for Visual Studio Professional
L]

vs_community.exe for Visual Studio Community

10
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The installer should include everything you need to both install and
customize Visual Studio. Now go ahead and double-click the installer that
you've downloaded to start kicking the bootstrapper. If you are prompted
with a user account control notice, just click Yes.

It will then ask you to acknowledge the Microsoft license terms and the
Microsoft privacy statement.

Visual Studio

To learn more about privacy, see the Microsoft Privacy Statement.

By continuing, you agree to the License Terms.

Figure 1-2. Visual Studio license terms agreement

Click Continue to proceed with the installation.

After the installer is installed, you should be presented with the
following view to customize your installation by selecting the feature sets
or workloads that you want.

11
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Workloads Individual components Language packs Installation locations

Web & Cloud (7)

Build web apglications using ASP.NET, ASP.NET Core Azure SDKs, tools, and projects for developing cloud apps.
HTML/JavaScript, and Containers including Docker support creating resources, and building Containers including...

‘ @ ASPNET and web development /& Azure development

P Python development

Editing, debugging, interactive development and source

Nodejs development
Build scalable network applications using Nodejs, an

control for Python, asynchrongus event-driven lavaScript runtime.
Data storage and processing LI!II Data science and analytical applications
Connect, develop, and test data solutions with SQL Server, Languages and toaling for creating data science

Arzure Data Lak

or Hadoop. applications, including Python, R and F=.

u Office/SharePoint development
Create Office and Sharefoint add-ins, SharePoint sclutions.
and V5TO add-ins using C#, VB, and JavaScript

Mobile & Gaming (5)

Q Mobile development with .NET Game development with Unity
Build cross-platform applications for iDS, Android or Create 20 and 3D games with Unity, a powerful cross-
Windows using Xamarin, platform development environment.

Figure 1-3. Workload selections
For building the application in this example, we need to select the
following workloads:
e ASP.NET and web development
o Data storage and processing
e Mobile development with .NET

After you select the required workloads, click the Install button.
A screen should appear showing the status and progress of the installation.
After the new workloads and components are installed, you may click
Launch to start using Visual Studio.

12
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SQL Server 2017

Microsoft SQL Server is a relational database management system
developed by Microsoft. As a database server, it is a software product with
the primary function of storing and retrieving data as requested by other
software applications (desktop, service, mobile, or web), which may run on
either the same or another computer across a network or the Internet.

For simplicity, I'm just going to use the Expression edition of SQL
Server 2017 because we will just be creating a basic database with simple
tables and storing only a minimal amount of data.

Go ahead and download the SQL Server Express edition at this link:
www.microsoft.com/en-us/sql-server/sql-server-editions-express.
You should be presented with the following page:

B® SOLServer 2017 Express Editon X 4

« C @ nttpsy/www.microsoft.com/en i-ser erver-editions-e e * @ :

=’ Microsoft I Data platform Products Solutions Downloads  More Try SQOL Server 2017 All Microsoft 2

SQL Server 2017 Express edition

Build small, data-driven web and mobile applications up to 10 GB in size with this free,

entry-level database.

Download now & More editions >

Why choose the Express edition?

Figure 1-4. SQL Server official download site
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Click the Download now button, and it should download the following
SQL Server 2017 Express installer into your machine drive:

o SQLServer2017-SSEI-Expr.exe

Run the SQLServer2017-SSEI-Expr.exe installer, and it should show a
screen that looks like this:

SQL Server 2017
Express Edition

Select an installation type:

Basic

Figure 1-5. SQL Server installation selection

14
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Just select the Basic installation type, and it should take you to the
following screen and ask you to accept the Microsoft SQL Server license terms:

SQL Server 2017
Express Edition

Microsoft SQL Server License Terms
MICROSOFT SOFTWARE LICENSE TERMS
MICROSOFT SQL SERVER 2017 EXPRESS

These license terms are an agreement between Microsoft Corporation (or based on where you live, one of its
affiliates) and you. Please read them. They apply to the software named above, which includes the media on which
you received it, if any. The terms also apply to any Microsoft

updates,
supplements,
Internet-based services, and

support services

for this software. unless other terms accompany those items. If so, those terms apply.

BY USING THE SOFTWARE, YOU ACCEPT THESE TERMS. IF YOU DO NOT ACCEPT THEM, DO NOT USE THE
SOFTWARE.

We collect data about how you interact with this software. This includes data about the performance of the services,
any problems you experience with them, and the features you use. This also

By cli ® button, | ack e that | accept the L

Figure 1-6. SQL Server license terms agreement
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Click Accept. It should now take you to the following screen:

SQL Server 2017
Express Edition

Specify SQL Server install location

Figure 1-7. SQL Server specify install location

Select the target location for installing the SQL Server. If you are
satisfied with the default install location or your current selected install
location, then go ahead and click Install.

16
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The next screen should display the installation status and progress just
like in the following figure:

SQL Server 2017
Express Edition

Downloading install package...

Acquiring rules engine.. 5.795 MB / 7.751 MB 13.532 Mbps

Figure 1-8. SQL Server installation progress
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You may need to wait a few minutes to complete the installation. Once
the installation is done, you should be presented with the following screen:

SQL Server 2017
Express Edition

Installation has completed successfully!

COMNMNECTION STRING

FEATURES INSTALLED INSTALLATION MEDIA FOLDER

NE

INSTALLATION RESOURCES FOLDER

14.0.1000.169, RTM

Figure 1-9. SQL Server installation summary

The final installation screen shows the summary of the installation.
It also allows you to open the SQL Server directly and customize the
installation. The next step is to install SSMS. Click the Install SSMS button
and it should take you to a download link. The latest version as of the time
of writing is SSMS 9.7.

18
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Run the online installer after you have downloaded the SSMS from
the Microsoft download site. You should be presented with the following

screen:

RELEASE 17.9

Microsoft SQL Server Management Studio

Welcome. Click “Install” to begin.

By clicking the “Install” button, | acknowledge that | accept the

SQL Server Management Studio transmits information about your installation experience, as well as other
usage and performance data, to Microsoft to help improve the product. To leam more about data processing
and privacy controls, and to turn off the collection of this information after installation, see the

Figure 1-10. SSMS installation

Click Install. After the setup is complete, just click Close.
We will use SSMS to query, design, and manage the database later in
the Chapter 3.
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Five Players, One Goal

As you can see from the “Prerequisites” section, we are going to use
various technologies to build this whole game application to fulfill a goal.
At this point, you should already have the needed frameworks installed
in your machine as long as you properly installed the required workloads
mentioned in the “Installation Guide” section.

Our main goal is to build a simple data-driven Working Memory game
application using cutting-edge technologies: Xamarin.Forms, ASP.NET
Web API, EF, ASP.NET MVC, and ASP.NET SignalR.

Before we discuss the high-level process flow for how each technology
connects together, let’s take a look at a brief overview of them.

Xamarin.Forms

Building mobile applications that target multiple platforms such as
Android, i0S, and UWP has always been a time-consuming pain, as you
have to deal with different programming languages and platform-specific
implementation. Aside from that, maintaining multiple code repositories
to do essentially the same thing is tedious at best, and at worst can become
a nightmare.

As a .NET developer who knows C#, Xamarin will provide you with the
functionality you need. It promises to deliver mobile apps with a shared
code base; however, that shared code base is on the application logic side
of things. Traditional Xamarin.iOS, Xamarin.Android, and Xamarin.UWP
development still requires that the Uls be written separately from each
other, and that is no small task.

Xamarin.Forms offers a significant time savings in this regard. Its
claim to fame is that it abstracts the UI of each platform—the individual
operating system controls and navigation metaphors—into a common
layer that can be used to build applications for iOS, Android, and UWP
with both a shared application layer and a Ul layer.
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Xamarin.Forms is a mobile application framework for generating
cross-platform Uls, and it couples that with .NET Standard to share code,
making it an even more favorable choice. Here’s the definition taken
from the official documentation: https://docs.microsoft.com/en-us/
xamarin/xamarin-forms/

Xamarin.Forms exposes a complete cross-platform UI toolkit
for .NET developers. Build fully native Android, iOS, and
Universal Windows Platform apps using C# in Visual Studio.

Xamarin.Forms offers so much more in addition to 20+ cross-platform
UI controls that work across platforms.

Xamarin vs. Xamarin.Forms

Xamarin (sometimes called Xamarin Native), enables developers to create
fully rich iOS, Android, macOS, watchOS, tvOS, and Windows applications
in C# and Visual Studio with 100% API coverage of each platform in C#.
You develop the Ul natively for each platform, but share all your business
logic, which on average is 60-80% of your application. This approach gives
you 100% API access, 100% of the UI, and of course the best performance.

Xamarin.Forms offers up a cross-platform Ul that is based on XAML or
C# and sits on top of Xamarin Native itself. This works across iOS, Android,
UWP, macOS§, and others supported by the community. The language is
similar, as it is XAML, but not identical, as the controls and names are a bit
different. However, picking it up is easy, and Xamarin and Microsoft have
great documentation on it.

ASP.NET Web API

The ASP.NET Web API is an extensible framework for building
HTTP-based services that can be accessed in different applications on
different platforms. It works more or less the same way as the ASP.NET
MVC web application, except that it sends data as a response instead of

21
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HTML View. It is like a web service or WCF (Windows Communication
Foundation) service, but the exception is that it only supports HTTP
protocol. Here’s the definition taken from the official documentation:
https://msdn.microsoft.com/en-us/1library/hh833994(v=vs.108).
aspx

ASP.NET Web API is a framework that makes it easy to build
HTTP services that reach a broad range of clients, including
browsers and mobile devices. ASPNET Web API is an ideal
platform for building RESTful applications on the .NET
Framework.

EF

EF is a tried and tested object-relational mapper (ORM) for .NET with
many years of feature development and stabilization.

According to the official documentation: https://docs.microsoft.
com/en-us/ef/ef6/

As an O/RM, EF reduces the impedance mismatch between
therelational and object-oriented worlds, enabling developers
to write applications that interact with data stored in rela-
tional databases using strongly-typed .NET objects that repre-
sent the application’s domain, and eliminating the need for a
large portion of the data access “plumbing” code that they
usually need to write.

If you are still confused about what an ORM does and how EF
functions in the application, don’t worry, as we will see details about it in
the Chapter 3.
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ASP.NET MVC

The ASP.NET MVC is a web application framework developed by
Microsoft, which implements the MVC pattern. Here’s the definition taken
from the official documentation: https://msdn.microsoft.com/en-us/
library/dd381412(v=vs.108).aspx

The Model-View-Controller (MVC) architectural pattern sep-
arates an application into three main components: the model,
the view, and the controller. The ASPNET MVC framework
provides an alternative to the ASP.NET Web Forms pattern for
creating Web applications. The ASPNET MVC framework is a
lightweight, highly testable presentation framework that (as
with Web Forms-based applications) is integrated with exist-
ing ASP.NET features, such as master pages and membership-
based authentication. The MVC framework is defined in the
System.Web.Muvc assembly.

ASP.NET SignalR

ASP.NET SignalR is typically used to add any kind of “real-time” web
functionality to your ASP.NET application. While chat is often used as an
example, you can do a whole lot more. Any time a user refreshes a web
page to see new data, or the page implements long polling to retrieve new
data, it is a candidate for using SignalR. Examples include dashboards and
monitoring applications, collaborative applications (such as simultaneous
editing of documents), job progress updates, and real-time forms.
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Here’s the definition taken from the official documentation: https://
docs.microsoft.com/en-us/aspnet/signalr/overview/getting-
started/introduction-to-signalr

ASP.NET SignalR is a library for ASP.NET developers that sim-
plifies the process of adding real-time web functionality to
applications. Real-time web functionality is the ability to have
server code push content to connected clients instantly as it
becomes available, rather than having the server wait for a
client to request new data.

Wrap-Up

Now that you know the basic overview of each technology and framework
that we will be using to build the applications, it’s time for us to take a
moment and see how to connect the dots in the picture. The following

diagram illustrates the high-level process by which the technologies
connect to each other.

S Web API (api/game)

o — Ce %

Entity Framework (CRUD)

Xamarin.Forms 4
(Mobile App)
v
\j

ASP.NET MVC & SignalR (dashboard)
I L

@ Response
O Request é%

SQL Server (database)

Figure 1-11. High-level diagram of how the technologies
interact
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Based on the preceding illustration, we are going to need to build the
following applications:

e A mobile app that targets both iOS and Android platform

e A Web API app that exposes some public-facing API
endpoints

e A web app that hosts a real-time dashboard
o A database that stores and persists data

Since this demo is primarily focusing on the game development, then
the process flow will start at the mobile app. A mobile app requests data
for storing and retrieving a user’s information via a REST API call (ASP.
NET Web API). All requests will then be handled by the Web API server.
The Web API server acts as the central gateway to access a resource from
a database; it serves the request made and returns a response when
necessary. The Web API server does not hold the actual data but contains
the actual implementation of how the data is being retrieved or stored and
handles the CRUD operations using EE. All data changes made by EF will
be executed and reflected against the SQL Server database. The SQL Server
database serves as a medium of storage to hold and persist data.

The beauty of the REST service is that it allows different client
applications (e.g., desktop, mobile, web, or services) to consume API
via endpoints for as long as it supports HTTP protocols. Based on the
preceding illustration, a web app can also request data to the Web API
server. The web app serves as the dashboard page for displaying the
information in real time using ASP.NET SignalR.

To summarize, we are going to build a mobile application using (1)
Xamarin.Forms that can target both i0OS and Android platforms. The
mobile app is where the actual game is implemented, and also where users
will be allowed to register. We will build an (2) ASP.NET Web API server
application to handle CRUD operations using (3) EF. The Web API project
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will serve as the central gateway to handle data requests that come from
the mobile app and the web app. We will also build a web application to
display the real-time dashboard for displaying player ranking using (4)
ASP.NET MVC and (5) ASP.NET SignalR. Finally, we are going to create a
database for storing players’ information and scores in SQL Server.
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Getting Started

Before we get our hands dirty with actual coding, let’s try to understand the
application process flow first so that you can have a better picture about
the whole flow of the application from the user’s perspective.

Application Flow

The application that we are going to build has three main layers:
e Mobile application
e Web API Server
e Web application

The following diagram shows the application process flow of each layer
and how the layers interact to achieve a goal:

© Vincent Maverick S. Durano 2019 27
V.M. S. Durano, Understanding Game Application Development,
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Mobile App (Xamarin.Forms)

(12) Game Over or
| Proceed 1o next level

% 19 Successhl (200)—3 D —> D —_— DG
talidate Credentials e . Q

) et Answer
(10) start gama  {11) Inpet angwer validation

18] Unauthonize-

N

- D {1) Register [ Login

User

[13} Sync data automatically
POST: api/game/player/scare

[2) GET:

Web AP| Server [7) Return DTO as respoese | Database Server

[5) Save changes o
return result set

{8) Return an object-

A o - ‘
‘. 3 A {3) bandle CRUD— r {4) Execute query—3 2
\xr, Q V)

A Endpoints. Entity Framewcrk (CRUD) 501 Server Database

Web Application

[Real-time Dashboard) (4] GET: aplgameloet

ASPNET MVC + SignalR

Figure 2-1. Application process flow

Mobile Application Process Flow

Let’s start with the first layer, the mobile app. In order for a user to

start playing the game, they need to register an account first. During
registration, a user will simply need to provide their e-mail address, first
name, last name, and that’s it. I've chosen not to include a password
upon registration for the sake of simplicity and to remove the complexity
of managing user accounts. With that being said, the mobile application
will simply ask for the user’s e-mail address to log in to the system. If you
look at the preceding diagram, the mobile application talks to the Web
API server to get the user information by issuing an HTTP Get request
before validating the credentials. The Web API Server handles the request
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from the mobile app and returns a JSON response back to the mobile app.
Keep in mind that the mobile application also stores the user information
locally. This is to ensure that the system has a local copy of data when a
user plays the game offline.

Now when a user’s credentials are successfully validated, the user will
be navigated to the main screen of the application, wherein they can start
playing the game. Otherwise, a validation error that the credentials are
invalid or do not exist is prompted.

During the game, the application will randomly beep a sound, blink
an image, or vibrate the device within a given amount of time in seconds.
When the time has elapsed, the application will automatically take the
user to the next screen, where they can input their answers. After they
submit the answers, the system will validate this input and either display a
“congratulations” message and allow them to proceed to the next level or
display a “game over” message if their answers are incorrect. The system
will also automatically sync the user’s highest score and level after the
system has validated the answers.

What's exciting about this game is that the more you move to a
next level, the faster it triggers the different event types until you can’t
remember which type of event occurs.

Web API Server Process Flow

As arecap, the API server acts as a central gateway for handling HTTP
requests from a client application. In this particular setup, the API server
handles both mobile and web app requests and then delegates the request
into the data access sublayer using EF to process the data. An HTTP
request can be a form of Insert, Update, Read, or Delete.

The EF manipulates the data through a strongly typed .NET object and
then translates that into a SQL query command and executes it to reflect
and persist the changes in the data to the SQL Server database.
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Web Application Process Flow

The web app is nothing but a page that displays the user ranking
dashboard (a.k.a. leaderboard). This page is an ASP.NET MVC application
that asynchronously listens to a data change by subscribing to a Web

API endpoint and then displays the changes in real time using ASP.NET
SignalR. Real-time changes occur when a manual sync or automatic sync
is triggered from the mobile app.

Game Overview

This section discusses the game mechanics and objective.

Mechanics

During the game and as soon as you hit the Start button, the application will
randomly play different event types within a given time interval expressed
in milliseconds. The trigger cycle has a time interval also expressed in
milliseconds. For example, within 10 seconds, the app randomly plays
different event types such as blinking an image, playing a sound, or
activating vibration on the device in a 2-second cycle. At the succeeding
levels, the 2-second cycle interval will decrease, which causes the events to
trigger much faster than at the previous level.

To make it clearer, the following diagram shows how the game flows:

30



CHAPTER 2  GETTING STARTED

Game Flow

Home Page Result Page

@
[

Challenger OK SO

trigger nbarval
10 Seconds interval) L 29.ch
count down

| |

Randomly triggers with 2
seconds interval:

Blink
Answer Validation

Sound

Vibrate

l

How many times it
10 Seconds blinks, beeps and
has elapsed ‘ vibrates?

Figure 2-2. Game flow

Objective

The objective of this game is very simple; you just need to count and
memorize how many times the light blinks on, the speaker beeps, and the
device vibrates within a span of time. The higher your level is, the faster it
blinks, beeps, and vibrates. This will test how great your memory is.
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Mobile Application Views

This section will give you some visual references about the outputs of the
applications that we are going to build.

Welcome Screen

The welcome screen is the default view of the application, which displays
information to register a new account or log in as a returning user.

Working Memory Game

Register to start the fun, or Log-on to
9 g

continue the challenge!

REGISTER LOG-ON

Figure 2-3. Mobile app welcome view
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Registration Screen

Clicking the REGISTER button will display the registration screen,
which allows users to register using first name, last name, and e-mail.
The LOG-ON button will display the login screen, which allows a returning
user to enter their registered e-mail.
Here’s a running view of the registration screen:

Working Memory Game

st Nams
vincent

ast Name

Email

vincentduranoi@testernail. com

LET'S DO THIS! CANCEL

Figure 2-4. Mobile app register view
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Main Screen

Once the user has successfully been registered or logged on to the system,
they will be redirected to the main screen, as shown in the following figure.

Best: Level 1

Figure 2-5. Mobile app home view

The main screen displays the current and best level scores and as
well as a SYNC button to allow users to manually sync their scores in
the database. It also displays three main images: a bulb, a speaker, and a
device that indicates a vibration.
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Clicking the START button will start the game within a short period
of time and turn the button text to GAME STARTED..., as shown in the
following figure.

Best: Level 1

Timer: 06

Level 1

Figure 2-6. Mobile app game view

Result Screen

After the time has elapsed, it will bring users to the result screen, wherein
they can input their answers for how many times each event happened.
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SUBMIT

Figure 2-7. Mobile app answer view

Clicking the SUBMIT button will trigger the system to validate the
answers and determines whether the user gave them correctly and thus
may proceed to the next level or whether the game should be restarted at
the current level. Note that the score will be automatically synced to the
database once the user surpasses their current best score.

Here are some screenshots of the results:
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Game Over!

Your current best is at level 1. Retry?

ND YES

Figure 2-8. Mobile app results view: Game Over!
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Congrats!

You've got it all right and made it to level 2.
Continue?

Figure 2-9. Mobile app results view: Congrats!

Web Application View

Here’s the sample output of the real-time leaderboard page built using
ASP.NET MVC and ASP.NET SignalR.
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My ASP.NET Application x 4+ B = = A

I &« C @ localhost T o
Leader Board

Top Challengers

Rank Best Achieved

Michelle Lorenzana 2 2018-09-25T08: 20042 42
2 Vianne Maverich Durano 2 2018-09-24T03.56.25 2
3 Vynn Markus Durano 1 2018-09-25T03:16:00

© 2018 - My ASP.NET Application

Figure 2-10. Web app real-time ranking view

That’s it. Now that you have some visual reference for what the app will
look like, it’s time for us to build the applications and get our hands dirty
with real code examples.

Creating the Core Projects for Mobile App

I'll try to keep this demo as simple as possible, so beginners can easily
follow. By “simple,” I mean that I will limit the discussion of theories and
concepts, but instead jump directly into the mud and let us get our hands
dirty with code examples.

Let’s go ahead and launch Visual Studio 2017 and then create a new
blank XAML app (Xamarin.Forms) by going through File » New »
Project. You should be presented with a New Project window dialog. In
the left pane of the dialog under the Installed item, drill down to Visual C#
» Cross-Platform and then select Mobile App (Xamarin.Forms) just like
in the following figure.
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MNew Project

b Recent Sort by: Default - [ Search (Ctrl+E)

4 Installed -
U_,;J Mobile App (Xamarin.Forms) Visualce  Type Visual G5
4 Visual C& A multiproject template for building apps
Get Started for i05, Android, and Windows with
s Xamarin and Xamarin.Forms.
Windows Universal

Windows Desktop
b Web

-NET Core

.NET Standard

Android

Apple TV

Apple Watch

Cloud

Cross-Platform

105 Bxtensions

iPhone & iPad -

Not finding what you are looking for?
Open Visual Studio Installer

Name: [MemoryGame.Apgl ]
* Browse...

Location: CAUsers\wdurano_srg\sourcerepos

Solution name: MemoryGame.App Zl Create directory for solution
(] Add to Source Control

: QK Cancel

Figure 2-11. Create new Xamarin.Forms project

Although you can freely name the project to your preference, for this
demo let’s just name it MemoryGame.App, as it suits well to what we are
going to build. Click OK and it should bring up the following window dialog.
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New Cross Platform App - MemoryGame.App X

Select a template:

e o A project template for a new Xamarin.Forms
= = app that has no extra sample pages or sample
o=l Q= piti

Master-Detail Tabbed

Platform Code Sharing Strategy ?

[ Android (@) .NET Standard

[] i0S _) Shared Project
Windows (UWNP)

ok |[ cancel

Figure 2-12. Blank template

Select the Blank template, and under Platform, tick the Android and
iOS options. Select .NET Standard as Code Sharing Strategy, and then
click OK to let Visual Studio generate the necessary files for you.

It may take a moment to generate the files and dependencies
depending on your machine and Internet speed.

After Visual Studio is done generating the default files for the project
and pulling the necessary dependencies, it should show something like the
following.
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"1' MemoryGame.App - Microsoft Visual Studio Y &7 | Quick Launch (Ctrl+Q) P - [ m x
File Edt View Project Build Debug Team Tools Test Analyze Window Help Vincent Maverick S Durano ~ ’
Q- B2 W - < Debug =~ iPhone = MemoryGame.App - DAmEIo il

§‘ MainPagexaml & X MainPagexaml.cs Al Solution Explorer
| g [ ContentPage = [ ContentPage “a GE- n-5fm "
1 <?xml version="1.8" encoding="utf-83" > - - -
2 - <ContentPage xmlns="http://xamarin.com/schemas/2014/for 7 a Search Selution Explorer (Ctris;) P~
3 xmlng:x="http://schemas.microsoft.com/winy ——
4 xmlns:local="clr-namespace:MemoryGame . App sy 4 [& MemoryGame.App
5 x:Class="MemoryGame .App.MainPage”> o b %' Dependencies
<StackLayouts = ) APF”MI
8 elie Plinre e comtrals hare: sk i b ) MainPagexaml
9 cLabel Texts"Welcome to Xamarin.Forms!™ — 4 [J MemoryGame.App.Android
10 HorizontalOptions="Center” - & Connected Services
11 VerticalOptions="CenterAndExpand™ /> - b S Properties
12 </StackLayout> b =@ References
13 b Assets
14 </ContentPage> b i Piorces
_ b € MainActivity.cs
4[5 MemeoryGameApp.i0S
& Connected Services
b Properties
b =B References
b [ Asset Catalogs
=B Native References
b Resources
b = AppDelegate.cs
[ Entitlements.plist
O Info.plist
b Maincs
4 »
Solution E...  Team Expl.. Server Expl...
Properties i x
o g MemoryGame.App Project Properties =
W% - 4 » @ e, =

# Add to Source Control =

Figure 2-13. Default generated files

The Xamarin.Forms project template basically generates the following
three main projects:

o MemoryGame.App
e MemoryGame.App.Android
e MemoryGame.App.iOS

Note That the solution only contains the .Android and .iOS projects. We
omitted the .UWP project, and so we will be focusing on Android and i0S
apps instead.
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Overview and Anatomy

Let’s take a quick overview of each project generated.

MemoryGame.App

In 2011, Microsoft released a new type of class libraries called Portable
Class Libraries (PCLs). A PCL is a project type that creates a binary file
compatible with multiple frameworks. The previous version of Xamarin.
Forms uses PCL to enable you to choose a combination of platforms that
you want your code to run on. PCLs enable centralized code sharing,
which allows developers to write and test code in a single project that can
be consumed by other libraries or applications.

However, the available APIs are reduced each time a new target
framework is selected. For example, if a class is available in .NET
Framework 4.5.1 but not in Windows Universal 10.0, it won’t be available
in the PCL targeting both these frameworks. The combinations of the
target frameworks are called profiles.

While PCLs were a breakthrough at the time of their creation, it was
sometimes difficult to find information on which APIs were available
and where to find them. In time, it became clear to the .NET team that a
simpler approach was needed, and that’s where .NET Standard fits.

The MemoryGame.App is a .NET Standard Library project. The
prerelease version of the Xamarin.Forms 2.3.5 added compatibility with
.NET Standard.

.NET Standard is a formal specification of .NET APIs that is intended
to be available on all .NET runtimes (such as .NET Framework, Mono,
and .NET Core). In real terms, you can think of this as a simplified yet
expanded PCL. Any code added to a .NET Standard library can be used
on any runtime that supports the .NET Standard platform. In addition, we
get expanded access to APIs within the .NET base class libraries, and this
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supports more platforms. For more information, see https://blogs.msdn.
microsoft.com/dotnet/2016/09/26/introducing-net-standard/.
Here’s the anatomy of the Xamarin.Forms .NET Standard project:

Folder/File Purpose

Dependencies Contains both NuGet and SDK dependencies for the project.

App.xaml Responsible for instantiating the first page that will be displayed
by the application on each platform.

MainPage.xaml Initializes the main page components.

MemoryGame.App.Android

The MemoryGame.App.Android contains Android-specific
configuration and files needed to run the application. Here’s the anatomy

of the Android project:

Folder/File Purpose

Connected Allows service providers to create Visual Studio extensions
Services that can be added to a project without leaving the IDE. It also

allows you to connect your ASP.NET core application or mobile
services to Azure storage services. Connected Services takes
care of all the references and connection code, and modifies your
configuration files accordingly.

Properties Contains the AndroidManifest.xml file, which describes all the
requirements for our Xamarin.Android application, including
name, version number, and permissions. It also contains the
AssemblylInfo.cs file, in which you can define assembly details
such as title, description, copyright info, version, and more.
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Folder/File Purpose
References Contains the assemblies required to build and run the application.
Assets Contains the files the application needs to run, including fonts,

local data files, and text files.

Resources Contains application resources such as strings, images, and
layouts. You can access these resources in code through the
generated resource class.

MainActivity.cs A C# class that contains code for initializing and loading the
application.

MemoryGame.App.i0S

The MemoryGame.App.iOS contains iOS-specific configurations and files

needed to run the application. Here’s the anatomy of the iOS project:

Folder/File

Purpose

Asset Catalogs

Native References

Resources

AppDelegate.cs

Just like the Assets folder in the .Android project, this
contains the files the application needs to run, including
fonts, local data files, and text files.

This is where you add assemblies specific to the i0S
platform.

Contains application resources such as strings, images, and
layouts. You can access these resources in code through the
generated resource class.

This class is responsible for launching the Ul of the
application, as well as listening (and optionally responding) to
application events from i0S.

(continued)
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Folder/File Purpose

Entitlements.plist  Used to specify entitlements and to sign the application
bundle. In essence, Entitlements are special app capabilities
and security permissions granted to applications that are
correctly configured to use them.

Info.plist Contains metadata to the system. This file typically contains
the keys and their corresponding values for the application’s
configuration bundle.

Main.cs The main entry point of the application.

Architecture Fundamentals

A Xamarin.Forms application is architected in the same way as a traditional
cross-platform application. Shared code is typically placed in a .NET
Standard library, and platform-specific applications consume the shared
code. The following diagram shows an overview of this relationship for the
MemoryGame . App application:
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MemoryGame.App.Android

MemoryGame.App Application Layer

NET Standard Library
Xamarin.Android SDK assemblies

MemoryGame.App.iOS

Application Layer

Xamarin.iOS SDK assemblies

Figure 2-14. Xamarin.Forms architecture fundamentals

First Run

To ensure that we have everything we need for our core mobile application
projects, let’s try to build and run the project. Let’s start by enabling the
Output window by going through the Visual Studio main menu under
View » Output just like in the following figure:
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ﬂ MemoryGame.App - Microsoft Visual Studio

File Edit

x0q|00]

View

~
v

O m g E

-—
l“n’.l

i)

mRlgr 41 &

Project Build Debug Team Tools Te
Code F7
Solution Explorer Ctrl+W, S
Team Explorer Ctrl+\, Ctrl+M
Server Explorer Ctrl+W, L
Cloud Explorer Ctrl+\, Ctrl+X
SQL Server Object Explorer Ctrl+\, Ctrl+S
Call Hierarchy Ctrl+W, K
Class View Ctrl+W, C
Code Definition Window Ctrl+W, D
Object Browser Ctrl+W, )
Error List Ctrl+W, E
Output Ctrl+W, O
Task List Ctrl+W, T

Figure 2-15. Enabling Output window

Next, let’s try building the whole projects by right-clicking the Solution

level then selecting Build Solution, as shown in the following figure:

& Build Solution
Rebuild Solution
Deploy Solution
Clean Solution
Analyze
Batch Build...

Configuration Manager...

Ml Solution Explorer *ax
il ] wel- -5 & ﬁE
.i. o Search Solution Explorer (Ctrl+;) P~

jon ‘MemoryGame.App' (3 projects) a

gmoryGame.App
Dependencies
App.xaml
MainPagexaml
emoryGame.App.Android
Connected Services
Properties
References

Figure 2-16. Building the project’s solution

Or, you could simply hit the F6 key.

The Output window should show the build results. If everything goes

well and builds successfully, then we can start running the apps. The good

thing is that the Visual Studio Emulator for Android is included when you
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install Visual Studio 2017 to develop Xamarin apps. This means that you
can test and run the application right away without needing to download
and install the Android emulator separately.

If you don’t want to use the default emulator that comes with the
Visual Studio 2017, then you can also download an emulator separately.

e Windows 8.1 and Windows 10: https://visualstudio.
microsoft.com/vs/msft-android-emulator/

e Windows 7: You can use Android SDK/Google or use
a third-party emulator such as GenyMotion/Xamarin
Android Player.

For this demo, I will just use the default emulator in Visual Studio 2017.

Xamarin.Android

Let’s try to run the Xamarin.Android project first. To do that, we need to
set the Xamarin.Android project as the startup project by right-clicking the
MemoryGame.App.Android and then select Set as StartUp Project.

The MemoryGame.App.Android project should be highlighted from
the Solution. Now click the Play button to run the project in the Android
emulator as shown in the following figure:

window  Help Vincent Maverick S Durano ~ [{f§]
MemaryGame. App. Android - P Android_Accelerated_x86_Oreo (Android8.1-4P127) - 5% - [ _ C

@E-o-50¢ "

Search Solution Explorer (Ctri+;) }3 -

%] Solution 'MemoryGame. App' (3 project
b [E%] MemoryGame.App
P [& MemoryGame.App.iOS

Figure 2-17. Running the Xamarin.Android project for the first time
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Note If you are prompted with a performance warning that says the
emulator will run unaccelerated, just click the “Start Anyway” button
to launch the emulator.

After the emulator starts, Visual Studio will build the application
then Xamarin.Android will deploy the app to the emulator. The emulator
runs the app with the configured virtual device image. An example of the
Android emulator is displayed in the following screenshot. In this example,
the emulator is running the application with the default page that says
“Welcome to Xamarin.Forms!”

Andraid Ermulator - Android_Accelerated x36_Oreo:3554

D6 O V4143

Welcome to Xamarin.Forms!

Figure 2-18. Android emulator output
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The emulator may be left running: it is not necessary to shut it down
and wait for it to restart each time the app is launched. The first time a
Xamarin.Android app is run in the emulator, the Xamarin.Android shared
runtime for the targeted API level is installed, followed by the application.
The runtime installation may take a few moments, so please be patient.
Installation of the runtime takes place only when the first Xamarin.
Android app is deployed to the emulator; subsequent deployments are
faster because only the app is copied to the emulator.

At this point, you may close the Android emulator, because we need to
test out the MemoryGame.App.iOS project.

Xamarin.i0oS

To run the Xamarin.iOS project, you need to have a Mac machine to
simulate the application. You will first need to pair your Mac so that the
MemoryGame.App.iOS project can connect to it.

Building native iOS applications requires access to Apple’s build tools,
which only run on a Mac. Because of this, Visual Studio 2017 must connect
to a network-accessible Mac to build Xamarin.iOS applications. For more
information on pairing your Mac, see the following:

https://docs.microsoft.com/en-us/xamarin/ios/get-started/
installation/windows/connecting-to-mac/

Now log on to your Mac machine and then go to System Preferences
» Sharing. Check the Remote Login and select Allow access for: All users
just like in the following figure:
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o < HHH Sharing Q

Computer Name: Vincent's MacBook Air

Computers on your local network can access your computer at: Edit
Vincents-MacBook-Air.local

On  Service @ Remote Login: On
Screen Sharing To log in to this type "ssh 192.168.0.11",
File Sharing

Printer Sharing
Remote Login
Remote Management

Remote Apple Events Allow access for: (@) All users

Internet Sharing Only these users:
Bluetooth Sharing 1 Administrators
+ | -

Figure 2-19. Enabling remote login on Mac

After you've done that, make sure that you have installed Xcode on
your Mac:

o https://itunes.apple.com/us/app/xcode/
1d497799835?mt=12

Xcode is required in order to build and run iOS apps, so ensure that
you installed that correctly and it’s functional.

Now go ahead and switch to Visual Studio and set the MemoryGame.
App.iOS project as a startup project.

Click the Play button that says Simulator as shown in the following
figure.

Debug - iPhoneSimulator ~ MemoryGame.App.iOS = P Simulator ~

Figure 2-20. Running the Xamarin.iOS project for the first time
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Then, it should show the following:

5 Pair to Mac Instructions X

To pair your Windows machine with a Mac, you must enable

Remote Login on your Mac

Q. Remote Login - sing ® |

< )

Sharing

Step 10f 3
On your Server, invoke Spotlight (Cmd-Space) and search for "Remote Login®
and then open the Sharing System Preferences.

] Don't show this again Next

Figure 2-21. Pair to Mac instructions

If it is on the same network as the Windows machine, the Mac
should now be discoverable by Visual Studio 2017. If the Mac is still
not discoverable, try manually adding a Mac or take a look at the
troubleshooting guide at the following links:

o https://docs.microsoft.com/en-us/xamarin/ios/
get-started/installation/windows/connecting-to-
mac/#manually-add-a-mac

o https://docs.microsoft.com/en-us/xamarin/ios/
get-started/installation/windows/connecting-to-
mac/troubleshooting
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Click Next and it should present you with the following screen:

21
Select a Mac: 0o

i t's MacBook Air

8.0.11

|. An active connection to the Mac is required in order to launch the application. Please ensure the
connection is established and try again

T

Figure 2-22. Select a Mac to pair

Click the Connect... button and it should prompt you to provide a
username and password for you to connect your Mac machine just like in
the following figure:
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Connect to Mac l x|

Xamarin requires the username and password for the following Mac:

_ssh (192.168.0.11)
13:17:65:B1:18:03:A5:51:0E:09:4E:3C:D6:3C:51:C8

Figure 2-23. Connect to Mac

Enter your username and password and click Login.
If your login is successful and you are prompted with a Missing Mono
installation, simply click Install as shown in the following figure:

1 Missing Mono installation
Mono could not be found on the Mac. This is required for building iOS apps with the Visual Studio
Tools for Xamarin. Would you like us to install it for you?

| mstal || Cancel

Figure 2-24. Missing Mono installation warning

You may also be prompted with the missing Xamarin.iOS installation.
Just click Install and it should download and install the missing pieces, as
shown in the following figure:
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Missing Xamarin.iOS installation
Downloading XamariniOS "12.0.0.15: 9.1%

Where's my Mac?
Figure 2-25. Missing Xamarin.iOS installation warning

It may take a few minutes to download and configure the Mono
settings depending on your Internet speed, so just be patient.

o Iffor some reason the Mono installation fails, then try
installing it manually on your Mac machine. You can
download the Mono installer here: www.mono-project.
com/docs/getting-started/install/mac/

o To ensure that you have everything you need to run
Xamarin.iOS on Mac, I would recommend that you
install Visual Studio for Mac. You can download the
installer here: https://docs.microsoft.com/en-us/
visualstudio/mac/installation

Once all the necessary tools are done installing, it should ask you
to agree on the Xcode and Apple SDKs agreement, as shown in the
following figure:
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o Pair to Mac ? X

Apple Inc.

Xcode and Apple SDKs Agreement

PLEASE SCROLL DOWN AND READ ALL OF THE FOLLOWING TERMS AND
CONDITIONS CAREFULLY BEFORE USING THE APPLE SOFTWARE OR APPLE SERVICES.
THIS IS A LEGAL AGREEMENT BETWEEN YOU AND APPLE. IF YOU AGREE TO BE
BOUND BY ALL OF THE TERMS AND CONDITIONS, CLICK THE “AGREE” BUTTON. BY
CLICKING "AGREE” OR BY DOWNLOADING, USING OR COPYING ANY PART OF THIS
APPLE SOFTWARE OR USING ANY PART OF THE APPLE SERVICES, YOU ARE
AGREEING ON YOUR OWN BEHALF AND/OR ON BEHALF OF YOUR COMPANY OR
ORGANIZATION TO THE TERMS AND CONDITIONS STATED BELOW. IF YOU DO NOT
OR CANNOT AGREE TO THE TERMS OF THIS AGREEMENT, YOU CANNOT USE THIS
APPLE SOFTWARE OR THE APPLE SERVICES. DO NOT DOWNLOAD OR USE THIS
APPLE SOFTWARE OR APPLE SERVICES IN THAT CASE.

1. Definitions
Whenever capitalized in this Agreement:

“Agreement” means this Xcode and Apple SDKs Agreement.
“Apple” means Apple Inc.. a California corporation with its principal place of business at

1 Xcode and Apple SDKs License Agreement for ‘vdurano-mbp13ts (3)'
Having Xcode functional is necessary in order to build and run iOS apps. You must agree to both
license agreements above in order to use Xcode. By clicking Agree, you are agreeing to the terms of
the software license agreements.

| Agree ‘ l Disagree

Figure 2-26. Xcode and Apple SDKs agreement

Click Agree.

Once you your PC is successfully paired to your Mac, then you should
be able to see various device emulators in your Visual Studio device list, as
shown in the following figure:
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MemoryGame.App.i0S 4l [> iPhone XRi0S 12.0 ~ RvIRE-2 = LbEamE®

| 4

iPhone XRi0S 12.0

Device

iPad (5th generation) i0S 12.0
iPad (6th generation) i0S 12.0
iPad Air 2i0S 12.0

iPad Airi0S 12.0

iPad Pro (10.5-inch) i0S 12.0
iPad Pro (12.9-inch) (2nd generation) i0S 12.0
iPad Pro (12.9-inch) i0S 12.0
iPad Pro (9.7-inch) i0S 12.0
iPhone 55105 12.0

iPhone 6105 12.0

iPhone 6 Plus i0S 12.0
iPhone 65105 12.0

iPhone 6s Plus i0S 12.0
iPhone 7i0S 12.0

iPhone 7 Plus 105 12.0
iPhone 8105 12.0

iPhone 8 Plus i0S 12.0
iPhone SE i0S 12.0

Figure 2-27. Selecting an iOS device emulator

58



CHAPTER 2  GETTING STARTED

Here’s a sample screenshot of the Xamarin.iOS running on the iPhone
emulator:

Carrier ¥ 11:47 PM —

Welcome to Xamarin.Forms!

Figure 2-28. i0OS emulator output

For more information about pairing your PC to Mac, see the following:
https://docs.microsoft.com/en-us/xamarin/ios/get-started/
installation/windows/connecting-to-mac/
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The Required NuGet Packages

The next step is adding the packages that are required for our application.
Go ahead and right-click the Solution and install the following packages in
all projects:

e Xam.Plugins.Settings 3.1.1
o Xam.Plugin.Connectivity 3.2.0

¢ Newtonsoft.Json 11.0.2

Note The specific versions indicated in the preceding. Those are the
latest stable versions released as of this time of writing, and we are
going to use them in this demo. Future releases of each packages might
contain some new changes and might work differently.

We'll be using the Xam.Plugins.Settings to provide us consistent
cross-platform settings/preferences across all projects (portable library,
.NET Standard, Android, and iOS projects). The Xam.Plugin.Connectivity
will be used to get network connectivity information such as network type,
speeds, and connection availability. The Newtonsoft.Json will be used in
our code to serialize and deserialize a JSON object from an API request.
We'll see how each of these references is used in action later.

There are two ways to add packages in Visual Studio; you could either
use the Package Manager Console, or proceed via NuGet Package Manager
(NPM). In this demo, we are going to use NPM so you can have a visual
reference.

Now, right-click the Solution level and then select Manage NuGet
Packages for Solution. Select the Browse tab, and in the search bar,
type in “Xam.Plugins.Settings” This should result in something like the
following:

60



CHAPTER 2  GETTING STARTED

NuGet: MemoryGameApp ® X MainPagexaml MainPagexaml.cs -
Browse  Installed  Updatesi) NuGet Package Manager: MemoryGame.App
Xam.Plugins.Settings x| ¢ D Include prerelease Package source: nugetorg -

{E} Xam.Plugins.Settings
Xam.Plugins.Settings by Jame: 3.1.1

Cross platform settings for
Xamarin.iOS, Xamarin.Android, Xa... Version: Latest stable 3.1.1 . Install
Each package is licensed to you by its owner. NuGet is not V) Options
responsible for, nor does it grant any licenses to, third- &) op
party packages.
|:| Do not show this again Description

Sem{:gs Plugin for Xamarin an_d Wi'ndows provides 3 -
Figure 2-29. Installing NuGet packages

When the install is successful, a reame.txt file for using the Xam.
Plugins.Settings should automatically display. Next, install the “Xam.
Plugin.Connectivity” and “Newtonsoft.Json” NuGet packages.

Once you've installed them all, you should be able to see them added
in your project Dependencies just like in the following figure:

fa] Solution ‘MemoryGame.App’ (3 projects)
4 MemoryGame.App
4 73" Dependencies
4 '@ NuGet
3 'B NewtonsoftJson (11.0.2)
b @ Xam.Plugin.Connectivity (3.2.0)
b @ Xam.Plugins.Settings (3.1.1)
b ‘@ Xamarin.Forms (3.1.0.697729)
b 3% SDK
N Appaxaml
) MainPagexaml
MemoryGame.App.Android
MemoryGame.App.iOS

b
&

Figure 2-30. The installed NuGet packages
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At this point, we should be confident that we have everything we
need to build and run the applications. Now it’s time to get our hands dirty
with coding.

You may also want to look at Xamarin.Essentials, as it provides
you with cross-platform APIs for your mobile applications. See the
documentation here: https://docs.microsoft.com/en-us/xamarin/
essentials/
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CHAPTER 3

Configuring Data
Access and API
Endpoints

In this chapter, we are going to see in action how to set up a database,
configure data access, and build REST API endpoints.

Creating a New Empty Database

Let’s start by creating a database for storing and persisting user data.

Now go ahead and fire up Microsoft SSMS and just log in using Windows
authentication. When you're inside the studio management, select File »
New » Query with Current Connection just like in the following figure:

© Vincent Maverick S. Durano 2019 63
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L‘; Microsoft SQL Server Management Studio
File | Edit View Debug Tools Window Help
¥ Connect Object Explorer...

¥ Disconnect Object Explorer

MNew 4

Project... Ctrl+Shift+N

Query with Current Connection Ctrl+N
Database Engine Query
47 Analysis Services MDX Query

Ctrl+S s Analysis Services DMX Query
12 Analysis Services XMLA Query
Ctrl+Shift+S srl  Analysis Services DAX Query

Policy

B Ext Alt+F4

Figure 3-1. Create a new query editor

Copy the following SQL script in the query editor:

CREATE Database MemoryGame
GO

USE [MemoryGame ]
GO

CREATE TABLE [dbo].[Challenger](
[ChallengerID] [int] IDENTITY(1,1) NOT NULL,
[FirstName] [varchar](50) NOT NULL,
[LastName] [varchar](50) NOT NULL,
[Email] [varchar](50) NULL,
CONSTRAINT [PK Challenger] PRIMARY KEY CLUSTERED
(
[ChallengerID] ASC
JWITH (PAD_INDEX = OFF, STATISTICS NORECOMPUTE = OFF,
IGNORE_DUP_KEY = OFF,
ALLOW_ROW_LOCKS = ON,
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ALLOW_PAGE_LOCKS = ON)
ON [PRIMARY]
) ON [PRIMARY]

Go

CREATE TABLE [dbo].[Rank](
[RankID] [int] IDENTITY(1,1) NOT NULL,
[ChallengerID] [int] NOT NULL,
[Best] [tinyint] NOT NULL,
[DateAchieved] [datetime] NOT NULL,
CONSTRAINT [PK Rank] PRIMARY KEY CLUSTERED
(
[RankID] ASC
JWITH (PAD_INDEX = OFF, STATISTICS NORECOMPUTE = OFF,
IGNORE DUP_KEY = OFF,
ALLOW_ROW_LOCKS = ON,
ALLOW_PAGE_LOCKS = ON) ON [PRIMARY]
) ON [PRIMARY]

GO

Then click the Execute button or hit F5 as shown in the following figure:

File Edit View Query Project Debug Tools Window Help
OO0 | B 02 HN BNewuey BRI XITD|D -

| "'f'| MemoryGame - | P Execute Debug vicB H 882 l1|

Object Explorer - AD...dmin-PC\user (53))* + X

Connect~ ¥ *# ¢ » -ICREATE Database MemoryGame
= @ ADMIN-PC\SQLEXPRESSO1 (SQL Server 60
=] Databases
@ System Databases -/USE [MemoryGame ]
ol Database Snapshots

—

Figure 3-2. Execute SQL query
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The preceding SQL script should create the “MemoryGame” database
with the following table:

Challenger
¥ ChallengerlD

FirstName
LastName

Email

Rank
¥ RankD
ChallengeriD
Best
DateAchieved

Figure 3-3. The database schema

The database tables that we've created are very plain and simple. The
dbo.Challenger table contains some basic properties for us to identify
a user who plays the game. The dbo.Rank table similarly contains basic
properties to help us identify which user has the highest rank.

Keep in mind that this book doesn’t focuses on databases, so if you
are new to SQL databases, | really recommend that you start looking
at some resources like books or online tutorials to learn the basic
foundations of databases.

Now that we've set up our database, it’s time for us to build a REST
service to handle database calls and CRUD operations. We are choosing
Web API because it’s a perfect fit to build RESTful services in the context
of .NET. It also allows other client apps (mobile apps, web apps, and even
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desktop apps) to consume our API via endpoints. This would enable our

application to allow clients to access data in any type of application as long

as it supports HTTP services.

Creating the ASP.NET Web API Project

Let’s proceed to our work. Switch back to Visual Studio 2017, add a new

project by right-clicking the Solution level, and then select Add » New
Project » Visual C# » Web. Select ASP.NET Web Application (.NET
Framework) and name the project “MemoryGame.API” just like in the

following figure:

Add New Project

b Recent = Sortby Default

4 Installed
@ ASP.NET Core Web Application Visual C#

4 Visual C&
Get Started
Windows Universal

ASP.NET Web Application [.NET Framework) Visual C=

Windows Desktop
b Web
NET Core
MET Standard
Android
Apple TV
Apple Watch ¥
Naot finding what you are looking for?

Open Visual Studic Installer

Narne: MemonyGame. API
Location: cusers\user source\repos\ MemoryGame.App
Framework: MET Framewark 4.6.1

Type: Visual C5

Project templates for creating ASP.NET
applications. You can create ASP.NET Web
Forms, MVC, or Web AP| applications and
add many other features in ASP.NET,

EBrowse...

OK Cancel

Figure 3-4. Create a new ASP.NET Web API project

Click OK and you should be presented with the next screen:
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New ASP.NET Web Application - MemoryGame.API

Empty Web Forms MVC Web API Single Page

Application
4
|

Azure APl App

Add folders and core references for:
[[] WebForms [ ] MVC Web API
[] Enable Docker Compose support (Requires Docker for Windows)

] Add unit tests

Test project name: MemoryGame APl Tests

? X

An empty project template for creating ASP.NET
applications. This template does not have any content
init.

Learn more

Change Authentication

Figure 3-5. Selecting an empty Web API template
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Select “Empty” from the ASP.NET web application project template
and then check the “Web API” option only. Click OK to let Visual Studio
generate the project for you. Here’s how the solution looks now:
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M) MemeryGame.App - Micioseft Visual Studio YB £  QuickLounch (Cul-Q) |P - 8 x

File Edit View Project Build Debug Team Tools Test Anslyze Window Help Vincent Maverick § Duranc - (8]
Q- B2 EN - - Debug - AnyCPU - MemoryGame App.Android - DAmd® . -

g yoame APl 8 X agexami sinPage.xaml.cs - EX

-4

-3

BE- B-SC

Search Solution Explorer (Cute:) P =

21 Solution "MemoryGame.App’ (4 prc

Connected Services A\_) P ; N F T

Publish Learn about the .NE

& Connected Services

latform, create your first application b o Properties
and extend it 1o the cloud b %W References
App_Data
b App_Start
G Controllers
¢T W Models
b &1 Global.asax
Build Your Connect to Learn your ¥ packages.config
App Azure IDE b ) Web.config
b MemoryGameApp
Get started sign up for See our ¥ [ MemoryGame.App-Android
with ASP.NET free productivit b [d MemoryGame.AppiOS
8 Publish your 4 5 »
5 m;-f»-te to '-\'fljté'w:v' Solution Explorer  Team Explorer
HAlure iasier
Setup ¢ Properties o x
continuous MemaoryGame APl Preject Propertie -

o @] =

Emor List Output

Figure 3-6. The default generated files

By default, the ASPNET Web API project configures a combination of
both conventional and attribute-based routing. You can see how the
routing is set up by navigating to the App_Start folder » WebApiConfig.cs.
Here’s what the code looks like:

using System.Web.Http;

namespace MemoryGame.API

{
public static class WebApiConfig

{
public static void Register(HttpConfiguration config)

{

// Web API configuration and services

// Web API routes
config.MapHttpAttributeRoutes();
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config.Routes.MapHttpRoute(
name: "DefaultApi",
routeTemplate: "api/{controller}/{id}",
defaults: new { id = RouteParameter.Optional }

)5

The config.MapHttpAttributeRoutes() line enables attribute routing,
in which you can configure custom routes at the controller or action level
of your Web API class. For more information about attribute routing, read
the following: https://docs.microsoft.com/en-us/aspnet/web-api/
overview/web-api-routing-and-actions/attribute-routing-in-web-
api-2.

The second line of code defines a default route template to the routing
table using convention-based routing. Each entry in the routing table
contains a route template. The default route template for Web API is
“api/{controller}/{id}" In this template, “api” is a literal path segment, and
{controller} and {id} are placeholder variables. When the Web API server
receives an HTTP request, it tries to match the URI against one of the route
templates in the routing table. For more information about conventional
routing, read the following: https://docs.microsoft.com/en-us/aspnet/
web-api/overview/web-api-routing-and-actions/routing-in-aspnet-
web-api.

ASP.NET routing is the ability to have URLSs represent abstract actions
rather than concrete physical files. If you are familiar with ASP.NET MVC,
Web API routing is very similar to MVC routing. The main difference is that
Web API uses the HTTP method, not the URI path, to select the action.

For this demo, we are going to use attribute routing to add route
templates in the routing table because it gives us more flexibility in
defining routes than convention routing.
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Integrating EF

Now that we have our Web API project ready, let’s continue by
implementing our data access layer to work with data from database.

In the software development world, most applications require a data
store or a database. So, we all need a code to read/write our data stored
in a database or a data store. Creating and maintaining code for database
make for tedious work and a real challenge. That’s where an ORM like EF
comes into place.

What Is an ORM?

An ORM enables developers to create data access applications by
programming against a conceptual application model instead of
programming directly against a relational storage schema. The goal is to
decrease the amount of code and maintenance required for data-oriented
applications. ORM like EF provides the following benefits:

e Applications can work in terms of a more application-
centric conceptual model, including types with
inheritance, complex members, and relationships.

e Applications are freed from hard-coded dependencies
on a particular data engine or storage schema.

e Mappings between the conceptual model and the
storage-specific schema can change without changing
the application code.

e Developers can work with a consistent application
object model that can be mapped to various storage
schemas, possibly implemented in different database
management systems.
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e  Multiple conceptual models can be mapped to a single
storage schema.

e Language-integrated query (LINQ) support provides
compile-time syntax validation for queries against a
conceptual model.

What is EF?

To recap, EF is an ORM that enables .NET developers to work with
relational data using domain-specific objects. It eliminates the need for
most of the data access code that developers usually need to write.

This could simply mean that using EF we will be working with
entities (class/object representation of your data structure) and letting
the framework handle the basic create, read, udpate, and delete (CRUD)
operations. In traditional ADO.NET, you will write the SQL queries directly
against tables/columns/procedures and you don’t have entities, so it’s
much less object oriented.

For more information, read the following: https://msdn.microsoft.
com/en-us/library/aa937723(v=vs.113).aspx.

Just like any other ORM, there are two main design workflows
supported by EF: In the Code-First approach, you create your classes
(POCO entities) and generate a new database out from them. The
Database-First approach allows you to use an existing database and
generate classes based on your database schema. For this demo, we're
going to use a Database-First approach, as we already have an existing
database created.
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Setting Up a Data Access Layer

In the MemoryGame.API project, create a new folder called “DB” under
the Models folder. Within the “DB” folder, add an ADO.NET Entity Data
Model. To do this, just follow these steps:

1.

Right-click the “DB” folder and then select Add »
New Item.

On the left pane under Visual C# item, select Data
» ADO.NET Entity Data Model.

Name the file as “MemoryGameDB” and then
click Add.

In the next wizard, select EF Designer from
Database and then click Next.

Click the “New Connection...” button.

Select Microsoft SQL Server under Data source
and click Continue.

Supply the database server name to where you
created the database. In my case, the name of

my SQL server is “ADMIN-PC\SQLEXPRESSO01".
Remember that yours can be different, so make sure
you supply the correct instance. You can find the

server name in SSMS.

Select or enter the database name. In this case, the
database name for this example is “MemoryGame”.

Click the Test Connection button to see if it’s
successful just like in the following figure:
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Enter information to connect to the selected data source or click "Change” to choose a different
data source and/or provider.

D

ata source:

| lMicrosoﬂ SQL Server (SqiClient) | Change...

Server name:

| ADMIN-PC\SQLEXPRESSO1 v| | Refresh

Authentication:

Log on to the server

Microsoft Visual Studio X

Password o Test connection succeeded.

Sav|

Connect to a database

(®) Select or enter a database name:

wind. Athanticati w

lMemoryGame v

(O Attach a database file:

Browse...

Advanced...

Figure 3-7. Testing the database connection
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10. Click OK to close the pop-up dialog and click OK

11.

again to generate the connection string that will be
used for our application.

In the next wizard, click Next.
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12. Select EF 6.x and then click Next.

13. Select the “Challenger” and “Rank” tables and then
click Finish.

The .EDMX file should now be added under the “DB” folder just like in
the following figure:

ﬂl MemoryGame.App - Microsoft Visual Studic YH & QuickLaunch (Ctri+Q) B - o x

File Edit View Project Buld Debug Team Tools Test Analyze Window Vincent Maverick S Durano - [l
Help

©-0 B-uHEM - - |Debug - AnyCPU - Dambe. DO
MemoryGameDB.edmax [Diagram1] + X MemoryGame.API Bl Solution Explorer 3 Xx
- @el- o-SCI@

Search Solution Explorer (Ctri+;) 2=

x0q|00]

il Solution ‘MemoryGame.App' (4 projects) =~
4§ MemoryGame AP
&p Connected Services

Sp 5 Ep = b ¥ Properties
roperti L ]
¥ ChallengeriD ¢¢ RankiD hiE :ﬁef;::ﬂ
M FirstName K ChallengerlD 3 A::_Stal:
& LastName & Best Controllers
& Email K DateAchieved 4 Models
= Navigation Properties = Navigation Properties
b 4 MemoryGameDB.edmx
b &) Global.asax
- ¥.) packages.config
a b & Weh.ranfin x
:;c Seolution Explorer | Team Explorer
I . :3; Properties v ix
-

EmorList Output

4 Addto Source Control =

Figure 3-8. The generated entity models

What happens there is that EF automatically generates the business
objects for you and lets you query against it. The EDMX or the entity data
model will serve as the main gateway by which you retrieve objects from
the database and resubmit changes.

Under the hood, the EDMX file contains the following child files:

e MemoryGameDB.Context.tt

e MemoryGameDB.Designer.cs
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e MemoryGameDB.Edmx.diagram
e MemoryGameDB.tt

The MemoryGameDB.Context.tt is a Visual Studio text template
file (a.k.a. T4 template). A T4 text template is a mixture of text blocks and
control logic that can generate a text file. The control logic is written as
fragments of program code in Visual C#. Expanding the MemoryGameDB.
Context.tt file will show the MemoryGameDB.Context.cs, which contains
the following code block:

namespace MemoryGame.API.Models.DB

{
using System;
using System.Data.Entity;
using System.Data.Entity.Infrastructure;
public partial class MemoryGameEntities : DbContext
{
public MemoryGameEntities()
: base("name=MemoryGameEntities")
{
}
protected override void OnModelCreating(DbModelBuilder
modelBuilder)
{
throw new UnintentionalCodeFirstException();
}
public virtual DbSet<Challenger> Challengers { get; set; }
public virtual DbSet<Rank> Ranks { get; set; }
}
}
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The MemoryGameEntities class represents a session with the
database and allows you to query and save instances of the entity classes.
This class derives from DbContext and exposes DbSet virtual properties
that represent collections of the specified entities in the context. Since we
are working with the EF Designer (EDMX), the context is automatically
generated for us. If you are working with the Code-First approach, you will
typically write the context yourself.

You may have noticed that the models generated are created as partial
classes. This means that you can extend them by creating another partial
class for each of the entity model classes when necessary.

Once you have a model, the primary class your application interacts
with is System.Data.Entity.DbContext (often referred to as the context
class). You can use a DbContext associated to a model to:

o Write and execute queries

o Materialize query results as entity objects

o Track changes that are made to those objects
o Persist object changes back on the database
» Bind objects in memory to UI controls

The MemoryGameDB.tt contains the following generated classes
based from the table we defined from the database:

e Challenger.cs

namespace MemoryGame.API.Models.DB

{
using System;
using System.Collections.Generic;

public partial class Challenger

{
public int ChallengerID { get; set; }
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public string FirstName { get; set; }
public string LastName { get; set; }
public string Email { get; set; }

¢ Rank.cs

namespace MemoryGame.API.Models.DB

{
using System;
using System.Collections.Generic;
public partial class Rank
{
public int RankID { get; set; }
public int ChallengerID { get; set; }
public byte Best { get; set; }
public System.DateTime DateAchieved { get; set; }
}
}

The classes generated in the preceding will be used as a type of DbSet
objects. The DbSet class represents an entity set that can be used for CRUD
operations.

The DbSet class is derived from IQuerayable. So, we can use LINQ for
querying against DbSet, which will be converted to a SQL query. EF API
executes this SQL query to the underlying database, gets the flat result set,
converts it into appropriate entity objects, and returns it as a query result.
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Implementing CRUD Operations

The next step is to create a central class for handling CRUD operations. Now,
create a new folder called “DataManager” under the Models folder. Right-
click the DataManager folder and select Add » New » Class. Name the class
as “GameManager’, click the Add button, and then copy the following code:

using System;

using System.Collections.Generic;
using System.Ling;

using MemoryGame.API.Models.DB;

namespace MemoryGame.API.Models.DataManager

{

#region DTO
public class ChallengerViewModel

{
public int ChallengerID { get; set; }
public string FirstName { get; set; }
public string LastName { get; set; }
public byte Best { get; set; }
public DateTime DateAchieved { get; set; }
}
#endregion

#iregion HTTP Response Object
public class HTTPApiResponse

{
public enum StatusResponse
{
Success = 1,
Fail = 2
}
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80

public StatusResponse Status { get; set; }
public string StatusDescription { get; set; }
public int StatusCode { get; set; }

}

#endregion

#region Data Access
public class GameManager

{

public IEnumerable<ChallengerViewModel> GetAll { get {
return GetAllChallengerRank(); } }

public List<ChallengerViewModel> GetAllChallengerRank()
{
using (MemoryGameEntities db = new
MemoryGameEntities())
{
var result = (from c in db.Challengers
join r in db.Ranks on
c.ChallengerID equals
r.ChallengerID
select new ChallengerViewModel
{
ChallengerID = c.ChallengerID,
FirstName = c.FirstName,
LastName = c.LastName,
Best = r.Best,
DateAchieved = r.DateAchieved
}) .OrderByDescending(o => o.Best)
.ThenBy(o => o.DateAchieved);

return result.Tolist();
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}
public HTTPApiResponse UpdateCurrentBest(DB.Rank user)

{

using (MemoryGameEntities db = new MemoryGameEntities())
{
var data = db.Ranks.Where(o => o.ChallengerID
== user.ChallengerID);
if (data.Any())
{
Rank rank = data.FirstOrDefault();
rank.Best = user.Best;
rank.DateAchieved = user.DateAchieved;
db.SaveChanges();
}

else

{
db.Ranks.Add(user);

db.SaveChanges();

}

return new HTTPApiResponse

{

Status = HTTPApiResponse.StatusResponse.Success,
StatusCode = 200,
StatusDescription = "Operation successful."

b
}

public int GetChallengerID(string email)
{

using (MemoryGameEntities db = new MemoryGameEntities())

{
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var data = db.Challengers.Where(o => o.Email.
ToLower().Equals(email.ToLower()));
if (data.Any())

{
return data.FirstOrDefault().ChallengerID;
}
return 0;
}

}
public HTTPApiResponse AddChallenger(DB.Challenger c)
{

HTTPApiResponse response = null;
using (MemoryGameEntities db = new MemoryGameEntities())
{
var data = db.Challengers.Where(o => o.Email.
ToLower().Equals(c.Email.ToLower()));
if (data.Any())

{
response = new HTTPApiResponse
{
Status = HTTPApiResponse.
StatusResponse.Fail,
StatusCode = 400,
StatusDescription = "User with
associated email already exist."
};
}
else
{

db.Challengers.Add(c);
db.SaveChanges();
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response = new HTTPApiResponse

{
Status = HTTPApiResponse.StatusResponse.
Success,
StatusCode = 200,
StatusDescription = "Operation successful."”
};

}

return response;

}

public ChallengerViewModel GetChallengerByEmail(string
email)

using (MemoryGameEntities db = new MemoryGameEntities())

{

var result = (from c in db.Challengers
join r in db.Ranks on c.ChallengerID
equals r.ChallengerID
where c.Email.TolLower().Equals(email.
ToLower())
select new ChallengerViewModel
{
ChallengerID = c.ChallengerID,
FirstName = c.FirstName,
LastName = c.LastName,
Best = r.Best,
DateAchieved = r.DateAchieved

};
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if (result.Any())
return result.SingleOrDefault();

}

return new ChallengerViewModel();

}

public HTTPApiResponse DeleteChallenger(int id)
{

HTTPApiResponse response = null;
using (MemoryGameEntities db = new MemoryGameEntities())
{
var data = db.Challengers.hWhere(o => o.ChallengerID == id);
if (data.Any())
{
try
{
var rankData = db.Ranks.Where(o =>
0.ChallengerID == id);
if (rankData.Any())
{
db.Ranks .Remove(rankData. FirstOrDefault());
db.SaveChanges();

b

db.Challengers.Remove(data.FirstOrDefault());
db.SaveChanges();

response = new HTTPApiResponse

{
Status = HTTPApiResponse.

StatusResponse.Success,
StatusCode = 200,
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StatusDescription = "Operation successful."
b5
}
catch (System.Data.Entity.Validation.
DbUnexpected ValidationException)

{
//handle error and log
response = new HTTPApiResponse
{
Status = HTTPApiResponse.StatusResponse.Fail,
StatusCode = 500,
StatusDescription = "An unexpected
error occurred."
}s
}
}
else
{
response = new HTTPApiResponse
{
Status = HTTPApiResponse.StatusResponse.Fail,
StatusCode = 400,
StatusDescription = "Associated ID not found."
}s
}

return response;
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Let’s take a look of what we just did there.

The preceding code is composed of three main regions: The Data
Transfer Object (DTO), the HTTP Response Object, and the GameMananger
class. Let’s break this down into code details. We will start with the DTO:

public class ChallengerViewModel

{
public int ChallengerID { get; set; }
public string FirstName { get; set; }
public string LastName { get; set; }
public byte Best { get; set; }
public DateTime DateAchieved { get; set; }
}

The ChallengerViewModel DTO is nothing but a plain class that
houses some properties that will be used in the view or any client that
consumes the API.

Next code block:

public class HTTPApiResponse

{
public enum StatusResponse
{
Success = 1,
Fail = 2
}
public StatusResponse Status { get; set; }
public string StatusDescription { get; set; }
public int StatusCode { get; set; }
}
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The HTTPApiResponse object is class that holds an enum and three
main basic properties: Status, StatusCode, and StatusDescription. This
object will be used in the GameManager class methods as a response or
return type object.

The GameManager class is the central class where we handle the
actual CRUD operations. This is where we use EF to communicate with
the database by working with a conceptual data entity instead of a real
SQL query. EF enables us to work with a database using .NET objects
and eliminates the need for most of the data access code that developers
usually need to write.

Let’s break this down into code details. Let’s start with this code:

public IEnumerable<ChallengerViewModel> GetAll { get { return
GetAllChallengerRank(); } }

The method GetAll is a public property that returns an IEnumerable
<ChallengerViewModel>. The sole purpose of this property is to get the
data; that is why we only set a getter accessor. Creating a property with
only a getter makes your property read-only for any code that is outside
the class.

Next code block:

public List<ChallengerViewModel> GetAllChallengerRank()
{

using (MemoryGameEntities db = new MemoryGameEntities())
{
var result = (from c in db.Challengers
join r in db.Ranks on c.ChallengerID
equals r.ChallengerID
select new ChallengerViewModel
{
ChallengerID = c.ChallengerID,
FirstName = c.FirstName,
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LastName = c.LastName,

Best = r.Best,

DateAchieved = r.DateAchieved
}).0rderByDescending(o => o.Best)
.ThenBy(o => o.DateAchieved);

return result.Tolist();

The method GetAllChallengerRank() basically fetches the
challenger’s profile and its corresponding rank. The first line of the
code within the method creates an instance of the DbContext called
MemoryGameEntities. We wrap the code for instantiating the DbContext
within the using block to ensure that the objects will be properly disposed
of after using them.

The next line uses a LINQ query expression to query the data. The
query joins the db.Challenger and db.Rank DbSets using the join clause.
We then select the data that we need and associate them into a strongly
typed object called ChallengerViewModel, order the results by highest
rank, and return the result by calling the ToList() function. ToList() is an
extension method that sits within the System.Linq namespace, which
converts collections (IEnumerables) to list instances.

Next code block:

public HTTPApiResponse UpdateCurrentBest(DB.Rank user)
{

using (MemoryGameEntities db = new MemoryGameEntities())

{
var data = db.Ranks.Where(o => o.ChallengerID ==

user.ChallengerID);
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if (data.Any())

{
Rank rank = data.FirstOrDefault();
rank.Best = user.Best;
rank.DateAchieved = user.DateAchieved;
db.SaveChanges();

}

else

{
db.Ranks.Add(user);
db.SaveChanges();

}

return new HTTPApiResponse

{
Status = HTTPApiResponse.StatusResponse.Success,
StatusCode = 200,
StatusDescription = "Operation successful."

};

The UpdateCurrentBest() method takes the DB.Rank class as the
parameter. The code block basically gets the Rank object based on the
ChallengerID using the LINQ Where function and assigns the result into a
variable data. We then call the LINQ Any() function to check if the object
contains any single element in a sequence.

If there’s any data returned from the query, then we create an instance
of the Rank class and set the result from the data variable using the
FirstOrDefault() LINQ function. The LINQ FirstOrDefault()is an eager
function that returns the first element of a sequence that satisfies a
specified condition. Once the FirstOrDefault() function is invoked,
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EF will automatically issue a parameterize SQL query to the database, in
which the SQL Server can understand and then bring back the result to
the entity model. We then assign the new values to each field and call the
SaveChanges() method to update the database with the changes.

Otherwise, if there’s no data or if the LINQ Any() function returns false,
then we simply create a new record in the database.

Finally, we return an HTTPApiResponse object indicating that the
operation is successful.

Next code block:

public int GetChallengerID(string email)
{

using (MemoryGameEntities db = new MemoryGameEntities())

{
var data = db.Challengers.Where(o => o.Email.TolLower().
Equals(email.ToLower()));
if (data.Any())

{
return data.FirstOrDefault().ChallengerID;

}

return 0;

As the method name suggests, the GetChallengerID() method gets the
ChallengerID of the challenger by passing an e-mail as the parameter. The
preceding code may be familiar to you by now, as it uses common LINQ
functions that we previously talked about such as the Where(), Any(), and
FirstOrDefault().
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Next code block:

public HTTPApiResponse AddChallenger(DB.Challenger c)

{

HTTPApiResponse response = null;
using (MemoryGameEntities db = new MemoryGameEntities())

{

var data = db.Challengers.Where(o => o.Email.Tolower().
Equals(c.Email.TolLower()));
if (data.Any())

{
response = new HTTPApiResponse
{
Status = HTTPApiResponse.StatusResponse.Fail,
StatusCode = 400,
StatusDescription = "User with associated email
already exist.”
};
}
else
{
db.Challengers.Add(c);
db.SaveChanges();
response = new HTTPApiResponse
{
Status = HTTPApiResponse.StatusResponse.Success,
StatusCode = 200,
StatusDescription = "Operation successful."
}s
}
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return response;

The AddChallengerID() method takes a DB.Challenger class. The
preceding code checks if the data associated with the e-mail already exists
in the database. If it does, then it returns an error; otherwise it adds a new
entry to the database and returns a successful response.

Next code block:

public ChallengerViewModel GetChallengerByEmail(string email)
{

using (MemoryGameEntities db = new MemoryGameEntities())
{
var result = (from c in db.Challengers
join r in db.Ranks on c.ChallengerID
equals r.ChallengerID
where c.Email.ToLower().Equals(email.
ToLower())
select new ChallengerViewModel
{
ChallengerID = c.ChallengerID,
FirstName = c.FirstName,
LastName = c.LastName,
Best = r.Best,
DateAchieved = r.DateAchieved

1

if (result.Any())
return result.SingleOrDefault();

}

return new ChallengerViewModel();
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The code implementation of GetChallengerByEmail() function
is somewhat similar to the GetAllChallengerRank() function. The
only difference is that we filter the data by e-mail using the LINQ
Where() function, and this returns only a single result using the LINQ
SingleOrDefault() function. The SingleOrDefault() function is similar to
FirstOrDefault() in the sense of returning just a single row. However, they
differ in terms of how they are used. Whenever you use SingleOrDefault(),
you clearly state that the query should result in at most a single result. On
the other hand, when FirstOrDefault() is used, the query can return any
number of results, but you state that you only want the first one. Since we
let e-mail be unique, we are sure that e-mails can’t be duplicated, and thus
we opt for SingleOrDefault().

Next code block:

public HTTPApiResponse DeleteChallenger(int id)
{
HTTPApiResponse response = null;
using (MemoryGameEntities db = new MemoryGameEntities())
{
var data = db.Challengers.Where(o => o.ChallengerID == id);
if (data.Any())
{
try
{
var rankData = db.Ranks.Where(o =>
0.ChallengerID == id);
if (rankData.Any())
{
db.Ranks.Remove(rankData.FirstOrDefault());
db.SaveChanges();
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db.Challengers.Remove(data.FirstOrDefault());
db.SaveChanges();

response = new HTTPApiResponse

{

Status = HTTPApiResponse.StatusResponse.
Success,

StatusCode = 200,

StatusDescription = "Operation successful."

};
}
catch (System.Data.Entity.Validation.DbUnexpected
ValidationException)
{
//handle error and log
response = new HTTPApiResponse
{
Status = HTTPApiResponse.StatusResponse.Fail,
StatusCode = 500,
StatusDescription="Anunexpectederror occurred."
};
}
}
else
{
response = new HTTPApiResponse
{
Status = HTTPApiResponse.StatusResponse.Fail,
StatusCode = 400,
StatusDescription = "Associated ID not found."
}s
}
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return response;

The DeleteChallenger() method takes an id as the parameter. This
means it deletes all information for a certain challenger and its associated
rank. The code basically checks for the existence of the challenger by
querying the database using the LINQ Where() function. If the record
exists, then it will delete the record that is associated with the id in both
the Rank and Challenger database tables. Otherwise, it returns a response
saying the associated ID was not found.

To summarize, the GameManager class is composed of the following
methods:

¢ GetAll() - A short method that calls the
GetAllChallengerRank() method and returns an IEnu
merable<ChallengerViewModel>.

e GetAllChallengerRank() - Gets all the challenger
names and their corresponding ranks. It uses LINQ to
query the model and sort the data. This method returns
a List<ChallengerViewModel> object.

e GetChallengerByEmail(string email) - Gets the
challenger information and its corresponding rank by
e-mail. This method returns a ChallengerViewModel
object.

e GetChallengerID(string email) - Gets the challenger
ID by passing an e-mail address as parameter. This
method returns an int type.

e AddChallenger(DB.Challenger c) - Adds a new
challenger to the database. This method returns an
HTTPApiResponse object.
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o UpdateCurrentBest(DB.Rank user) - Updates the
rank of a challenger to the newly achieved high score.
This method returns an HTTPApiResponse object.

o DeleteChallenger(int id) - Deletes a challenger
from the database. This method returns an
HTTPApiResponse object.

A Friendly Reminder

It was my intent not to decouple the actual implementation of the data
access layer, as I'm trying to make this demo as simple as possible. In a
real-world scenario where you want to deal with a complex database and
value the testability of your data access, then I'd recommend you implement
a data repository pattern. The main reason for adding your own repository
implementation is so that you can use Dependencylnjection (DI) and make
your code more testable. EF is not that testable out of the box, but it’s quite
easy to make a mockable version of the EF data context with an Interface
that can be injected. In other words, if you implement an interface for your
data access, other services such as Web API can just use that interface
instead of directly accessing your DBContext from your Web API controller.

The Web API Endpoints

Now that we have our data access ready, we can start creating the API
endpoints to serve data using ASP.NET Web API. As a recap, Web API
is a framework used to build HTTP services and is an ideal platform for
building RESTful applications on the .NET Framework.

Create a new folder called “API” within the root of the MemoryGame.
API application. Right-click the API folder and select Add » Controller.
Select Web API 2 Controller - Empty just like in the following figure:
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Add Scaffeld *
4 |nstalled
¢ Common Web API 2 Controller - Empty
o ‘[: MVC 5 Controller - Empty et

v2.0.0.0

ﬁ: MVC 5 Controller with read/write actions An empty Web AP controller.

,';:' MVC 5 Controller with views, using Entity Framework M ApiControllerEmptyScaffolder
‘[‘ Web API 2 Controller with actions, using Entity Framework

#1% Web API 2 Controller with read/uwrite actions

Web API 2 OData v3 Controller with actions, using Entity
Framework

¥ Web API 2 0Data v3 Controllerwith read/wite actions

lick hen nlin: find mor in nSions.

Figure 3-9. Adding a new empty Web API 2 controller

Click Add and then, on the next screen, name the controller
“GameController” like in the following figure:

Add Controller X

Controller name: | GameController |

| add || Conce |

Figure 3-10. Assigning the controller name
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Click Add and then copy the following code:

using MemoryGame.API.Models.DataManager;
using MemoryGame.API.Models.DB;

using System.Collections.Generic;

using System.Web.Http;

namespace MemoryGame.API.API

{
[RoutePrefix("api/game/players™)]
public class GameController : ApiController

{

GameManager _gm;
public GameController()

{

_gm = new GameManager();

}

[HttpGet, Route("")]
public IEnumerable<ChallengerViewModel> Get()

{
return _gm.GetAll;

}

[HttpGet, Route("{email}")]
public int GetPlayerID(string email)

{
return gm.GetChallengerID(email);

}

[HttpGet, Route("~/api/game/profile/{email}")]
public ChallengerViewModel GetPlayerProfile(string email)
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return _gm.GetChallengerByEmail(email);
}

[HttpPost, Route("")]
public HTTPApiResponse AddPlayer(Challenger user)

{
return _gm.AddChallenger(user);

}

[Route("score")]
[HttpPost]
public void UpdateScore(Rank user)

{
_gm.UpdateCurrentBest(user);

}

[HttpDelete, Route("{id}")]
public HTTPApiResponse DeletePlayer(int id)

{
return gm.DeleteChallenger(id);

The preceding code comprises the Web API endpoint definitions.

It uses an Attribute Routing for defining routes that maps to the actual

code implementation of the endpoint. Let’s break down the code details.

We will start at the class level with the following code:

[RoutePrefix("api/game/players")]
public class GameController : ApiController

//trimmed down code for clarity
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The GameController class is the main entry point for the API
endpoints. This class derives the ApiController class and uses the
RoutePrefix attribute for defining a common prefix for all routes within
the class. In this demo, the common route prefix is “api/game/players”.

ApiControllers contain methods and properties that are specialized in
returning data. For example, they take care of transparently serializing the
data into the format requested by the client. Also, they follow a different
routing scheme by default (as in: mapping URLSs to actions), providing a
RESTful API by convention.

If you have worked with ASPNET MVC, then you are already
familiar with controllers. They work similarly in Web API, but
controllers in Web API derive from the ApiController class
instead of the controller class. The first major difference you
will notice is that actions on Web API controllers do not return
views, they return data.

Next code block:

GameManager _gm;
public GameController()
{

_gm = new GameManager();

This code is the class constructor of the GameController class. This is
where we initialize the creation of the GameManager class instance. The
GameManager is the data access gateway, which contains the methods
for handling CRUD operations. Just to remind you again, you may want to
implement an Interface to decouple the GameManager object from your
Web API controller to make your class more testable.
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Next code block:

[HttpGet, Route("")]
public IEnumerable<ChallengerViewModel> Get()

{
return _gm.GetAll;

The Get() method fetches all challenger data from the database and
returns an IEnumerable<ChallengerViewModel>. Notice that the method
is decorated with the [HttpGet] and [Route] attributes. This means that
this method can be invoked only on a GET Http request and routes to
“api/game/players”. Setting the route attribute to empty ( [Route(“”)] )
automatically maps to the base route defined at the class level.

Next code block:

[HttpGet, Route("{email}")]
public int GetPlayerID(string email)

{
return gm.GetChallengerID(email);

The GetPlayerID() method takes an e-mail as the parameter. This
method invokes the GetChallengerID() from the GameChallenger class,
which returns the ID of a challenger that is associated in the e-mail. This
method can be invoked only on a GET Http request, as we are decorating
the method with the [HttpGet] attribute. The {email} value in the route
is the parameter template holder that maps to the string email parameter
of the GetPlayerID() method. This method routes to the following
endpoint: “api/game/players/testemail.com/’, where “testemail.com” is
the value of e-mail passed to the route template.
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Next code block:

[HttpGet, Route("profile/{email}")]
public ChallengerViewModel GetPlayerProfile(string email)

{
return _gm.GetChallengerByEmail(email);

The GetPlayerProfile() method also takes an e-mail as the
parameter and invokes the GetChallengerByEmail() method from the
GameManager class. This method can be invoked only on a GET Http
request, as we are decorating the method with the [HttpGet] attribute.
This method routes to “api/game/players/profile/testemail.com/’, where
“testemail.com” is the value of e-mail passed to the route template.

Next code block:

[HttpPost, Route("")]
public HTTPApiResponse SavePlayer(Challenger user)
{

return gm.SaveChallenger(user);

The SavePlayer() method takes a Challenger model as the parameter
and creates a new entry into the database. This method invokes the
SaveChallenger() method from the GameManager class and returns an
HTTPApiResponse object. Notice that the method is now decorated with
the [HttpPost]. This means that this method can be invoked only on a
POST Http request and routes to base endpoint “api/game/players”.

Next code block:

[HttpPost, Route("score")]
public void AddScore(Rank user)

{
_gm.UpdateCurrentBest(user);
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The AddScore() method takes a Rank model as the parameter and
creates or updates the current best score of the challenger record in the
database. This method invokes the UpdateCurrentBest() method from
the GameManager class and returns void. This method can be invoked
only on a POST Http request, and it routes to “api/game/players/score”.

Next code block:

[HttpDelete, Route("{id}")]
public HTTPApiResponse DeletePlayer(int id)

{
return _gm.DeleteChallenger(id);

The DeletePlayer() method takes an integer value as the parameter
and deletes the challenger profile and associated rank record in the
database. This method invokes the DeleteChallenger() method of the
GameManager class and returns an HTTPApiResponse object. It uses the
[HttpDelete] attribute to denote that this method can be invoked only on
a DELETE Http request, and it routes to “api/game/players/1’, where “1” is
the value of ID passed into the route table.

The following is a summary of the GameController API endpoints:

HTTP Method C# Method Endpoint (Route) Description
GET Get() api/game/players Gets all the challenger
and rank data
POST AddPlayer(Challenger api/game/players Adds a new
user) challenger
POST UpdateScore(Rank  api/game/players/ Adds or updates a
user) score challenger score
DELETE DeletePlayer(intid)  api/game/players/{id} Removes a player
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HTTP Method GC# Method Endpoint (Route) Description
GET GetPlayerlD(string api/game/players/ Gets the challenger
email) {email} ID based on e-mail
GET GetPlayerProfile(string api/game/players/ Gets the challenger
email) profile/{email} information based
on e-mail

All Web API endpoints in the example are contained within a single
class, as I'm trying to make this demo as simple as possible. In a real-world
scenario when you are dealing with large data models, I would strongly
recommend you separate each controller implementation and follow the
REST standards whenever you can. It’s also recommended to always wrap
your API response with meaningful results and handle possible errors.
You may check out my article about writing a custom wrapper for
managing API exceptions and consistent responses here for an example:
http://vmsdurano.com/asp-net-core-and-web-api-a-custom-wrapper-
for-managing-exceptions-and-consistent-responses/.

Enabling CORS

Now that we have our API endpoints ready, the final step that we are going

to do on this project is to enable CORS. We need this because this API will

be consumed in other applications that probably have difference domains.
Here’s the CORS definition as per the documentation here:

https://msdn.microsoft.com/en-us/magazine/dn532203.aspx
Cross-origin resource sharing (CORS) is a World Wide Web Consortium

(W3C) specification (commonly considered part of HTML5) that lets

JavaScript overcome the same-origin policy security restriction imposed

by browsers. The same-origin policy) means that your JavaScript can

only make AJAX calls back to the same origin of the containing Web page
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(where “origin” is defined as the combination of host name, protocol and
port number). For example, JavaScript on a Web page from http://foo.
com can’t make AJAX calls to http://bar.com (or to http://www. foo. com,
https://foo.comor http://foo.com:999, for that matter).

CORS relaxes this restriction by letting servers indicate which origins
are allowed to call them. CORS is enforced by browsers but must be
implemented on the server, and the most recent release of ASPNET Web API
2 has full CORS support. With Web API 2, you can configure policy to allow
JavaScript clients from a different origin to access your APIs.

To enable CORS in ASP.NET Web API, do the following:

1. Install Microsoft.AspNet.WebApi.Cors via nugget.
The latest stable version as of this time of writing is
5.2.6.

2. Navigate to the App_Start folder and then open
WebApiConfig.cs. Add the following code to the
WebApiConfig.Register method:

config.EnableCors();

3. Open the GameController class and then declare
the following namespace:

using System.Web.Http.Cors;

4. Finally, add the [EnableCors] attribute just like in
the following:

[EnableCors(origins: "http://localhost:60273",
headers: "*", methods: "*")]
public class GameController : ApiController

105


http://foo.com
http://foo.com
http://bar.com
http://www.foo.com
https://foo.com
http://foo.com:999

CHAPTER 3  CONFIGURING DATA ACCESS AND API ENDPOINTS

Note that you’ll have to replace the value of origins based on the

Wy

URI of the consuming client. Otherwise, you can use the “*” wildcard to
allow any domain to access your API.

At this point, we are done creating the required API endpoints. Before
moving into the Chapter 4, I would suggest you do a Clean and then

Rebuild to ensure that the application has no compilation errors.

Sample cURLs

One of the advantages of REST APIs is that you can use almost any
programming language to call the endpoint. The endpoint is simply a
resource located on a web server at a specific path.

Each programming language has a different way of making web calls.
Rather than exhausting your energy by trying to show how to make web
calls in .NET, Java, Python, C++, JavaScript, Ruby, and so on, you can just
show the call using cURL.

cURL provides a generic, language-agnostic way to demonstrate HTTP
requests and responses. Users can see the format of the request, including
any headers and other parameters. Your users can translate this into the
specific format for the language they're using.

You can test out the API endpoints that we've created earlier yourself
by using the following cURLs:

e GetAll Players

curl -X GET \
http://localhost:56393/api/game/players \
-H 'Cache-Control: no-cache' \

e Getthe Player ChallengerID

curl -X GET \
http://localhost:56393/api/game/players/testemail.com/ \
-H 'Cache-Control: no-cache' \
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e Getthe Player Profile

curl -X GET \
http://localhost:56393/api/game/players/profile/
testemail.com/ \
-H 'Cache-Control: no-cache' \

e Add a New Player

curl -X POST \
http://localhost:56393/api/game/players \
-H 'Cache-Control: no-cache' \
-H 'Content-Type: application/json' \
-d '
"Email":"vynnmarkus@email.com",

"FirstName":"Vynn Markus",

"LastName" :"Durano”
} 1
e Update a Player Score

curl -X POST \
http://localhost:56393/api/game/players/score \
-H 'Cache-Control: no-cache' \
-H 'Content-Type: application/json' \
-d
"ChallengerID":1,
"Best":3,
"DateAchieved":"9/23/2018 4:16"
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e Delete a Player

curl -X DELETE \
http://localhost:56393/api/game/players/1 \
-H 'Cache-Control: no-cache' \

The following table shows the cURL commands used and their
descriptions from the preceding examples:

Command Description

-X The -X signifies the method used for the request. Common options are
GET, POST, DELETE, PUT.

-H Submits the request header to the resource. This is very common with
REST API requests because the authorization is usually included in the
header.

-d Includes data to post to the URL. The data needs to be URL encoded.

Data can also be passed in the request body.

For the available list of the cURL commands that you can use, see the
cURL documentation here: https://curl.haxx.se/docs/manpage.html

Testing with Postman

You can also download Postman to test out the API endpoints that we have
created earlier. Postman is really a handy tool to test APIs without needing
to create a UI, and it’s absolutely free. Get it here: waw.getpostman.com/
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Here’s a sample screenshot of the API tested in Postman:

http:/flocalhost:56393/api/game/players Params “ Save v

POST ~
(1) Eody ® p T Cookies Code
form-data xwww-form-urlencoded @ raw binary  |SON (application/json) ¥
19
2 "Email”:"vynnmarkus@email.com™,
“FirsthHame™:"Vynn Markus®,
“LastName":"Duranc”
)
Body (10 est | Stalus: 200 0K Time: 14776ms  Size: 4618
Pretty JSON + = m Q
1- {
2 “Status™: 1,
3 "StatusDescription”™: "Operation successful.”,
4 “StatusCode™: 200
5 I}

Figure 3-11. Testing an API with Postman

109



CHAPTER 4

Building Mobile
Application with
Xamarin.Forms

Now that we have the API ready, we can start implementing the Memory
Game mobile application and start consuming the Web API that we've
just created in the Chapter 3. Go head and navigate to MemoryGame.App
project and then create the following folders:

e REST - this folder is where we put the class for
managing REST API calls.

o Services - this folder is where we put the interfaces that
the application is going to need.

o Classes - this folder is where application-specific
classes such as Helpers, Settings, and Data Manager are
stored.

o Pages - this folder is where the XAML files needed for
the application are stored.

We are doing it this way in order for us to easily manage the files by just
looking at the folder for ease of navigation and maintainability.

© Vincent Maverick S. Durano 2019 111
V.M. S. Durano, Understanding Game Application Development,
https://doi.org/10.1007/978-1-4842-4264-3_4



CHAPTER 4  BUILDING MOBILE APPLICATION WITH XAMARIN.FORMS

Implementing the Service Interfaces

We are going to use an interface to define a common method in which
other applications can implement it. This is because Android and i0S
platforms have different code implementations to deal with device
vibration, playing a sound, and storage.

An interface is just a skeleton of a method without the actual
implementation. This means that the application which implements
the interface will create a class to perform a concrete platform-specific

implementation.

The IHaptic Interface

Let’s create a few services that our app will need. Let’s start by adding the
IHaptic interface. To do this, right-click the Services folder and then select
Add » New Item. On the left pane under Visual C# Items » Code, select
Interface and name it “IHaptic.cs” just like in the following figure:

Add New Item - MemoryGame.App 7 %
4 Installed Sortby: Default - o= Search (Ctrl+E P
Vi | C# I T -
= 'sugoje ers q':j Class Visual C# items Type: Visual CEltems
. = An empty interface definition
it
G::nal C@ Interface Visual C# ltems
SQL Server -t 5
Code Fil Visual C= It
> Web h‘] ode File isual ems

Windows Forms
Xamarin.Forms

b Online

MName: IHaptic.cs

Add || Cancel

Figure 4-1. Adding a new interface file
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Click Add and then replace the default generated code with the
following code:

namespace MemoryGame.App.Services

{
public interface IHaptic
{
void ActivateHaptic();
}
}

The preceding code is nothing but a simple interface definition that
contains a void method called ActivateHaptic().

The ILocalDataStore Interface

Create another interface file under the Services folder. Name the file as
“ILocalDataSource.cs” and replace the default generated code with the
following:

namespace MemoryGame.App.Services

{
public interface ILocalDataStore
{
void SaveSettings(string fileName, string text);
string LoadSettings(string fileName);
}
}

The ILocalDataStore interface contains two main methods:
SaveSettings() takes a file name and a text as the parameter. The
LoadSettings() method takes a file name as a parameter and returns a

string type.
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The ISound Interface

Lastly, create another interface and name it “ISound.cs” Replace the
default generated code with the following:

namespace MemoryGame.App.Services

{
public interface ISound
{
bool PlayMp3File(string fileName);
bool PlayWavFile(string fileName);
}
}

The ISound interface contains two main boolean methods:
PlayMp3File() and PlayWavFile(), which takes a file name as the
parameter.

The reason we are creating the preceding services/interfaces is
because iOS and Android have different code implementations for setting
device vibration and sound. That’s why we are defining interfaces so both
platforms can just inherit from it and implement code-specific logic.

Let’s move on by creating the following files within the Classes folder:

e Helper.cs
o Settings.cs
o PlayerManager.cs

e MemoryGame.cs
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The Helper Class

Create a new class called “Helper.cs” under the Classes folder and then

replace the default generated code with the following code:

using Plugin.Connectivity;

namespace MemoryGame.App.Helper

{

public static class StringExtensions

{
public static int ToInteger(this string numberString)
{
int result = 0;
if (int.TryParse(numberString, out result))
return result;
return O;
}
}
public static class Utils
{
public static bool IsConnectedToInternet()
{
return CrossConnectivity.Current.IsConnected;
}
}

The Helper.cs file is composed of two classes: StringExtension and

Utils. The StringExtension class contains a ToIntenger() extension

method that accepts a string containing a valid numerical value and

converts it into an integer type. The Utils class, on the other hand,

contains an IsConnectedToInternet() method to verify Internet

connectivity. We will be using these methods later in our application.
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The Settings Class

Create another class within the Classes folder and name it “Settings.cs”.
Replace the default generated code with the following:

using Plugin.Settings;
using Plugin.Settings.Abstractions;
using System;

namespace MemoryGame.App.Classes

{

public static class Settings

{
private static ISettings AppSettings => CrossSettings.
Current;

public static string PlayerFirstName

{
get => AppSettings.GetValueOrDefault(nameof(Player
FirstName), string.Empty);
set => AppSettings.AddOrUpdateValue(nameof(Player
FirstName), value);

}

public static string PlayerLastName

{
get => AppSettings.GetValueOrDefault(nameof(Player
LastName), string.Empty);
set => AppSettings.AddOrUpdateValue(nameof(Player
LastName), value);

}

116



CHAPTER 4  BUILDING MOBILE APPLICATION WITH XAMARIN.FORMS

public static string PlayerEmail

{

}

get => AppSettings.GetValueOrDefault(nameof(Player
Email), string.Empty);

set => AppSettings.AddOrUpdateValue(nameof(Player
Email), value);

public static int TopScore

{

}

get => AppSettings.GetValueOrDefault(nameof
(TopScore), 1);

set => AppSettings.AddOrUpdateValue(nameof
(TopScore), value);

public static DateTime DateAchieved

{

}

get => AppSettings.GetValueOrDefault(nameof(Date
Achieved), DateTime.UtcNow);

set => AppSettings.AddOrUpdateValue(nameof(Date
Achieved), value);

public static bool IsProfileSync

{

get => AppSettings.GetValueOrDefault(nameof
(IsProfileSync), false);
set => AppSettings.AddOrUpdateValue(nameof
(IsProfileSync), value);
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public static int PlayerID

{
get => AppSettings.GetValueOrDefault(nameof(Player
1D), 0);
set => AppSettings.AddOrUpdateValue(nameof(Player
1D), value);

}

The Settings.cs file contains a few static properties that we are going
to use in the application. They are defined static so that we don’t need to
create an instance of the class when calling them; that’s what the Helper
or Utility class is meant for. We are defining them in the Settings.cs file
to separate them from the Helper class for one sole purpose: having a
central location for shared properties that can be accessed across all our
applications. You can think of it as a local data store for the user’s data and
application configuration.

Let’s look at a quick example:

public static string PlayerFirstName

{
get => AppSettings.GetValueOrDefault(nameof(PlayerFirst
Name), string.Empty);
set => AppSettings.AddOrUpdateValue(nameof(PlayerFirst
Name), value);

}

The PlayerFirstName is a static property that contains Expression-
Bodied Members for getting and setting values. Expression-bodied
functions are another syntax simplification in C# 6.0. These are functions
with no statement body. Instead, you implement them with an expression
following the function declaration.
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This code is an example of expression body definition:

get => AppSettings.GetValueOrDefault(nameof(PlayerFirstName),
string.Empty);

The preceding code gets the value of PlayerFirstName and sets a
default value to string. Empty.
C# 7.0 introduces this syntax for setters:

set => AppSettings.AddOrUpdateValue(nameof(PlayerFirstName), value);

The preceding code sets the PlayerFirstName with the new value
assigned and stores it locally in the device.

For more information on Expression-Bodied Members, read the
Jollowing: https://docs.microsoft.com/en-us/dotnet/csharp/
programming-guide/statements-expressions-operators/expression-
bodied-members

The Settings plug-in saves specific properties directly to each
platform’s native setting APIs (NSUserDefaults in iOS, SharedPreferences
in Android, etc.). This ensures the fastest, securest, and most reliable
creation and editing settings per application.

For more information about the Settings plug-in, see the following:
https://jamesmontemagno.github.io/SettingsPlugin/

The DTO Class

Create another class within the Classes folder and name it “DTO.cs”.
Replace the default generated code with the following:

using System;

namespace MemoryGame.App.Classes

{
public class PlayerProfile

{
public string FirstName { get; set; }
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public string LastName { get; set; }
public string Email { get; set; }

}
public class PlayerScore
{
public int ChallengerID { get; set; }
public byte Best { get; set; }
public DateTime DateAchieved { get; set; }
}
public class PlayerData
{
public string FirstName { get; set; }
public string LastName { get; set; }
public byte Best { get; set; }
public DateTime DateAchieved { get; set; }
}

The DTO file contains three main classes: The PlayerProfile,
PlayerScore, and PlayerData. We will use these classes as DTOs for
passing information from one place to another.

The GameAPI Class

Since we finished creating the Web API earlier, it’s time for us to create
a class that consumes the API endpoints. Create a new class called
“GameAPI.cs” under the REST folder and then replace the default
generated code with the following code:

using System;
using System.Text;
using System.Threading.Tasks;
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using Newtonsoft.Json;

using MemoryGame.App.Classes;
using System.Net.Http;
using System.Net.Http.Headers;

namespace MemoryGame.App.REST

{

public class GameAPI

{

//replace the value of APIUri with the published URI to
where your API is hosted.
//E.g http://yourdomain.com/yourappname/api/game
private const string APIUri = "http://localhost:56393/
api/game/players";
HttpClient client;
public GameAPI()
{
client = new HttpClient();
client.MaxResponseContentBufferSize = 256000;
client.DefaultRequestHeaders.Clear();
//Define request data format
client.DefaultRequestHeaders.Accept.Add(new Media
TypeWithQualityHeaderValue("application/json™));

}

public async Task<bool> SavePlayerProfile(PlayerProfile
data, bool isNew = false)

{

var uri = new Uri(APIUri);

var json = JsonConvert.SerializeObject(data);
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}

var content = new StringContent(json, Encoding.
UTF8,"application/json");

HttpResponseMessage response = null;
if (isNew)
response = await ProcessPostAsync(uri, content);

if (response.IsSuccessStatusCode)

{
Settings.IsProfileSync = true;

return true;

}

return false;

public async Task<bool> SavePlayerScore(PlayerScore data)

{

}

var uri = new Uri($"{APIUri}/score");

var json = JsonConvert.SerializeObject(data);

var content = new StringContent(json, Encoding.
UTF8,"application/json");

var response = await ProcessPostAsync(uri, content);

if (response.IsSuccessStatusCode)
return true;

return false;

public async Task<int> GetPlayerID(string email)

{
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var response = await ProcessGetAsync(uri);

if (response.IsSuccessStatusCode)

{
var content = await response.Content.
ReadAsStringAsync();
id = JsonConvert.DeserializeObject<int>(content);

}

return id;

public async Task<PlayerData> GetPlayerData(string
email)

{

}

var uri = new Uri($"{APIUri}/profile/{email}/");
PlayerData player = null;

var response = await ProcessGetAsync(uri);
if (response.IsSuccessStatusCode)

{
player = new PlayerData();
var content = await response.Content.
ReadAsStringAsync();
player = JsonConvert.DeserializeObject
<PlayerData>(content);

}

return player;

private async Task<HttpResponseMessage>
ProcessPostAsync(Uri uri, StringContent content)

{

return await client.PostAsync(uri, content);
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private async Task<HttpResponseMessage>
ProcessGetAsync(Uri uri)

{

return await client.GetAsync(uri);

The preceding code is pretty much self-explanatory, as you could
probably guess by its method name. The class just contains a method that
calls the API endpoints that we created in the previous section. If the code
does not make sense to you now, don’t worry as we will talk about it later
in this section.

Async and Await Overview

Before we dig into the code implementation details of the GameAPI class,
let’s have a quick overview of the Async and Await concepts in C#.
Asynchronous programming is all about writing code that allows
several things to happen at the same time without “blocking,” or
waiting for other things to complete. This is different from synchronous
programming, in which everything happens in the order it is written. In
order to perform an asynchronous operation, a method should be marked
as async: this tells the compiler that the method can run asynchronously.
The await keyword is used in conjunction with the async keyword to tell
the compiler to wait for the Task without blocking code execution.
The async keyword only enables the await keyword. The await keyword
is where things can get asynchronous. Await is like a unary operator: it
takes a single argument, an awaitable Task or Task<T> (an “awaitable” is
an asynchronous operation). Await examines that awaitable to see if it has
already completed; if the awaitable has already completed, then the method
just continues running (synchronously, just like a regular method).
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The Task and Task<T> represent an asynchronous operation that can
be waited. A Task does not return a value, while Task<T> does.

Note If an async method doesn’t use an await operator to mark
a suspension point, the method executes as a synchronous method
does, despite the async modifier. The compiler issues a warning for
such methods.

Here’s a brief definition of the async and await keywords taken from
the official documentation here: https://docs.microsoft.com/en-us/
dotnet/csharp/programming-guide/concepts/async/

The async and await keywords in C# are the heart of async
programming. By using those two keywords, you can use resources in
the .NET Framework, .NET Core, or the Windows Runtime to create an
asynchronous method almost as easily as you create a synchronous method.
Asynchronous methods that you define by using the async keyword are
referred to as async methods.

Method Definitions

Now that you have a basic idea regarding how asynchronous programming
works, let’s see what the code does by breaking them. Let’s start with the
GameAPI constructor code block:

private const string APIUri = "http://localhost:56393/api/game/
players";
HttpClient client;
public GameAPI()
{
client = new HttpClient();
client.MaxResponseContentBufferSize = 256000;
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client.DefaultRequestHeaders.Clear();

//Define request data format
client.DefaultRequestHeaders.Accept.Add(new MediaTypeWith
QualityHeaderValue("application/json"));

The APIUri is a private variable that holds the base API endpoint
value. In this example, it uses the value http://localhost:56393/api/
game/players, which points to my local development IIS Express host. The
value “http://localhost:56393” is automatically created for you once
you run the application in Visual Studio. You need to change this value
with the published URI to where your API is hosted. We'll talk more about
that later in the Chapter 6.

It was my intent to put the value of APIUri within the GameAPI class
Jfor the sake of simplicity. In real-world applications, it is recommended
to store the value of APIUYi in a configuration file, where you can easily

modify the value.

The HttpClient object is declared on the second line. HttpClient is a
modern HTTP client for .NET. It provides a flexible and extensible API for
accessing all things exposed through HTTP.

On the next line is the GameAPI class constructor. This is where the
HttpClient is initialized and configured with a few properties for setting the
MaxResponseContentBufferSize and DefaultRequestHeader media type.

Next code block:

public async Task<bool> SavePlayerProfile(PlayerProfile data,
bool isNew = false)

{

var uri = new Uri(APIUri);

var json = JsonConvert.SerializeObject(data);
var content = new StringContent(json, Encoding.UTF8,"
application/json");
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HttpResponseMessage response = null;
if (isNew)
response = await ProcessPostAsync(uri, content);

if (response.IsSuccessStatusCode)
{
Settings.IsProfileSync = true;
return true;

}

return false;

The SavePlayerProfile() takes a PlayerProfile object and an optional
bool isNew flag parameter. This method is defined as asynchronous by
marking it as async and returns a Task of type bool.

Inside the method, we define a new Uri object that takes the
APIUTri as the parameter. We then serialize the data using Newtonsoft’s
JsonCovert.SerializeObject() method and pass the result into a json
variable. After the data has been serialized, we create a StringContent
object with the format “application/json” and the encoding set to UTF8.
The StringContent class creates a formatted text appropriate for the http
server/client communication. After a client request, a server will respond
with an HttpResponseMessage and that response will need a content; that
can be created with the StringContent class.

In the next line, we create an instance of the HttpResponseMessage
object and we check for the isNew flag to do some validation. If the flag
value is true, we call an awaitable Task called ProcessPostAsync() and
pass along the uri and content values. The awaitable Task return is then
assigned to an HttpResponseMessage object called response. If the
response is successful, then we set the value of Settings.IsProfileSync to
true and return true to the method. Otherwise, if the flag value is false or
the response isn’t successful, we simply return false to the method.
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Next code block:

public async Task<bool> SavePlayerScore(PlayerScore data)

{

var uri = new Uri($"{APIUri}/score");

var json = JsonConvert.SerializeObject(data);

var content = new StringContent(json, Encoding.UTF8,
"application/json");

var response = await ProcessPostAsync(uri, content);

if (response.IsSuccessStatusCode)
return true;

return false;

The SavePlayerScore() method is also an asynchronous method
that takes a PlayerScore object as a parameter. The first line in the
method defines a new Uri object that takes the $“{APIUri}/score” as the
parameter. The $ character denotes an interpolated string. You can think
of it as a shorthand syntax for the string.Format method, but it's more
readable and convenient. In this case, the value of $“{APIUri}/score” will
be translated to “http://localhost:56393/api/game/players/score”.

Next, we serialize the data using Newtonsoft’s JsonCovert.
SerializeObject() method and pass the result into a json variable. After
the data has been serialized, we then create a StringContent object with
specific formatting. It then returns true for a successful response and
otherwise returns false.

Next code block:

public async Task<int> GetPlayerID(string email)

{
var uri = new Uri($"{APIUri}/{email}/");
int id = 0;
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var response = await ProcessGetAsync(uri);
if (response.IsSuccessStatusCode)

{
var content = await response.Content.
ReadAsStringAsync();
id = JsonConvert.DeserializeObject<int>(content);
}
return id;

The GetPlayerID() method is an asynchronous method that takes a string
as a parameter and returns a Task of type int. Just like the previous async
methods, the first line defines a new Uri object that takes an interpolated
string value. The $“/APIUri}/{email}/” will be translated to something like
“http://localhost:56393/api/game/players/testemail.com/".

The next line initializes a variable called id of type int with a default
value of 0. It then calls an awaitable Task called ProcessGetAsync()and
passes the uri variable to it. If the response is successful, it calls another
awaitable Task called ReadAsStringAsync() and assigns the result to
avariable called content. It then deserializes the content value using
Newtonsoft’s JsonConvert.DeserializeObject() and assigns the result to
the variable called id. Finally, the value of id is returned to the method.

Next code block:

public async Task<PlayerData> GetPlayerData(string email)

{
var uri = new Uri($"{APIUri}/profile/{email}/");
PlayerData player = null;
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var response = await ProcessGetAsync(uri);
if (response.IsSuccessStatusCode)

{
player = new PlayerData();
var content = await response.Content.
ReadAsStringAsync();
player = JsonConvert.DeserializeObject<PlayerData>
(content);

}

return player;

The preceding method is pretty much similar to the GetPlayerID()
method except that it returns an object rather than an int. The
GetPlayerData() method is also an asynchronous method that takes
a string as a parameter and returns a Task of type PlayerData. The
PlayerData is a class we defined in the DTO file that houses a few
properties. The first line within the method defines a new Uri object that
takes an interpolated string value. The $“/APIUri}/profile/{email}/” value
will be translated to something like “http://localhost:56393/api/game/
players/profile/testemail.com/’.

The next line initializes a variable called player of type PlayerData.
It then calls an awaitable Task called ProcessGetAsync() and passes the
uri variable to it. If the response is successful, it calls another awaitable
Task called ReadAsStringAsync() and assigns the result to a variable
called content. It then deserializes the content value using Newtonsoft’s
JsonConvert.DeserializeObject() and assigns the result to the variable
called player. If the response is not successful, then it returns the player
variable with a null value to the method; otherwise, it returns the player
variable with the associated data assigned from the API response.
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Next code block:

private async Task<HttpResponseMessage> ProcessPostAsync(Uri
uri, StringContent content)

{

return await client.PostAsync(uri, content); ;

}

private async Task<HttpResponseMessage> ProcessGetAsync(Uri uri)

{

return await client.GetAsync(uri);

The last two private methods in the preceding are used to handle
common operations. The ProcessPostAsync() is an async method that
takes a Uri and StringContent as parameters and returns a Task of type
HttpResponseMessage. This method basically calls the PostAsync()
method of the HttpClient object.

On the other hand, the ProcessGetAsync() takes only a Uri as a
parameter and returns a Task of type HttpResponseMessage. This method
calls the GetAsync() method of the HttpClient object.

For more information on consuming Web API from a .NET client, see
the following: https://docs.microsoft.com/en-us/aspnet/web-api/
overview/advanced/calling-a-web-api-from-a-net-client

The PlayerManager Class

Now let’s create the class for managing the player data and score. Create a
new class under the Classes folder and name it “PlayerManager.cs” and
then copy the following code:

using MemoryGame.App.Helper;
using System;
using System.Threading.Tasks;
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namespace MemoryGame.App.Classes

{
public static class PlayerManager
{
public static void Save(PlayerProfile player)
{
Settings.PlayerFirstName = player.FirstName;
Settings.PlayerlLastName = player.lLastName;
Settings.PlayerEmail = player.Email;
}
public static PlayerProfile GetPlayerProfileFromLocal()
{
return new PlayerProfile
{
FirstName = Settings.PlayerFirstName,
LastName = Settings.PlayerLastName,
Email = Settings.PlayerEmail
};
}
public static PlayerScore GetPlayerScoreFromLocal()
{
return new PlayerScore
{
ChallengerID = Settings.PlayerID,
Best = Convert.ToByte(Settings.TopScore),
DateAchieved = Settings.DateAchieved
};
}
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public static void UpdateBest(int score)

{
if (Settings.TopScore < score)
{
Settings.TopScore = score;
Settings.DateAchieved = DateTime.UtcNow;
}
}

public static int GetBestScore(int currentlLevel)

{

if (Settings.TopScore > currentLevel)
return Settings.TopScore;

else
return currentlevel;
}
public async static Task<bool> Sync()
{

REST.GameAPI api = new REST.GameAPI();
bool result = false;

try

{
if (!Settings.IsProfileSync)

result = await api.SavePlayerProfile(Player
Manager.GetPlayerProfileFromLocal(), true);

if (Settings.PlayerID == 0)
Settings.PlayerID = await api.GetPlayerID
(Settings.PlayerEmail);

result = await api.SavePlayerScore(PlayerManager.
GetPlayerScoreFromLocal());
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}
catch
{
return result;
}
return result;
}
public async static Task<bool> CheckScoreAndSync(int score)
{
if (Settings.TopScore < score)
{
UpdateBest(score);
if (Utils.IsConnectedToInternet())
{
var response = await Sync();
return response == true ? true : false;
}
else
return false;
}
else
return false;
}

public async static Task<PlayerData> CheckExistingPlayer
(string email)
{

REST.GameAPI api = new REST.GameAPI();

PlayerData player = new PlayerData();

if (Utils.IsConnectedToInternet())
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player = await api.GetPlayerData(email);
}

return player;

The PlayerManager class is composed of a few methods for handling
data retrieval and syncing. The class and methods are marked with the
keyword static, so we can directly reference them without instantiating
the object. Since this class is not tied up to any object that can change the
behavior of the class itself and its member, it makes more sense to use
static. Notice that each method calls the method defined in the GameAPI
class. We did it like this so we can separate the actual code logic for ease of
maintenance and separation of concerns.

Let’s take a look at what we did there by breaking the code into
sections. Let’s start with the Save() method:

public static void Save(PlayerProfile player)

{
Settings.PlayerFirstName = player.FirstName;
Settings.PlayerLastName = player.LastName;
Settings.PlayerEmail = player.Email;

}

The Save() method takes a PlayerProfile object as a parameter. The
PlayerProfile is an object that we define in the DTO file, which houses a
few properties. The code basically stores the value from the PlayerProfile
object properties to the Settings properties. In other words, this method
saves the player profile such as FirstName, LastName, and Email in the
device’s local storage for future use.
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Next code block:

public static PlayerProfile GetPlayerProfileFromLocal()
{

return new PlayerProfile

{
FirstName = Settings.PlayerFirstName,
LastName = Settings.PlayerlLastName,
Email = Settings.PlayerEmail

};

The GetPlayerProfileFromLocal() method is the opposite of the
Save() method. The code fetches the player information from the local
device data storage and assigns them to the PlayerProfile object.

Next code block:

public static void UpdateBest(int score)

{
if (Settings.TopScore < score)
{
Settings.TopScore = score;
Settings.DateAchieved = DateTime.UtcNow;
}
}

As the method name suggests, the UpdateBest() method updates the
challenger score. The code checks for the existing top score from the local
data store and updates the TopScore property with the current score if the
challenger score is greater than the existing top score.
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Next code block:

public static int GetBestScore(int currentlevel)
{
if (Settings.TopScore > currentlevel)
return Settings.TopScore;
else
return currentlevel;

The GetBestScore() method takes an int as a parameter. The code
basically compares the current score/level with the score from the local
data storage and returns the highest value.

Next code block:

public async static Task<bool> Sync()

{
REST.GameAPI api = new REST.GameAPI();
bool result = false;

try
{
if (!Settings.IsProfileSync)
result = await api.SavePlayerProfile(PlayerManager.
GetPlayerProfileFromLocal(), true);
if (Settings.PlayerID == 0)
Settings.PlayerID = await api.GetPlayerID(Settings.
PlayerEmail);

result = await api.SavePlayerScore(PlayerManager.
GetPlayerScoreFromLocal());
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catch

{

return result;

}

return result;

The Sync() method is an asynchronous method that returns a Task of
type bool. The first line creates an instance of the GameApi object. If you
remember, the GameApi class contains the code for communicating with
the Web API endpoints. The next line of code initializes a bool flag in a
variable called result.

Within try-block, the code checks if the challenger profile is already
synced. If not, then it calls an awaitable Task from the GameApi class
called SavePlayerProfile(), which takes a PlayerProfile object as the
parameter and a bool parameter that indicates if the profile is new. The
next if-condition checks for the existence of the challenger profile by
validating the PlayerID property, which is stored in the local data storage.
If the value is 0, then it calls an awaitable Task called GetPlayerID(), with
an e-mail as the parameter, and assigns the result back to the Settings.
PlayerID property. Otherwise, if the challenger already did a sync, it just
updates the challenger score by calling the SavePlayerScore() Task.

If the code within the try-block fails, then it should go to the catch-
block and return a false value to the method, indicating that the sync
wasn’t successful.

Note In real-world applications, it is recommended to handle
specific exceptions and log them for debugging and easy
troubleshooting.
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Next code block:

public async static Task<bool> CheckScoreAndSync(int score)

{

if (Settings.TopScore < score)

{
UpdateBest(score);
if (Utils.IsConnectedToInternet())
{
var response = await Sync();
return response == true ? true : false;
}
else
return false;
}
else

return false;

The CheckScoreAndSync() is also an asynchronous method that
takes an int as a parameter and returns a Task of type bool. The code
basically validates the score; if the current score is greater than the existing
top score, then it updates the existing top score from the local data storage
with the current score and ultimately calls the Sync() method.

Next code block:

public async static Task<PlayerData> CheckExistingPlayer(string
email)

{
REST.GameAPI api = new REST.GameAPI();

PlayerData player = new PlayerData();
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if (Utils.IsConnectedToInternet())

{
player = await api.GetPlayerData(email);

}

return player;

The CheckExistingPlayer() is an asynchronous method that takes a
string as a parameter and returns a Task of type PlayerData. This method
simply calls the awaitable Task called GetPlayerData() from the GameApi
class and takes an e-mail as the parameter.

Here’s a quick definition of each of these methods:

e The Save() method saves the player information in the
local device storage using the Settings plug-in.

o The GetPlayerProfileFromLocal() method fetches the
player information from the local device storage.

o The GetPlayerScoreFromLocal() method fetches the
player score details from the local device storage.

e The UpdateBest() method updates the player score in
the local device storage.

o The GetBestScore() method fetches the player top
score from the local device storage.

e The asynchronous Sync() method syncs the player
profile and score details with data from the database
into the local data storage.

e The asynchronous CheckScoreAndSync() method
updates the top score to the database.

e The asynchronous CheckExistingPlayer() method
verifies the existence of a challenger from the database.
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Adding the Needed Graphics and Sound File

Go ahead and download the images and file sound at the following links:

o Graphics: https://github.com/proudmonkey/
Xamarin.MemoryGameApp/tree/master/MemoryGame.
App/MemoryGame.App.Droid/Resources/drawable

o Sound: https://github.com/proudmonkey/Xamarin.
MemoryGameApp/tree/master/MemoryGame.App/
MemoryGame.App.Droid/Resources/raw

Android

For Xamarin.Android, add the required images under the “Resources/
drawable” folder. Right-click the drawable folder and then select

Add » Existing Item. Locate the images that you have just downloaded
from the previous step and then click Add. The drawable folder should
look like something in the following figure:

4[] MemoryGame.App.Android
&p Connected Services
b M Properties
b =B References
b Assets
4 Resources
4 drawable
] icon.png
B lightoff.png
£ lighton.png
2] speakeron.png
4 vibration.png

Aemisimbala badal

Figure 4-2. Adding the graphics file
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To add the sound file, we need to create the “raw” folder first. Now go
ahead and add a new folder under the Resources folder and name it “raw’”.
Add the beep.mp3 file within the folder just like in the following figure:

4 |4 MemoryGame.App.Android

& Connected Services

M Properties

=-B References
Assets
Resources

4 drawable
drawable-hdpi
drawable-xhdpi
drawable-xxhdpi
drawable-xoochdpi
layout
mipmap-anydpi-v26
mipmap-hdpi
mipmap-mdpi
mipmap-xhdpi
mipmap-xx<hdpi
mipmap-xochdpi

bl raw

Figure 4-3. Adding the sound file

A VYV

A VVVVVVY

i0S
For Xamarin.iOS, add the required images and sound file under the
“Resource” folder as shown in the following figure.
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4 [¢] MemoryGame.App.iOS
&p Connected Services
b M Properties
p =W References
b [@ Asset Catalogs
=-8 Native References

Pl beep.mp3

P icon.png

[ LaunchScreen.storyboard
B lightoff.png

B lighton.png

P speakeron.png

P vibration.png

Figure 4-4. Adding the graphics and sound files

The Required XAML Pages

Before starting to create the required pages for the application, let’s
talk a bit about the anatomy of the XAML file. When we created the
MemogyGame.App project, a pair of files are automatically with the
following names:

e App.xaml, the XAML file; and

e App.xaml.cs, a C# code-behind file associated with the
XAML file.

If you are working with ASP.NET WebForms, you will notice that the
concept of the XAML file is pretty much the same as that of the WebForm’s
ASPX files. You'll need to click the arrow next to App.xaml to see the code-
behind file. Both App.xaml and App.xaml.cs contribute to a class named
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App that derives from Application. Most other classes with XAML files
contribute to a class that derives from ContentPage; those files use XAML
to define the visual contents of an entire page.

In this section, we are going the create the following XAML files that
derive from the ContentPage.

o Register
e Home
e Result

The Register Page

Let’s start building the Register page. Right-click the Pages folder and
then select Add » New Item. On the left pane under Visual C# Items >
Xamarin.Forms, select Content Page just like in the following figure:

Add New Item - MemoryGame.App ? ®
4 Installed Sortby: Default - i Search (Ctrl~ p-
Visual H 3 =
st obhens @ Content Page [Pl Type: Visual C= items
gode = A page for displaying content using
t -
G:ﬂ:al a Content Page (C=] Visual C# tems XAML.
Sl Save I—j Content View Visual C# ltems
b Web <=
Wind F £
= I:i:.‘F:;T gj Content View (C#) Visual C# tems
b Online [ istviewpage Visual C# ltems
>
Master Detail P: Visual C It
‘D aster ail Fage 1sua ems
rj Tabbed Page Visual C# ltems
o
‘D View Cell Visual C# Items
MName: Registerxaml
Add Cancel

Figure 4-5. Creating a new ContentPage file
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Name the page “Register” and click Add.
Replace the default generated markup with the following:

<?xml version="1.0" encoding="utf-8" ?>

<ContentPage xmlns="http://xamarin.com/schemas/2014/forms"
xmlns:x="http://schemas.microsoft.com/winfx/2009/
xaml"
x:Class="MemoryGame.App.Pages.Register">

<StackLayout VerticalOptions="CenterAndExpand">
<Label Text="Working Memory Game"
FontSize="Large"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand" />

<Label x:Name="1lblWelcome"
Text="Register to start the fun, or Log-on to
continue the challenge!"
FontSize="Small"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand" />

<StackLayout x:Name="layoutChoose"
Orientation="Horizontal"
Spacing="5"
VerticalOptions="CenterAndExpand"
HorizontalOptions="Center">

<Button x:Name="btnNew"
Text="Register"
FontSize="Medium"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand"
Clicked="OnbtnNewClicked"/>
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<Button x:Name="btnReturn"
Text="Log-on"
FontSize="Medium"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand"
Clicked="OnbtnReturnClicked"/>
</StackLayout>

<StackLayout x:Name="layoutRegister"
VerticalOptions="CenterAndExpand"
IsVisible="False">

<Label Text="First Name" />
<Entry x:Name="entryFirstName" />
<Label Text="Last Name" />

<Entry x:Name="entrylLastName" />
<Label Text="Email" />

<Entry x:Name="entryEmail" />

<StacklLayout Orientation="Horizontal"

Spacing="3
HorizontalOptions="Center">

<Button x:Name="btnRegister"
Text="Let's Do This!"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand"
Clicked="OnbtnRegisterClicked"/>

<Button x:Name="btnCancelRegister"
Text="Cancel"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand"
Clicked="OnbtnCancelRegister
Clicked"/>
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</StackLayout>
</StackLayout>

<StackLayout x:Name="layoutlLogin"
VerticalOptions="CenterAndExpand"
IsVisible="False">

<Label Text="Email" />
<Entry x:Name="entryExistingEmail" />

<StackLayout Orientation="Horizontal" Spacing="3
HorizontalOptions="Center">

<Button x:Name="btnLogin"
Text="Let me in!"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand"
Clicked="OnbtnLoginClicked"/>

<Button x:Name="btnCancellogin"
Text="Cancel"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand"
Clicked="OnbtnCancelloginClicked"/>

</StackLayout>

</StackLayout>
</StackLayout>
</ContentPage>

The preceding markup uses XAML to build the application UL XAML
allows you to define Uls in Xamarin.Forms applications using markup
rather than code. You may have noticed that it contains some StackLayout
elements to group controls in certain areas in the form. The controls are
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used to present the form to Ul and are referred to as Button, Entry, Label,
and more. Each button from the preceding markup has a Clicked event
attached to it to perform a certain action in the server (a.k.a. code-behind).

For comprehensive documentation about XAML in Xamarin.
Forms, see the following: https://docs.microsoft.com/en-us/xamaxrin/
xamarin-forms/xaml/xaml-basics/

Now open the Register.xaml.cs file and replace the default generated
code with the following code:

using MemoryGame.App.Classes;
using MemoryGame.App.Helper;
using System;

using System.Threading.Tasks;
using Xamarin.Forms;

using Xamarin.Forms.Xaml;

namespace MemoryGame.App.Pages

{
[XamlCompilation(XamlCompilationOptions.Compile)]

public partial class Register : ContentPage

{
public Register ()

{

InitializeComponent ();

}

enum EntryOption

{
Register = 0,
Returning = 1,
Cancel = 2
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protected override void OnAppearing()

base.OnAppearing();
NavigationPage.SetHasBackButton(this, false);

if (!string.IsNullOrEmpty(Settings.PlayerFirstName))

App._navPage.PushAsync(App. homePage);

async Task CheckExistingProfileAndSave(string email)

{

}

{
try
{
}

PlayerData player = await PlayerManager.
CheckExistingPlayer(email);
if (string.IsNullOrEmpty(player.FirstName) 8&
string.IsNullOrEmpty(player.LastName))
{
await App.Current.MainPage.DisplayAlert
("Error", "Email does not exist.", "OK");

}

else

{
Settings.PlayerFirstName = player.
FirstName.Trim();
Settings.PlayerLastName = player.
LastName.Trim();
Settings.PlayerEmail = email.Trim();
Settings.TopScore = player.Best;
Settings.DateAchieved = player.DateAchieved;

await App. navPage.PushAsync(App. homePage);
}
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catch

{
await App.Current.MainPage.DisplayAlert("Oops”,
"An error occurred while connecting to the
server. Please check your connection.”, "OK");

}

}

async Task Save()

{
Settings.PlayerFirstName=entryFirstName.Text.Trim();
Settings.PlayerLastName = entrylLastName.Text.Trim();
Settings.PlayerEmail = entryEmail.Text.Trim();
await App. navPage.PushAsync(App. homePage);

}

void ToggleEntryView(EntryOption option)

{
switch (option)

{
case EntryOption.Register:
{
1blWelcome.IsVisible = false;
layoutChoose.IsVisible = false;
layoutlogin.IsVisible = false;
layoutRegister.IsVisible = true;
break;
}
case EntryOption.Returning:
{

lblWelcome.IsVisible = false;
layoutChoose.IsVisible = false;
layoutRegister.IsVisible = false;
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layoutLogin.IsVisible = true;
break;

}

case EntryOption.Cancel:

{

1blWelcome.IsVisible = true;
layoutChoose.IsVisible = true;
layoutRegister.IsVisible = false;
layoutlogin.IsVisible = false;
break;

}

void OnbtnNewClicked(object sender, EventArgs args)

{
ToggleEntryView(EntryOption.Register);

}

void OnbtnReturnClicked(object sender, EventArgs args)

{
ToggleEntryView(EntryOption.Returning);

}

void OnbtnCancelloginClicked(object sender, EventArgs args)

{
ToggleEntryView(EntryOption.Cancel);

}

void OnbtnCancelRegisterClicked(object sender, EventArgs
args)

{
ToggleEntryView(EntryOption.Cancel);
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async void OnbtnRegisterClicked(object sender, EventArgs args)

{
btnRegister.IsEnabled = false;

if (string.IsNullOrEmpty(entryFirstName.Text)
|| string.IsNullOrEmpty(entryLastName.Text)
|| string.IsNullOrEmpty(entryEmail.Text))
await App.Current.MainPage.
DisplayAlert("Error", "Please supply the
required fields.", "Got it");
else
await Save();

btnRegister.IsEnabled = true;
}

async void OnbtnLoginClicked(object sender, EventArgs args)
{
if (string.IsNullOrEmpty(entryExistingEmail.Text))
await App.Current.MainPage.DisplayAlert("Error",
"Please supply your email.", "Got it");

else
{
if (Utils.IsConnectedToInternet())
{
btnLogin.IsEnabled = false;
await CheckExistingProfileAndSave
(entryExistingEmail.Text);
}
else
{

await App.Current.MainPage.
DisplayAlert(“Error”, “No internet
connection.”, “OK”);
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}
}

btnLogin.IsEnabled = true;

Let’s take a look at the code implementation details by breaking them
into sections. Let’s start with this:

using MemoryGame.App.Classes;
using MemoryGame.App.Helper;
using System;

using System.Threading.Tasks;
using Xamarin.Forms;

using Xamarin.Forms.Xaml;

At the very top, you'll find a series of using keywords. This type of
keyword is typically used as a directive, when it is used to create an alias
for anamespace or to import types defined in other namespaces. In other
words, when you want to access a certain class in your code, you need to
define the namespace first.

Next code block:

[XamlCompilation(XamlCompilationOptions.Compile)]
public partial class Register : ContentPage

{
public Register()
{
InitializeComponent();
}
}

The Register class is a partial class that derives from a ContentPage
class. In XAML, a ContentPage is a page that displays a single View, often
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a container like a StackLayout or ScrollView. Within the class constructor,
it calls the method InitializeComponent(), which initializes a new
ContentPage instance.

Next code block:
enumEntryOption
{
Register = 0,
Returning = 1,
Cancel = 2
}
The preceding code is an enumeration used for toggling the buttons on
the page.
Next code block:

protected override void OnAppearing()

{
base.OnAppearing();
NavigationPage.SetHasBackButton(this, false);
if (!string.IsNullOrEmpty(Settings.PlayerFirstName))
App. navPage.PushAsync(App. homePage);
}

The OnAppearing() is a built-in event of a page. This event is marked as
virtual, meaning that we can override this event to customize the behavior
immediately prior to the page becoming visible. In this case, we call the
SetHasBackButton() method to hide the back button navigation when
the Register page is loaded. The if-condition line checks the existence of
the challenger’s name. If the property PlayerFirstName has a value, then it
redirects the view to the Home page; otherwise, it stays in the Register page.

For more information about Xamarin.Forms navigation, see the

Jollowing: https://docs.microsoft.com/en-us/xamarin/xamaxin-
forms/app-fundamentals/navigation/
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Next code block:

async Task CheckExistingProfileAndSave(string email)

{
try

{

}

PlayerData player = await PlayerManager.Check
ExistingPlayer(email);
if (string.IsNullOrEmpty(player.FirstName) && string.
IsNullOrEmpty(player.LastName))
{
await App.Current.MainPage.DisplayAlert("Error”,
"Email does not exist.", "OK");

}

else

{
Settings.PlayerFirstName = player.FirstName.Trim();
Settings.PlayerLastName = player.lastName.Trim();
Settings.PlayerEmail = email.Trim();
Settings.TopScore = player.Best;
Settings.DateAchieved = player.DateAchieved;

await App. navPage.PushAsync(App. homePage);

catch

{

await App.Current.MainPage.DisplayAlert("Oops", "An
error occurred while connecting to the server. Please
check your connection.”, "OK");
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The CheckExistingProfileAndSave() is an asynchronous method that
takes a string as the parameter and returns a Task. The first line within
the try-block calls the awaitable Task called CheckExistingPlayer() and
assigns the result to a type of PlayerData. If the FirstName and LastName
of the PlayerData object are null or empty, then it displays an error stating
that the e-mail provided does not exist. Otherwise, it stores the challenger
information in the local data storage via Settings properties.

Next code block:

async Task Save()

{
Settings.PlayerFirstName = entryFirstName.Text.Trim();
Settings.PlayerLastName = entrylLastName.Text.Trim();
Settings.PlayerEmail = entryEmail.Text.Trim();
await App. navPage.PushAsync(App. homePage);

}

The Save() method stores the basic challenger information such as
FirstName, LastName, and Email and then automatically redirects to the
Home page.

Next code block:

void ToggleEntryView(EntryOption option)

{
switch (option)
{
case EntryOption.Register:
{
1blWelcome.IsVisible = false;
layoutChoose.IsVisible = false;
layoutlogin.IsVisible = false;
layoutRegister.IsVisible = true;
break;
}
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case EntryOption.Returning:

{

}

1blWelcome.IsVisible = false;
layoutChoose.IsVisible = false;
layoutRegister.IsVisible = false;
layoutlogin.IsVisible = true;
break;

case EntryOption.Cancel:

{

1blWelcome.IsVisible = true;
layoutChoose.IsVisible = true;
layoutRegister.IsVisible = false;
layoutlLogin.IsVisible = false;
break;

The ToggleEntryView() method takes an EntryOption enumeration
as a parameter. This method basically handles the switching of register and
login container layout in the Register page.

Next code block:

void OnbtnNewClicked(object sender, EventArgs args)

ToggleEntryView(EntryOption.Register);

void OnbtnReturnClicked(object sender, EventArgs args)

ToggleEntryView(EntryOption.Returning);
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void OnbtnCancelloginClicked(object sender, EventArgs args)

{
ToggleEntryView(EntryOption.Cancel);

}

void OnbtnCancelRegisterClicked(object sender, EventArgs args)

{
ToggleEntryView(EntryOption.Cancel);

The preceding code comprises event handlers for buttons that invoke
the ToggleEntryView() method. The OnbtnNewClicked event shows the
Register view with a cancel button. The OnbtnReturnClicked event, on
the other hand, shows the Login view with a cancel button. The remaining
events are used to revert the view to original state.

Next code block:

async void OnbtnRegisterClicked(object sender, EventArgs args)

{
btnRegister.Isknabled = false;

if (string.IsNullOrEmpty(entryFirstName.Text)
|| string.IsNullOrEmpty(entrylLastName.Text)
|| string.IsNullOrEmpty(entryEmail.Text))
await App.Current.MainPage.DisplayAlert("Error",
"Please supply the required fields.", "Got it");
else
await Save();

btnRegister.IsEnabled = true;

The OnbtnRegisterClicked is an asynchronous event that returns
void. As you may know, async methods can return Task<T>, Task, or
void. In almost all cases, you want to return Task<T> or Task, and return
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void only when you have to. Returning void for async event handlers is
great, as we can perform asynchronous operations without blocking the Ul
thread.

The first line of the code within the event disables the button
btnRegister and then performs some asynchronous operations. If the
FirstName, LastName, and Email fields are left empty, then it shows an
error. Otherwise, it calls the Save() method.

Next code block:

async void OnbtnLoginClicked(object sender, EventArgs args)
{
if (string.IsNullOrEmpty(entryExistingEmail.Text))
await App.Current.MainPage.DisplayAlert("Error",
"Please supply your email.", "Got it");

else
{
if (Utils.IsConnectedToInternet())
{
btnLogin.IsEnabled = false;
await CheckExistingProfileAndSave(entryExisting
Email.Text);
}
else
{
await App.Current.MainPage.DisplayAlert("Error”,
"No internet connection.", "OK");
}

}

btnLogin.IsEnabled = true;
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The OnbtnLoginClicked event is also an asynchronous event that
returns void. This event is where the user credential is validated: in this
case, the e-mail address value. The first line of code within the event
handler checks for the e-mail address value. If it’s empty, then it displays
an error; otherwise, it saves the challenger information to the local data
storage by calling the CheckExistingProfileAndSave() method.

The Home Page

Add a new Content Page under the Pages folder and name it “Home”.
Replace the default generated code with the following code:

<?xml version="1.0" encoding="utf-8" ?>

<ContentPage xmlns="http://xamarin.com/schemas/2014/forms"
xmlns:x="http://schemas.microsoft.com/winfx/2009/
xaml"
x:Class="MemoryGame.App.Pages.Home">

<StackLayout Padding="2">
<StackLayout>
<StackLayout Orientation="Horizontal">

<Label x:Name="1blBest"
FontSize="Medium"
HorizontalOptions="StartAndExpand" />

<Button x:Name="btnSync"
Text="Sync"
Clicked="0OnbtnSyncClicked"
HorizontalOptions="EndAndExpand"
VerticalOptions="CenterAndExpand" />

<Button x:Name="btnLogOut"
Text="Logout"
Clicked="0OnbtnLogoutClicked"
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HorizontalOptions="EndAndExpand"
VerticalOptions="CenterAndExpand" />

</StackLayout>

<Label x:

Name="1blTime"

FontSize="Large"

HorizontalOptions="Center"
VerticalOptions="CenterAndExpand" />

</StackLayout>

<Label x:Name="lblLevel"
FontSize="Small"
HorizontalOptions="Center"

VerticalOptions="CenterAndExpand" />

<StackLayout Orientation="Horizontal"

<Image

<Image

<Image

Spacing="2"

HorizontalOptions="Center"
BackgroundColor="White">

x:Name="imglLightOff"
Source="lightoff.png"
WidthRequest="60"
HeightRequest="20" />

x:Name="imglLightOff2"
Source="lightoff.png"
IsVisible="False"
WidthRequest="60"
HeightRequest="20" />

x:Name="imglLightOn"
Source="1lighton.png"
IsVisible="False"
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WidthRequest="60"
HeightRequest="20" />

<Image x:Name="imgSpeaker"
Source="speakeron.png"
WidthRequest="60"
HeightRequest="40" />

<Image x:Name="imgHaptic"
Source="vibration.png"
WidthRequest="60"
HeightRequest="20" />

</StackLayout>

<Label Text="The light will blink on, the speaker will

beep and the device will vibrate at different times.

Try to count how many times each one happens.”
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand" />

<Button x:Name="btnStart"
Text="Start"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand"
Clicked="0OnButtonClicked"/>

</StackLayout>
</ContentPage>

The preceding XAML markup contains three Label, three Button, and
five Image. The Label elements are used for displaying the existing saved
top score, the current top score, and the instructions to play the game. The
Button elements are used for syncing data to the database, logging out,
and starting the game. The Image elements are used for displaying a bulb
(on and off), speaker, and haptic indication.
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Open the Home.xaml.cs file and replace the default generated code
with the following code:

using MemoryGame.App.Classes;
using MemoryGame.App.Helper;
using MemoryGame.App.Services;
using System;

using System.Threading.Tasks;
using Xamarin.Forms;

using Xamarin.Forms.Xaml;

namespace MemoryGame.App.Pages

{
[XamlCompilation(XamlCompilationOptions.Compile)]

public partial class Home : ContentPage

{
public Home()
{
InitializeComponent();
}
enum PlayType
{
Blink = 0,
Sound = 1,
Haptic = 2
}

private int _cycleStartInMS = o;

private int _cycleMaxInMS = 10000;

private const int cycleIntervalInMS = 2000;
private const int _eventTypeCount = 3;

public statici nt CurrentGameBlinkCount { get; private
set; } = 0;
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public static int CurrentGameSoundCount { get; private

set; } = 0;

public static int CurrentGameHapticCount { get; private
set; } = 0;

public static int CurrentGamelLevel { get; private set;
b=

protected override void OnAppearing()

{

base.OnAppearing();
NavigationPage.SetHasBackButton(this, false);

PlayerManager.UpdateBest(CurrentGamelLevel);

if (Result. answered)
LevelUp();

else
ResetlLevel();

1b1Best.Text = $"Best: Level {PlayerManager.GetBest
Score(CurrentGamelLevel)}";
lblLevel.Text = $"Level {CurrentGameLevel}";
}
static void IncrementPlayCount(PlayType play)
{
switch (play)
{
case PlayType.Blink:
{
CurrentGameBlinkCount++;
break;

}
case PlayType.Sound:

{
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CurrentGameSoundCount++;

break;
}
case PlayType.Haptic:
{
CurrentGameHapticCount++;
break;
}

public static void IncrementGamelevel()

{

CurrentGamelevel++;

}

void ResetlLevel()

{

CurrentGameLevel = 1;
_cycleStartInMS = cycleIntervalInMS;

1blTime.Text = string.Empty;
btnStart.Text = "Start";
btnStart.IsEnabled = true;

}

async void StartRandomPlay()

{

await Task.Run(() =>

{

Randomrnd=newRandom(Guid.NewGuid().GetHashCode());
int choice = rnd.Next(0, _eventTypeCount);

switch (choice)

{
case (int)PlayType.Blink:
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{
Device.BeginInvokeOnMainThread(async () =>

{
await imglightOff.FadeTo(0, 200);
imglightOff2.IsVisible = false;
imglightOff.IsVisible = true;
imglLightOff.Source = ImageSource.
FromFile("lighton.png");
await imglightOff.FadeTo(1, 200);
1);

IncrementPlayCount(PlayType.Blink);
break;

}
case (int)PlayType.Sound:

{
DependencyService.Get<ISound>().
PlayMp3File("beep.mp3");
IncrementPlayCount(PlayType.Sound);
break;

}

case (int)PlayType.Haptic:

{
DependencyService.Get<IHaptic>().
ActivateHaptic();
IncrementPlayCount(PlayType.Haptic);
break;

};
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void ResetGameCount()

{
CurrentGameBlinkCount = 0;
CurrentGameSoundCount = 0;
CurrentGameHapticCount = 0;

}

void LevelUp()

{
_cycleStartInMS = cycleStartInMS - 200;
//minus 200 ms

}

void Play()

{

int timelapsed = 0;
int duration = 0;
Device.StartTimer(TimeSpan.FromSeconds(1), () =>
{
duration++;
1b1Time.Text = $"Timer: { TimeSpan.
FromSeconds (duration).ToString("ss")}";

if (duration < 10)
return true;
else
return false;

};

Device.StartTimer(TimeSpan.FromMilliseconds(
cycleStartInMs), () => {
timelapsed = timelapsed + cycleStartInMS;
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Device.BeginInvokeOnMainThread(async () =>

{
imglightOff2.IsVisible = true;
imglightOff.IsVisible = false;
await Task.Delay(200);

D;

if (timelLapsed <= _cycleMaxInMS)

{
StartRandomPlay();
return true; //continue

}

App. navPage.PushAsync(App. resultPage);
return false; //don’t continue

D;
}
void OnButtonClicked(object sender, EventArgs args)
{
btnStart.Text = "Game Started...";
btnStart.IsEnabled = false;
ResetGameCount();
Play();
}
async void OnbtnSyncClicked(object sender, EventArgs args)
{

if (Utils.IsConnectedToInternet())

{
btnSync.Text = "Syncing...";

btnSync.IsEnabled = false;
btnStart.IsEnabled = false;

var response = await PlayerManager.Sync();
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if (!response)
await App.Current.MainPage.
DisplayAlert("Oops", "An error occurred
while connecting to the server. Please
check your connection.", "OK");
else
await App.Current.MainPage.
DisplayAlert("Sync", "Data synced!","0K");
btnSync.Text = "Sync";
btnSync.IsEnabled = true;
btnStart.IsEnabled = true;

}
else
{
await App.Current.MainPage.DisplayAlert
("Error", "No internet connection.", "OK");
}
}
async void OnbtnLogoutClicked(object sender, EventArgs
args)
{

if (Utils.IsConnectedToInternet())

{

btnLogOut.IsEnabled = false;
var response = await PlayerManager.Sync();

if (response)

{
Settings.ClearEverything();

await App. navPage.PopToRootAsync();
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else
await App.Current.MainPage.
DisplayAlert("Oops","An error occurred
while connecting to the server. Please
check your connection.”, "OK");

else

await App.Current.MainPage.DisplayAlert
("Oops™, "No internet connection. Please
check your network.", "OK");

btnLogOut.IsEnabled = true;

The code-behind for the Home page is expected to be long, because
this is where the game logic is handled. I keep it this way in order for you
to easily reference the relevant code logic in one place and for simplicity’s
sake. In a real-world scenario, you may want to break the code into classes
and identify components that can be reusable.

Let’s see what the code does by breaking it into sections. Let’s start
with the class-level definition:

[XamlCompilation(XamlCompilationOptions.Compile)]
public partial class Home : ContentPage

{
public Home()
{
InitializeComponent();
}
}
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Just like any other XAML page, the Home class inherits the
ContentPage class. Within the class constructor, it calls the method
InitializeComponent() to initialize a new ContentPage instance.

Next code block:

enum PlayType

{
Blink = 0,
Sound = 1,
Haptic = 2
}

The PlayType is an enum that consists of three main entries: Blink,
Sound, and Haptic. This enum will be used later in the code to identify the
type of event played.

Next code block:

private int cycleStartInMS = o;

private int cycleMaxInMS = 10000;

private const int _cycleIntervalInMS = 2000;
private const int _eventTypeCount = 3;

The preceding code comprises the private global variables of type
int that will be used within the class. The _cycleStartInMS variable value
is expressed in milliseconds and defaults to 0. This variable indicates
the time when the app should trigger a new cycle to start the play. The
cycleMaxInMS variable indicates the maximum time to when the app
stops the play. The default value is 10,000 milliseconds, or 10 seconds.
The last two variables are marked as const, meaning the value assigned to
them won’t change. The _cycleIntervalInMS variable indicates the time
interval between playing different event types such as blinking an image,
playing a sound, or activating vibration on the device. The interval value is
2000 milliseconds, equivalent to 2 seconds. The eventTypeCount variable
indicates the number of event types, for which the value in this case is 3.
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Next code block:

public static int CurrentGameBlinkCount { get; privateset; }
public static int CurrentGameSoundCount { get; privateset; }
public static int CurrentGameHapticCount { get; privateset; } =
public static int CurrentGamelevel { get; privateset; } = 1;

. e

1}
o o O
-

)

The preceding code comprises the public properties for the class.
They are marked public and static, so other class can access them without
having to create an instance of the Home class. The preceding syntax uses
property initializers, which was introduced in C# 6.0.

The CurrentGameBlinkCount property holds the number of blink
counts with the default value of 0. The CurrentGameSoundCount property
holds the number of sound counts with the default value of 0. The
CurrentGameHapticCount property holds the number of haptic counts
with the default value of 0. Last but not least, the CurrentGameLevel holds
the level/score value.

Next code block:

protected override void OnAppearing()

{
base.OnAppearing();

NavigationPage.SetHasBackButton(this, false);
PlayerManager.UpdateBest(CurrentGameLevel);

if (Result. answered)
LevelUp();

else
Resetlevel();

1b1Best.Text = $"Best: Level {PlayerManager.GetBestScore
(CurrentGamelLevel)}";
lblLevel.Text = $"Level {CurrentGamelevel}";
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The OnAppearing() method fires before the page gets visible. The
preceding code disables the back navigation of the app and then updates
the challenger top score. The if-condition checks the value of _answered
from the Result page. If true, then it calls the LevelUp() method, otherwise
it calls the ResetLevel().

The last two lines of code within the method sets the label’s Text
property to display the top score and current score.

Next code block:

static void IncrementPlayCount(PlayType play)

{
switch (play)
{
case PlayType.Blink:
{
CurrentGameBlinkCount++;
break;
}
case PlayType.Sound:
{
CurrentGameSoundCount++;
break;
}
case PlayType.Haptic:
{
CurrentGameHapticCount++;
break;
}
}
}
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The IncrementPlayCount() method takes a PlayType object as a
parameter. This method basically increases the number of each event type
based on the enum value.

Next code block:

public static void IncrementGamelevel()

{

CurrentGamelLevel++;

The IncrementGameLevel() increases the level/score value. This
method is marked as public so other class can invoke it.
Next code block:

void ResetlLevel()

{
CurrentGamelevel = 1;
_cycleStartInMS = cycleIntervalInMS;
1blTime.Text = string.Empty;

}

The ResetLevel() method resets the level/score and play cycle time and
clears the time displayed in the view.
Next code block:

async void StartRandomPlay()

{
await Task.Run(() =>
{
Random rnd = new Random(Guid.NewGuid().GetHashCode());
int choice = rnd.Next(0, _eventTypeCount);

switch (choice)

{
case (int)PlayType.Blink:
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{

}

Device.BeginInvokeOnMainThread(async () =>
{
await imglLightOff.FadeTo(0, 200);
imglightOff2.IsVisible = false;
imglightOff.IsVisible = true;
imglightOff.Source = ImageSource.
FromFile("lighton.png");
await imglLightOff.FadeTo(1, 200);
1);

IncrementPlayCount(PlayType.Blink);
break;

case (int)PlayType.Sound:

{

}

DependencyService.Get<ISound>().
PlayMp3File("beep.mp3");
IncrementPlayCount(PlayType.Sound);
break;

case (int)PlayType.Haptic:

{

DependencyService.Get<IHaptic>().
ActivateHaptic();
IncrementPlayCount(PlayType.Haptic);
break;
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The StartRandomPlay() is an asynchronous method that returns
avoid. The preceding code is the core method of the Home class. The
method is responsible for activating different criteria on a random
basis, whether invoking a sound, making a vibration, or just blinking an
image. Notice that we've used the DependencyService class to inject the
interface that we've defined in previous section of this Chapter. This allows
us to perform platform specific implementations for playing a sound or
activating a device vibration.

Next code block:

void ResetGameCount()

{
CurrentGameBlinkCount = 0;
CurrentGameSoundCount = 0;
CurrentGameHapticCount = 0;
}

The preceding code simply resets the properties value to 0.
Next code block:

void LevelUp()
{

_cycleStartInMS = cycleStartInMS - 200; //minus 200 ms

The preceding code decreases the cycle interval for triggering a new
random event. In other words, the 2-second cycle will be decreased by 200
ms per level. This is where the game gets exciting, because the higher your
level/score goes, the faster the different event types are triggered until you
can’t remember which type of event has occurred.
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Next code block:

void Play()
{
int timelapsed = 0;
int duration = 0;
Device.StartTimer(TimeSpan.FromSeconds(1), () =>
{
duration++;
1b1Time.Text = $"Timer: { TimeSpan.
FromSeconds (duration).ToString("ss")}";

if (duration < 10)
return true;
else
return false;

};

Device.StartTimer(TimeSpan.FromMilliseconds
(_cycleStartInMs), () => {
timelapsed = timelapsed + cycleStartInMS;

Device.BeginInvokeOnMainThread(async () =>

{
imglightOff2.IsVisible = true;
imglightOff.IsVisible = false;
await Task.Delay(200);

D;

if (timelLapsed <= _cycleMaxInMS)

{
StartRandomPlay();
return true; //continue

}
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App. navPage.PushAsync(App. resultPage);
return false; //don’t continue

};

The preceding code invokes two methods for starting a timer on the
view. The Device.StartTimer() starts a recurring timer on the UI thread
using the device clock capabilities. The first one creates a countdown timer
in the view starting from 10 seconds to 0 and displays the result to a Label
element in real time. The second invokation of the Device.StartTimer()
method is responsible for triggering a new random event based in the
current value of the _cycleMaxInMS value.

Next code block:

void OnButtonClicked(object sender, EventArgs args)

{
btnStart.Text = "Game Started...";

btnStart.IsEnabled = false;

ResetGameCount();
Play();
}
The OnButtonClicked event activates and starts the game by calling
the Play() method.

Next code block:

async void OnbtnSyncClicked(object sender, EventArgs args)

{
if (Utils.IsConnectedToInternet())

{
btnSync.Text = "Syncing...";

btnSync.IsEnabled = false;
btnStart.IsEnabled = false;
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var response = await PlayerManager.Sync();
if (!response)
await App.Current.MainPage
DisplayAlert("Oops"
"An error occurred while connecting to the
server. Please check your connection.”, "OK");
else
await App.Current.MainPage.DisplayAlert("Sync",
"Data synced!","0K");

btnSync.Text = "Sync";
btnSync.IsEnabled = true;
btnStart.IsEnabled = true;

}

else

{

await App.Current.MainPage

DisplayAlert("Error"
“No internet connection.”
IIOK" );

}

The OnbtnSyncClicked() is an asynchronous event handler that syncs
data to the database. The first line of the code within the method checks
for the connection using the Utils.IsConnectedToInternet() method. If
the device is connected to an Internet or wifi, then it enables data sync by
calling the awaitable Sync() method from the PlayerManager class.

Next code block:

async void OnbtnLogoutClicked(object sender, EventArgs args)

if (Utils.IsConnectedToInternet())

{
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btnLogOut.IsEnabled = false;
var response = await PlayerManager.Sync();
if (response)
{
Settings.ClearEverything();
await App. navPage.PopToRootAsync();
}
else
await App.Current.MainPage
DisplayAlert("Oops"
"An error occurred while connecting to the
server. Please check your connection.”
"0K") ;
}
else
await App.Current.MainPage
DisplayAlert("Oops"
"No internet connection. Please check your
network."
"0K") ;

btnLogOut.IsEnabled = true;

The OnbtnLogoutClicked event handles the logout functionality
of the application. Just like the sync feature, it first checks for Internet
connectivity. If the device is connected, it will then invoke the Sync()
method to persist the data in the database. If it syncs successfully,
then it clears the data from the local device storage using the Settings.
ClearEverything() method and redirects the user back to the default page.
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The Result Page

Add a new Content Page under the Pages folder and name it “Result”.
Replace the default generated code with the following code:

<?xml version="1.0" encoding="utf-8" ?>

<ContentPage xmlns="http://xamarin.com/schemas/2014/forms"
xmlns:x="http://schemas.microsoft.com/winfx/2009/
xaml"
x:Class="MemoryGame.App.Pages.Result">

<StackLayout>

<Label Text="How many times did the light blink, the

speaker beep and the device vibrate?"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand" />

<StackLayout Orientation="Horizontal"
Spacing="2"
HorizontalOptions="Center"

BackgroundColor="white">

<Image x:Name="imglLight"
Source="lightoff.png"
WidthRequest="60"
HeightRequest="20" />

<Image x:Name="imgSpeaker"
Source="speakeron.png"
WidthRequest="60"
HeightRequest="20" />

<Image x:Name="imgHaptic"
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Source="vibration.png"
WidthRequest="60"
HeightRequest="20" />

</StackLayout>

<StackLayout Orientation="Horizontal"
HorizontalOptions="Center"
Spacing="5">
<Picker x:Name="pickerLight"
HorizontalOptions="FillAndExpand"
WidthRequest="100">
<Picker.Items>
<x:String>0</x:String>
<x:String>1</x:String>
<x:String>2</x:String>
<x:String>3</x:String>
<x:String>4</x:String>
<x:String>5</x:String>
<x:String>6</x:String>
<x:String>7</x:String>
<x:String>8</x:String>
<x:String>9</x:String>
<x:String>10</x:String>
</Picker.Items>
</Picker>

<Picker x:Name="pickerSpeaker"
HorizontalOptions="FillAndExpand"
WidthRequest="100">
<Picker.Items>
<x:String>0</x:String>
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<X
<X
<X
<X
<X
<X
<X
<X
<X:
<X

String>1</x:
String>2</x:
String>3</x:
String>4</x:
String>5</x:
String>6</x:
String>7</x:
String>8</x:
String>9</x:
String>10</x:String>

</Picker.Items>

</Picker>

String>
String>
String>
String>
String>
String>
String>
String>
String>

<Picker x:Name="pickerHaptic"

HorizontalOptions="FillAndExpand"

WidthRequest="100">
<Picker.Items>

<X

<X

<X
<X

<X

<X
<X:

<X

<X
<X

<X

String>0</x:
:String>1</x:
String>2</x:
String>3</x:
:String>4</x:
String>5</x:
String>6</x:
:String>7</x:
String>8</x:
String>9</x:
:String>10</x:String>

</Picker.Items>

</Picker>

</StackLayout>

String>
String>
String>
String>
String>
String>
String>
String>
String>
String>
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<Label x:Name="1lblText"

FontSize="20"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand" />

<StackLayout Orientation="Horizontal"

HorizontalOptions="Center"
Spacing="40">

<Label x:Name="1blBlinkCount"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand"

<Label x:Name="1blBeepCount"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand"

<Label x:Name="1lblHapticCount"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand"

</StackLayout>

<Button x:Name="btnSubmit"

Text="Submit"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand"
Clicked="0OnButtonClicked"/>

<Button x:Name="btnRetry"

Text="Retry"

IsVisible="False"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand"

/>

/>

/>
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Clicked="OnRetryButtonClicked"/>
</StackLayout>
</ContentPage>

The preceding XAML markup contains a few Label, Button, Picker
and Image elements. The Picker elements are used for storing a list of
items for a challenger to pick. The Label elements are used for displaying
the answer count for each event type that has occurred. The Button
elements are used for submitting the answers or navigating back to
the Home page to restart the game. The Image elements are used for
displaying a bulb, a speaker, and a haptic indication.

Open the Result.xaml.cs file and replace the default generated code
with the following code:

using MemoryGame.App.Classes;
using System;

using Xamarin.Forms;

using Xamarin.Forms.Xaml;

namespace MemoryGame.App.Pages
{
[XamlCompilation(XamlCompilationOptions.Compile)]
public partial class Result : ContentPage
{
public static bool _answered = false;
public Result()

{
InitializeComponent();
ClearResult();
}
protected override void OnAppearing()
{

185



CHAPTER 4  BUILDING MOBILE APPLICATION WITH XAMARIN.FORMS

base.OnAppearing();
ClearResult();
NavigationPage.SetHasBackButton(this, false);

}

void ClearResult()

{
1blText.Text = string.Empty;
1b1BlinkCount.Text = string.Empty;
1b1BeepCount.Text = string.Empty;
1blHapticCount.Text = string.Empty;
pickerLight.SelectedIndex = 0;
pickerSpeaker.SelectedIndex = 0;
pickerHaptic.SelectedIndex = 0;
btnSubmit.IsVisible = true;
btnRetry.IsVisible = false;
_answered = false;

}

bool CheckAnswer(int actualAnswer, int selectedAnswer)

{
if (selectedAnswer == actualAnswer)

return true;
else
return false;

}

void Retry()

{
btnSubmit.IsVisible = false;
btnRetry.IsVisible = true;

}

async void OnButtonClicked(object sender, EventArgs args)
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if (pickerLight.SelectedIndex >= 0 &&

pickerSpeaker.SelectedIndex >= 0 && pickerHaptic.

SelectedIndex >= 0)

{
1blText.Text = "The actual answers are:";
1b1BlinkCount.Text = Home.
CurrentGameBlinkCount.ToString();
1blBeepCount.Text = Home.
CurrentGameSoundCount.ToString();
1blHapticCount.Text = Home.
CurrentGameHapticCount.ToString();

int blinkCountAnswer = Convert.ToInt32
(pickerLight.Items[pickerLight.SelectedIndex]);
int soundCountAnswer = Convert.ToInt32
(pickerSpeaker.Items[pickerSpeaker.SelectedIndex]);
int hapticCountAnswer = Convert.ToInt32
(pickerHaptic.Items[pickerHaptic.SelectedIndex]);

if (CheckAnswer (Home.CurrentGameBlinkCount,
blinkCountAnswer))
if (CheckAnswer(Home.CurrentGameSoundCount,
soundCountAnswer))
if (CheckAnswer(Home.CurrentGame
HapticCount,hapticCountAnswer))
{
_answered = true;
Home.IncrementGamelevel();

var isSynced = PlayerManager.Check
ScoreAndSync(Home. CurrentGameLevel);
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var answer = await App.Current.
MainPage.DisplayAlert("Congrats!”,
$"You’ve got it all right and made
it to level {Home.CurrentGamelLevel}.
Continue?", "Yes", "No");

if (answer)
await App._navPage.PopAsync();
else
Retry();
}
if (! answered)
{
var isSynced = PlayerManager.
CheckScoreAndSync (Home.CurrentGameLevel);

var answer = await App.Current.MainPage.
DisplayAlert("Game Over!", $"Your current
best is at level{Home.CurrentGamelevel}.
Retry?", "Yes", "No");
if (answer)

await App. navPage.PopAsync();
else

Retry();

}
void OnRetryButtonClicked(object sender, EventArgs args)

{
App. navPage.PopAsync();
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The preceding code handles the logic for validating the answers
against the actual count of each event type occurred. If all answers are
correct, then it will prompt you with a message asking if you want to
proceed to the next level or not.

Setting the Page Navigation

Now that we have the required pages set up, let’s declare them on the App
class to create a simple navigation with a default page.

Go ahead and open the App.xaml.cs file and replace the existing code
with the following code:

using MemoryGame.App.Pages;
using Xamarin.Forms;
using Xamarin.Forms.Xaml;

[assembly: XamlCompilation(XamlCompilationOptions.Compile)]
namespace MemoryGame.App

{
public partial class App : Application

{
public static NavigationPage _navPage;
public static Home _homePage;
public static Result resultPage;
public static Register registerPage;

public App()
{
InitializeComponent();
_homePage = new Home();
_resultPage = new Result();
_registerPage = new Register();
_navPage = new NavigationPage( registerPage);
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MainPage = _navPage;

}
protected override void OnStart()
{
// Handle when your app starts
}
protected override void OnSleep()
{
// Handle when your app sleeps
}
protected override void OnResume()
{
// Handle when your app resumes
}
}
}
The App class inherits the Application base class, which offers the
following features:

e A MainPage property, which is where to set the initial
page for the app.

o A persistent Properties dictionary to store simple
values across lifecycle state changes.

o A static Current property that contains a reference to
the current application object.

The code within the app class defines a public static NavigationPage
object and the three Pages that we've created in the previous section:
Register, Home, and Result. These objects are then initialized in the class
contractor with the default page set to the Register page. The MainPage
property on the application class sets the root page of the application.
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For more information about the Xamarin.Forms app class, see
the following: https://docs .microsoft.com/en-us/xamarin/xamaxrin-
forms/app-fundamentals/application-class

Summary of Files Added

Here’s what the MemoryGame.App project looks like after all the files are
added.

&1 Solution ‘"MemoryGame.App' (5 projects)
b @1 MemoryGame.AP
b " Dependencies
4 Classes
€* DTO.cs
C* Helper.cs
€* PlayerManager.cs
C* Settings.cs
- Pages
4 [ Homexaml
P € Homexaml.cs
4 [ Registerxaml
b C* Registerxaml.cs
) Resultxaml
b €= Resultxaml.cs

vVevwvw

4 REST
b GameAPl.cs
4 Services

b = |Haptic.cs
P ©=® |LocalDataStore.cs
P = |Sound.cs
b I Appxaml
P ) MainPagexaml
MemoryGame.App.Android
MemoryGame.App.iOS

0
&
Figure 4-6. Summary of newly added files
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Implementing the Haptic and Sound
Services

Now it’s time for us to provide an actual implementation of each interface
created in previous sections of this chapter. Let’s start with the Xamain.
Android. Add a new folder called “Services” in the MemoryGame.App.
Android project and then create the following classes:

o HapticServer.cs

¢ SoundService.cs

Xamarin.Android Haptic Service

Open HapticService.cs file and replace the default generated code with
the following code:

using Android.Content;

using Android.O0S;

using Xamarin.Forms;

using MemoryGame.App.Droid.Services;
using MemoryGame.App.Services;

[assembly: Dependency(typeof(HapticService))]
namespace MemoryGame.App.Droid.Services

{

public class HapticService : IHaptic

{
public HapticService() { }

public void ActivateHaptic()

{
VibrationEffect effect = VibrationEffect.CreateOne

Shot (100, VibrationEffect.DefaultAmplitude);
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Vibrator vibrator = (Vibrator)global::Android.App.
Application.Context.GetSystemService
(Context.VibratorService);
vibrator.Vibrate(effect);

The HapticService class implements the ActivateHaptic() method
of the IHaptic interface. The preceding code contains Android-specific
implementation for activating the device vibration.

Xamarin.Android Sound Service

Open SoundService.cs file and replace the default generated code with
the following code:

using Xamarin.Forms;

using Android.Media;

using MemoryGame.App.Droid.Services;
using MemoryGame.App.Services;

[assembly: Dependency(typeof(SoundService))]

namespace MemoryGame.App.Droid.Services

{

public class SoundService : ISound

{
public SoundService() { }

private MediaPlayer mediaPlayer;

public bool PlayMp3File(string fileName)

{
_mediaPlayer = MediaPlayer.Create(Android.App.
Application.Context, Resource.Raw.beep);
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_mediaPlayer.Start();
return true;
}
public bool PlayWavFile(string fileName)
{
//T0 DO: Own implementation here
return true;
}

The SoundService class implements the PlayMp3File() method
of the ISound interface. The preceding code contains Android-specific
implementation for playing a media.

Now switch to the MemoryGame.App.iOS project. Add a new folder
called “Services” and then create the following classes:

o HapticServer.cs

e SoundService.cs

Xamarin.iOS Haptic Service

Open the HapticService.cs file and replace the default generated code
with the following code:

using Xamarin.Forms;

using AudioToolbox;

using MemoryGame.App.iOS.Services;
using MemoryGame.App.Services;
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[assembly: Dependency(typeof(HapticService))]
namespace MemoryGame.App.i0S.Services

{
public class HapticService : IHaptic
{
public HapticService() { }
public void ActivateHaptic()
{
SystemSound.Vibrate.PlaySystemSound();
}
¥
}

The preceding code contains iOS-specific implementation
for activating device vibration. It uses the SystemSound.Vibrate.
PlaySystemSound() to vibrate the device in iOS.

Xamarin.iOS Sound Service

Open the SoundService.cs file and replace the default generated code
with the following code:

using Xamarin.Forms;

using MemoryGame.App.iOS.Services;
using System.IO;

using Foundation;

using AVFoundation;

using MemoryGame.App.Services;

195



CHAPTER 4  BUILDING MOBILE APPLICATION WITH XAMARIN.FORMS

[assembly: Dependency(typeof(SoundService))]
namespace MemoryGame.App.i0S.Services

{

public class SoundService : NSObject, ISound,
IAVAudioPlayerDelegate

{
public SoundService(){}

public bool PlayWavFile(string fileName)

{
return true;
}
public bool PlayMp3File(string fileName)
{

var played = false;

NSError error = null;
AVAudioSession.SharedInstance().SetCategory
(AVAudioSession.CategoryPlayback, out error);

string sFilePath = NSBundle.MainBundle.
PathForResource
(Path.GetFileNameWithoutExtension(fileName),
"mp3");

var url = NSUrl.FromString(sFilePath);

var player = AVAudioPlayer.FromUrl(url);
_player.Delegate = this;

_player.Volume = 100f;

played = player.PrepareToPlay();
_player.FinishedPlaying += (object sender,
AVStatusEventArgs e) => {

_player = null;

};
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played = player.Play();

return played;

The SoundService class implements the PlayMp3File() method
of the ISound interface. The preceding code contains iOS-specific
implementation for playing a media.

Note ForiOS, add the required images and sound file under the
Resource folder.

Setting Permissions
Xamarin.Android

For Android, open the AndroidManifest.xml file as shown in the following

figure:
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2] Solution ‘MemoryGame.App' (5 projects)
b @] MemoryGame.API
b MemoryGame.App
4 [{] MemoryGame.App.Android
& Connected Services
4 M Properties
c* Assemblylnfo.cs
b =B References

b Assets
b Resources
p Services

P c* MainActivity.cs
> [ MemoryGame.App.iOS

Figure 4-7. The AndroidManifest.xml file

Then, add the following configuration:

<uses-permission android:name="android.permission.VIBRATE" />

<uses-permission android:name="android.permission.ACCESS
NETWORK STATE" />

<uses-permission android:name="android.permission.ACCESS WIFI_
STATE" />

<uses-permission android:name="android.permission.INTERNET" />

Xamarin.i0oS

An i0OS device doesn’t require any permissions. In Android, the system
seeks the user’s permission while the app is being installed. But iOS allows
you to go ahead with an installation, seeking permission when the user is
using a feature that requires specific permission.
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Note Apple has made several enhancements to both security and
privacy in i0S 10 (and greater) that will help the developer improve
the security of their apps and ensure the end user’s privacy. For

the new i0S 10 Privacy Permission Settings, see: https://blog.
xamarin.com/new-1i0s-10-privacy-permission-settings/
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CHAPTER 5

Building a Simple
Real-Time
Leaderboard Web
App with ASPNET
SignalR and MVC

Before we start implementing real-time functionality, let’s get to know
what ASP.NET SignalR and MVC are all about. Although we are not going
to fully utilize the features that the MVC framework offers, it is still nice to
have a basic understanding of how the MVC framework works.

What ASP.NET MVC Is

ASP.NET MVC is part of the ASP.NET framework. The following figure will
give you a high-level look at where ASP.NET MVC resides within the ASPNET
framework.

© Vincent Maverick S. Durano 2019 201
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SIGNALR AND MVC
ASP.NET Technologies
SPA
Web Pages
MVC SignalR jQuery Mobile,
Sencha,
Web Forms WebHooks Web API RDF
Web Application Real-time API Mobile

ASP.NET 4.6.x

Figure 5-1. The ASP.NET technologies

In the preceding figure, you see that ASP.NET MVC sits on top of
ASP.NET. ASP.NET MVC is a Ul framework that enables a clean separation
of concerns and gives you full control over your markup.

To make it clearer, here’s how I view the high-level process of MVC:

Request/Response Flow
MVC
REQUEST: > Controller
Client/Browser Model
RESPONSE Vi‘e:-w

Figure 5-2. Request and response flow
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Unlike in ASP.NET WebForms, in which requests go directly to a page

file (.LASPX), in MVC, when a user requests a page, it will first talk to the
Controller, process data when necessary, and return a Model to the View
for the user to see.

The Model

Model is just a class that implements the logic for the application domain
data. Often, model objects retrieve and store model states in the database.

The Controller

Just like models, Controller is also a class that handles the user
interaction. It will work with the model and ultimately select a view to
render in the browser.

The View

As the name suggests, a View is the component that displays the
application’s U, typically, this Ul is created from the model data.

To put them up together, the M is for Model, which is typically where
the business objects, business layer, and data access layer will live. Note
that in typical layered architecture, your business layer and data access
layer should be in separate projects. The V is for View, which is what the
user sees. This could simply mean that any UI- and client-side-related
developments will live in the View, including HTML, CSS, and JavaScript.
The C s for the Controller, which orchestrates the flow of logic. For
example, if a user clicks a button that points to a specific URL, that request
is mapped to the controller action method that is responsible for handling
any logic required to service the request and return a response. This will
typically be a new view, or an update to the existing view.

203



CHAPTER 5  BUILDING A SIMPLE REAL-TIME LEADERBOARD WEB APP WITH ASP.NET
SIGNALR AND MVC
To get started with ASP.NET MVC 5, I'd recommend you read

my series of article here: http://vmsdurano.com/building-web-
application-using-entity-framework-and-mvc-5-part-1/

What ASP.NET SignalR Is

ASP.NET SignalR is a new library for ASP.NET developers that makes
developing real-time web functionality easy. SignalR allows bidirectional
communication between server and client. Servers can now push content
to connected clients instantly as it becomes available. SignalR supports
WebSockets and falls back to other compatible techniques for older
browsers.

SignalR can be used wherever a user is required to refresh a page in
order to see up-to-date data. It allows the server to logically “push” data
to the client. This is typically required for web-based dashboards and
monitoring tools, where information needs to be kept up to date at all
times without the user having to refresh the page. SignalR is a powerful,
high-level library that abstracts a lot of the complicated underlying
technologies in order to provide an easy way to transmit data between the
client and the server. SignalR manages the connections automatically and
allows data to be sent using either broadcasts or unicasts.

In SignalR, there are two distinct models for implementing client-

server communications:

o Persistent Connections are the base class with an
API for exposing a SignalR service over HTTP. They
are useful for when developers need direct access to
the low-level communication technology. Persistent
connections use a model similar to that of WCE.
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e Hubs are built on top of persistent connections
and abstract most of the underlying complexity in
order to allow developers to call methods on both
the client and the server without worrying about the
implementation details. One great benefit of using
Hubs is that you get model binding and serialization
straight out of the box.

Transport Protocols Selection

One of the great features about SignalR is that when a client doesn'’t
support WebSockets, it automatically falls back to using older methods of
communication, as shown in the following figure:

SignalR Communication Flow

Client/Browser Server
Hub Persistent
5 Connection
jQuery

——REQUEST—»

jQuery.signalR

g ——FRESPONSE—
/signalr/hub AMkLone fores

Figure 5-3. SignalR communication flow
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SignalR is quite flexible in terms of supporting a variety of transport

protocols. It uses the WebSocket transport when available, but falls back
to older transports when necessary. WebSocket requires at least Windows
Server 2012 or Windows 8, and .NET Framework 4.5 for server and at least
IE 10 for the client. If these requirements are not met, SignalR will attempt
to use other transports to make its connections.

The following are the available transport protocols:

o WebSockets
e LongPolling
o Server Sent Events
o Forever Frame
The default transport selection process goes like this:

1. Ifthe client/server doesn’t support WebSockets,
then it falls back to use Server Sent Events.

2. IfServer Sent Events isn’t available, then it falls
back to Forever Frame; if Forever Frame if isn’t
available, it falls back to Long Polling.

Transport Protocol Overview

WebSocket is a full duplex protocol that uses http handshaking internally
and allows the stream of messages to flow on top of TCP. It supports
Google Chrome (> 16), Firefox (> 11), IE (> 10), and Win IIS (>8.0). In other
words, if both client and server support WebSockets, then this creates a
persistent connection between them, which can be used by either client
or server to send the data anytime. As such, this way is the most efficient,
takes the least memory, and shows the lowest latency. This is the most
preferred protocol for a SignalR application.
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e Simplex Communication: It just spreads in one way

when one point just broadcasts while another point
just can listen without sending a message, such as

television and radio.

o Half Duplex: One point sends a message and at
that moment another point cannot send a message
and must wait until the first point finishes its
transmission; then it can send its message. It is just one
communication at a time, such as old wireless devices
like walkie-talkies and HTTP protocol.

o Full Duplex: Both points can send and receive
messages simultaneously; there is no need to wait until
the other point finishes its transmission. This is similar
to telephones and WebSocket protocol.

Server Sent Events (also known as Event Source): This is another
technique introduced with HTMLS5 that allows the server to push the updates
to the client whenever new data is available. This technology is used when
WebSocket is not supported. It is supported by most browsers except IE.

Forever Frame: This is part of the Comet model and uses a hidden
iframe in the browser to receive the data in an incremental manner from
the server. The server starts sending the data in a series of chunks even
without even knowing the complete length of the content. It is executed on
the client when the data is received.

AJAX Long Polling: This is the least preferred way in SignalR to set up
a communication between client and server. Also, it is the most expensive!
Itis a part of the Comet model and as the name suggests, it keeps polling
the server to check for updates. The request that is sent to the server is
AJAX based, to minimize the resource usage and provide a better user
experience. But it’s still expensive because it keeps polling the server
whether there are any updates or not.

For more information, see www.asp.net/signalr
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Create a New Web Application

Now that you have an idea of how SignalR transmits and persists data
across client and the server, it’s time for us to see that in action.

Let’s add a new ASP.NET web application project. Right-click the
Solution and then select Add » New Project. On the left pane under
Visual C# » Web, select ASP.NET Web Application (.NET Framework)
and name it “MemoryGame.Web” just like in the following figure:

Add New Project ? x
b Recent “ Soby Default - afE e eh (CLieE) p-
4 Installed - W
@ ASP.NET Core Web Application Visual C# Type: Visual C*
4 Visual C# Project templates for creating ASP.NET

Get Started

Windows Universal

Windows Desktop
4 Web

r— ASP.NET Web Application ( NET F weortl Visual C2 applications. You can create ASP.NET Web
ASP.NET Web Application (,NET Framework) ol € PR V. ot Wab APt olcaion sod
add many other features in ASP.NET.

Previous Versions
NET Core
i NET Standard
Andreid
Apple TV
Apple Watch -
Mot finding what you are looking for?
Open Visual Studio Installer

Name: MemoryGame.Web
Location: ChUsers\user\source\repos\MemoryGame.App - Browse...
Frameworic NET Framework 4.6.1

ok || canee

Figure 5-4. Create a new ASP.NET web application project

Click OK and then select Empty. Tick the MVC option under the “Add
folders and core references for:” just like in the following figure:
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New ASP.NET Web Application - MemoryGame.Web [ X
An empty project template for creating ASP.NET
applications. This template does not have any content

F-‘ F‘ F‘ 4 F‘ init
o 52 o o B i
Empty Web Forms MVC Web API Single Page
Application
A
-
Azure APl App
Add folders and core references for: Authentication: No Auth
[[] WebForms  [/] MVC  [T] Web API Change Authentication
[] Enable Docker Compose support (Requires Docker for Windows)
[[] Add unit tests
Test project name:  MemoryGame. Web. Tests
oK | Cancel

Figure 5-5. Create an empty ASPNET MVC project

Click OK to let Visual Studio generate the project for you.

Integrating ASP.NET SignalR

Install Microsoft.Asp.Net.SignalR in your project via NuGet as shown the
following figure:
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Browse Installed Updates @ NuGet Package Manager: MemoryGame.Web
Microsoft.Asp.Net.SignalR x = ¢ [ Include prerelease Package source: nugetorg ~ £

‘B Microsoft.AspNet.SignalR &

) Microsoft.AspNet.SignalR @ by Microsoft, v2.3.0

Incredibly simple real-time web for .NET.
This package pulls in the server components a... Version: Latest stable 2.30 -~ Install

Figure 5-6. Install Microsoft.AspNet.SignalR NuGet package

The latest stable version as of the time of writing is v2.3.0. Once
installed, you should be able to see them added under the references folder:

Solution Explorer * O X ac
<

BE- ©0-SCID F= g
Search Solution Explorer (Ctrl+: P~ %
4 3] MemoryGame.Web al &

& Connected Services
b Properties
4 =B References
& Analyzers
=8 Microsoft.AspNet.SignalR.Core
=8 Microsoft. AspNet.SignalR.SystemWeb
=8 Microsoft.CodeDom.Providers.DotNetCompilerPlatfo
=8 Microsoft.CSharp

Figure 5-7. ASP.NET SignalR references

The Microsoft.AspNet.SignalR.Core is responsible for pulling in the
server components and JavaScript client required to use SignalR in our
application. Microsoft.AspNet.SignalR.SystemWeb contains components
for using SignalR in applications hosted on System.Web.

Install Microsoft.AspNet.Web.Optimization and then add the
following code under View » web.config:

<addnamespace="System.Web.Optimization"/>
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Adding a Middleware for SignalR

We need to create a middleware for SignalR so we can configure it for use
by creating an IApplicationBuilder extension method. Create a new class
at the root of the MemoryGame.Web project, name it “Startup.cs’, and
then replace the generated code with the following:

using Microsoft.Owin;
using Owin;

[assembly: OwinStartup(typeof(MemoryGame.Web.Startup))]
namespace MemoryGame.Web

{
public class Startup
{
public void Configuration(IAppBuilder app)
{
app.MapSignalR();
}
}
}

The preceding configuration will add the SignalR services to the
pipeline and enable us to use ASP.NET SignalR real-time capabilities in our
application.

Adding a Hub

Next is to add an ASP.NET SignalR Hub. Add a new class at the root of the
project and name it “LeaderboardHub.cs”. Replace the default generated
code with the following code:
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using Microsoft.AspNet.SignalR;

namespace MemoryGame.Web

{
public class LeaderboardHub : Hub
{
public static void Broadcast()
{
IHubContext context = GlobalHost
.ConnectionManager
.GetHubContext<LeaderboardHub> () ;
context.Clients.All.displaylLeaderBoard();
}
}
}

The LeaderboardHub inherits the Hub class and contains a static
class called Broadcast.

The Hub is the centerpiece of the SignalR. Similar to the concept of
Controller in ASPNET MVC, a Hub is responsible for receiving input and
generating the output to the client.

To make it clearer, the following class:

public class LeaderboardHub : Hub
will generate the following JavaScript client proxy:
var hubProxy = $.connection.leaderboardHub;

By default, JavaScript clients refer to Hubs by using a camel-cased
version of the class name. SignalR automatically makes this change so that
JavaScript code can conform to JavaScript conventions. The preceding
example code would be referred to as leaderBoardHub in JavaScript code.
We'll take a look at how we are going to invoke the Hub from our JavaScript

code later in this chapter.
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The Broadcast() method creates an instance of the IHubContext

interface. IHubContext provides access to information about an ITHub and
basically exposes two main properties, which are the Clients and Groups.
In this example, a connected client can call the Broadcast server method
and displayLeaderBoard client proxy method, and when it does, the data
received is broadcast to all connected clients, as shown in the following

figure:

Server Invocation

LeaderboardHub | displayleaderBoard
Server e Sl Client
(.NET) (HTIL Javascripe)

$.connection, leaderboardHub.client.displaylLeaderBoard()

Client Invocation

LeaderboardHub ‘ ‘ displayleaderBoard
Server el ) Client
(-NET) (HTML Javascript)

%.connection.leaderboardHub.server.broadcast()

Figure 5-8. SignalR client-to-server invocation and vice versa

SignalR handles connection management automatically and lets you
broadcast messages to all connected clients simultaneously, like a chat
room. You can also send messages to specific clients. The connection
between the client and server is persistent, unlike a classic HTTP
connection, which is re-established for each communication.
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SignalR provides a simple API for creating server-to-client remote
procedure calls (RPC) that call JavaScript functions in client browsers (and
other client platforms) from server-side .NET code. SignalR also includes
API for connection management (for instance, connect and disconnect
events) and grouping connections.

Adding an API Endpoint

At this point, the MemoryGame.API Web API server doesn’t have
access to the Hub. Since the MemoryGame.API application was created
separately and will be hosted in a different server with different URL/ports,
then we need to create an API for exposing a public endpoint to that server
to communicate with SignalR.

Let’s go ahead and add a new Web API controller class. Right-click the
Controllers folder and then select Add » Web API Controller class (v2.1)
as shown in the following figure:

. e
b1 b Content
& View in Browser (Microsoft Edge)
> Task Runner Explorer 5
Configure External Tools... 3
Browse With...
[ Controller... Add » lasax
T Newitem... Ctrl+Shifts A Scope to This :’:’c':':"';'“
.confi
£ : =1 . 1

‘0O Existing tem... Shift+ Alt+ A B New Solution Explorer View =

MNew Scaffolded Item... Exclude From Project onfig

WLEdE i % o CerleX

Add ASP.NET Folder ¥ D"] Copy Ctrl=C

Container Orchestrater Support

REST API Client... X Delete Del

i ] Rename

£ Client-Side Library... Tearn Explorer

Mew Azure Weblob Project € Open Folder in File Explorer

: b ]

Existing Project as Azure Weblob > Properties Alt+Enter

Web API Controller Class (v2.1) 55 g‘ p

ADO.NET i M 1 - T

DO.NER Entity Data Mode Folder Name Controllers
*  Class. Shifts Alt+C
* 0w

Figure 5-9. Adding a new Web API controller class
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On the next screen, name the class “LeaderBoardAppController’, just
like in the following figure:

Specify Name for Item X

ltem name: iLeaderBoardAppController ]

| 0K | ] Cancel |

Figure 5-10. Setting a controller name

Click OK and then replace the default generated code with the
following code:
using System.Web.Http;

namespace MemoryGame.Web.Controllers

{
[RoutePrefix("api/ranking")]
public class LeaderBoardAppController : ApiController
{
[HttpPost,Route("")]
public void Broadcast()
{
LeaderboardHub.Broadcast();
}
}
}
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The LeaderBoardAppController class derives the ApiController

class, which enables it to become a Web API controller rather an MVC
controller. This class uses the RoutePrefix attribute to define a common
route prefix that is set to “api/ranking”.

The Broadcast() method class calls the static Broadcast method of
the LeaderboardHub class that we created earlier. Notice that the method
is decorated with the [HttpPost] and [Route] attributes. This signifies that
this method can be invoked only on a POST Http request and routes to “api/
ranking”. If you remember, setting the Route attribute to empty ( [Route(“”)] )
automatically maps to the base route defined at the class level.

Note You can also define a client proxy method outside the Hub via
IHubContext. For example, in your Web API controller action, you can
do something like in the following code:

[HttpPost, Route("")]
public void Broadcast()

{
IHubContext context = GlobalHost
.ConnectionManager
.GetHubContext<LeaderboardHub>();
context.Clients.All.displaylLeaderBoard();
}

Note If you want to use Hubs API for SignalR version 2 in .NET
clients, such as Windows Store (WinRT), WPF, Silverlight, and console
applications, then see https://docs.microsoft.com/en-us/
aspnet/signalr/overview/guide-to-the-api/hubs-api-
guide-net-client
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Configure Web API Routing

The next thing that we are going to do is to configure Web API routing
within an ASP.NET MVC application.

Add a new class under the App_Start folder of the MemoryGame.Web
project. Name the class “WebApiConfig.cs” and copy the following code:

using System.Web.Http;

public static class WebApiConfig

{
public static void Register(HttpConfiguration config)
{
// Web API routes
config.MapHttpAttributeRoutes();
}
}

The preceding code enables attribute-based routing for Web API.

The final step is to register the WebApiConfig class in Global.asax. In
the Application_Start method of the file Global.asax.cs file, add a call to
GlobalConfiguration.Configure() method; be careful to place it before
the call to RouteConfig.RegisterRoutes(RouteTable.Routes):

using System.Web.Http;
using System.Web.Mvc;
using System.Web.Routing;

namespace MemoryGame.Web

{
public class MvcApplication : System.Web.HttpApplication

{
protected void Application Start()

{
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AreaRegistration.RegisterAllAreas();

GlobalConfiguration.Configure(WebApiConfig.
Register);
RouteConfig.RegisterRoutes(RouteTable.Routes);

Again, take note of the registration sequence in your code or
the routing won’t work properly and you will end up getting an
unexpected behavior.

Enabling APl Endpoint-to-Endpoint
Communication

Now that we're done creating an API endpoint for invoking SignalR
communication, we need to modify the UpdateScore() method of the
GameController class in the MemoryGame.API application. Head over to
MemoryGame.API project and drill down to API » GameController.cs
file, as shown in the following figure:
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fa] Solution ‘MemoryGame.App' (5 proje
4 ] MemoryGame.API
& Connected Services
b M Properties
b =B References

4 AP|
App_Data
b App_Start
Controllers
b Models

b &) Global.asax
¢.) packages.config
b ¢ Web.config

Figure 5-11. Navigating to the GameContoller class

Double-click the GameController.cs file to open it and then replace
the UpdateScore() method with this code:

[HttpPost, Route("score")]
public void UpdateScore(Rank user)

{
_gm.UpdateCurrentBest (user);
HttpClient client = new HttpClient();
var uri = new Uri($"http://localhost:57865/api/ranking");
client.PostAsync(uri, null).Wait();
}

What we did there is to add the lines of code for invoking the API endpoint
that we've created in the previous section using the HttpClient object.
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The preceding code is responsible for updating data in the database

and automatically broadcasts a trigger to SignalR to display real-time live
updates in the page.

Note You may need to change the value of Uri with the actual
URL at which your application is running. For this example,
localhost:57865 is the generated port number generated by Visual
Studio 2017 when running the application in debug mode.

Adding an MVC Controller

Let’s add a new MVC 5 controller file. To do that, right-click the
Controllers folder and then select Add » Controllers.

Add Scaffald ®
4 Installed
b Common MVC 5 Controller - Em
e ply
Controller % LBEEE v, by Microsoft
v3.0.0.0
‘[: MVC 5 Controller with read/write actions An empty MVC controller.

a MVC 5 Controller with views, using Entity Framework Id: MvcControllerEmptyScaffolder

‘[: Web API 2 Controller - Empty

Web AP1 2 Controller with actions, using Entity
Framework

#7 Web API 2 Controller with read/write actions

‘Web APl 2 OData v3 Controller with actions, using
Entity Framework

‘[: Web API 2 OData v3 Controller with read/write actior

[ o]

Select MVC 5 Controller - Empty and then click Add.
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On the next screen, set the name as “HomeController”. Click Add and
it should generate the following code:

using System.Web.Mvc;

namespace MemoryGame.Web.Controllers

{
public class HomeController : Controller
{
public ActionResult Index()
{
return View();
}
}
}

The preceding code is just an action method that throws an Index
View. For this particular example, we don’t really need to build the UI in
MVC with Razor, as we will be using only JavaScript and plain HTML to
generate the UL The MVC here is used only to launch a View, and that’s it.

Adding a View

Add a new View in the “Views/Home"” folder and name it “Index” Replace
the generated code with the following code:

<div id="body">
<section class="featured">
<div class="content-wrapper">
<hgroup class="title">
<hi>Leader Board</h1>
</hgroup>
</div>
</section>
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<section class="content-wrapper main-content clear-fix">

<h1>
<span>
Top Challengers
<imgsrc="~/Images/goals_256.png"style="width:40px;
height:60px;"/>
</span>
</h1>
<table id="tblRank" class="table table-striped table-
condensed table-hover"></table>
</section>
</div>

@section scripts{
@Scripts.Render("~/Scripts/jquery.signalR-2.3.0.min.js")
@Scripts.Render("~/signalr/hubs™)

<script type="text/javascript">
$(function () {
var hubProxy = $.connection.leaderboardHub;

hubProxy.client.displaylLeaderBoard = function () {
LoadResult();

};

$.connection.hub.start();
LoadResult();

B

function LoadResult() {
var $tbl = $("#tblRank");

$.ajax({
url: 'http://192.168.0.14:45455/api/game/players’,
type: 'GET',
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datatype: 'json',
success: function (data) {
if (data.length > 0) {
$tbl.empty();
$tbl.append(' <thead><tr><th>Rank</th>'
+ "<th></thy!
+ "<th></th>’
+ '<th>Best</th>'
+ '<th>Achieved</th>'
+ "</tr></thead > ');

var rows = [];
for (var i = 0; i < data.length; i++) {
rows.push('<tbody><tr><td>"

+ (1 + 1).toString() + '</td><td>'
+ data[i].FirstName + '</td><td>'
+ data[i].LastName + '</tdy><td>’
+ data[i].Best + '</td><td>'
+ data[i].DateAchieved
+ '</td></tr></tbody>");

}
$tbl.append(rows.join(“));

}
1
}

</script>
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Take note of the sequence for adding the client script references:

. jQuery
e jQuery.signalR
o /signalr/hub
jQuery should be added first, then the SignalR Core JavaScript and
finally the SignalR Hub script.
The reference to the SignalR-generated proxy is dynamically generated
JavaScript code, not a physical file. SignalR creates the JavaScript code for

the proxy on the fly and serves it to the client in response to the “/signalr/
hubs” URL.

Again, take note of the preceding script’s order sequence reference;
otherwise, SignalR client will not work.

For more information, see https://docs.microsoft.com/en-us/
aspnet/signalr/overview/quide-to-the-api/hubs-api-guide-
javascript-client

Let’s take a look at what we did there by breaking the code into
sections.

The LoadResult() function uses a jQuery AJAX to invoke a Web
API call through AJAX GET request. If there’s any data from the
response, it will generate an HTML by looping through the rows. The
LoadResult() function will be invoked when the page is loaded or when
the displayLeaderboard() client proxy method from the Hub is invoked.
By subscribing to the Hub, ASP.NET SignalR will do the entire complex
plumbing for us to do real-time updates without any extra work needed in
our side. Thanks, SignalR!

224


https://docs.microsoft.com/en-us/aspnet/signalr/overview/guide-to-the-api/hubs-api-guide-javascript-client
https://docs.microsoft.com/en-us/aspnet/signalr/overview/guide-to-the-api/hubs-api-guide-javascript-client
https://docs.microsoft.com/en-us/aspnet/signalr/overview/guide-to-the-api/hubs-api-guide-javascript-client

CHAPTER 5  BUILDING A SIMPLE REAL-TIME LEADERBOARD WEB APP WITH ASP.NET

SIGNALR AND MVC
Output

Here’s the final output when you deploy and run the project:

“ C @ localhost5786¢ * @

Leader Board

Top Challengers \,

Rank Best Achieved

1 Michelie Lorenzana 3 2018-09-25T08:20:42.42
2 Vianne Maverich Durano 2 2018-09-24T03.56:23.2
3 wynn Markus Durano 1 2018-09-25T03.16:00

& 2018 - My ASP.NET Application

Figure 5-12. Real-time leaderboard page

The preceding page uses SignalR Hub client-server communication
to automatically update the data without refreshing the page once a user
from the mobile app syncs their information and scores.
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Deployment and
Testing

This chapter discusses how to test and deploy our Xamarin.Android and
Xamarin.iOS apps in platform-specific device emulators to simulate

the process. During the development stage, it is required to test the
functionality of your applications. Visual Studio 2017 is equipped with
built-in device emulators to test your application without having the need
to use real devices, although it requires a few extra steps to simulate your
app in Mac. As long as your machine is properly configured, it should be
easy enough to test out your applications in Visual Studio.

Since the mobile application relies on API endpoints to communicate
with the data from the database, then the API endpoints should be publicly
accessible. Unfortunately, emulators do not have direct access to localhost.
This means that your Web API application project should be hosted in a
public-facing server or in the cloud, such as with the Azure web app, so
virtual device emulators can consume the API endpoints. However, going
to that approach to hosting the API publicly can be a big time-waster if we
are still at the early stages of the development. This is because any type of
change can happen during this stage and we don’t want to always push
changes to the public-facing serve, plus there’s no way for you to debug
your code and hit a breakpoint once your application is hosted publicly
on a different server or cloud. You may end up relying on your application
logs to troubleshoot any issues, which can be a time-consuming pain.
© Vincent Maverick S. Durano 2019 227
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To overcome this hurdle, we will use a freely available plug-in or tool
to test the application without needing to deploy it publicly on a different
staging server or cloud.

Using the Conveyor Plug-in for Visual
Studio 2017

Luckily, as mentioned, there’s an available plug-in that we can use to
access a local hosted web application from various devices emulators. The
plug-in is called Conveyor by Keyoti.

What Is Conveyor?

According to the documentation, Conveyor is used to

e Open up IIS Express to allow access over your local
network (e.g., access from phones, tablets, and other

devices).

e Tunnel a domain name to your machine, so anyone
on the web can access your web development project
through their browser.

o Fixmost 400 Bad Request errors coming from IIS
Express.

For more information about this cool plug-in, see https://keyoti.
com/blog/open-up-visual-studio-web-projects-for-access-over-
the-internet-using-conveyor/
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Install Conveyor

Let’s go ahead and install the Conveyor plug-in by navigating to the
Tools menu » Extensions and Updates. On the search bar, type the word
“conveyor”; the result will be something like this:

Extensions and Updates T ®
P Instalied Sort by: Relevance - cony X -k
4 Online

Created by: Jim - Keyoti

4 Visual Studio Marketplace = e
f Downloads: 28335
b Controls SR Vot
b Templstes {#%} Code Converter C# to/from VB.NET R et
b Tool LT Based on Roslyn, this converter allows you to convert CF code to B = o -
o VB.NET and vice versa eport Extension to Microsol
B Updates (2)
P Roaming Extensicn Manager n’ Case Converter
LS This is a simple visual studio extension to convert text between

snake_case, camelCase and PascalCaze.

VDProj to WiX Converter
VDProj to Wix Converter is an extension for Visual Studio that lets you
migrate your eisting Visual Studic setup projects to WiX with no codi...

Image Resize And Convert Tools Mane
‘You can resize, optimize and rotate your images easily from your VS Scheduled For Update:
Sohution Explorer. Also conversion support from * o PNG, GIF and J... e

y J L None

Change your Extensicns and Updates settings

Figure 6-1. Install Conveyor by Keyoti plug-in

Click Download. You may need close Visual Studio to continue the
installation, so make sure to save your work before attempting to install
this plug-in.
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Once the plug-in is ready to install, it should present you with the
following dialog:

[5 vsiX Installer X

Scheduled tasks for Microsoft Visual Studio Community 2017:
Install
Conveyor by Keyoti License
Digital Signature: Keyoti Inc. Release Notes

By dlicking "Modify", you agree with the
above license terms (if any) and the | Modify | | Cancel
installation of any prerequisites.

Figure 6-2. VSIX Installer license terms agreement
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Click Modify to start the installation. If you are prompted as shown in

the following figure, then just click the End Tasks button to close the listed
processes.

[-3 VSIX Installer

Waiting on the following processes to shut down before continuing with
modifications:

| |
- ServiceHub.SettingsHost.exe (ID 14068)

- ServiceHub.Host.Node.x86.exe (ID 11476)

- ServiceHub.VSDetouredHost.exe (ID 8816)

- devenv.exe (ID 4072)

- ServiceHub.|dentityHost.exe (ID 6092)

| EndTasks || Cancel

Figure 6-3. End existing running tasks
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After that, it should then continue the installation as shown in the
following figure:

B8 VSIX Installer

Modifying Microsoft Visual Studio Community 2017...

Updating configuration for Microsoft Visual Studio Community 2017

Figure 6-4. Modifying Visual Studio 2017 configuration
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When the installation is done, the following information should be
displayed:

=

Modifications Complete

Your modifications have been successfully applied. Please close
and restart all target application instances for changes to take
effect.

@ Conveyor by Keyoti

it g

Figure 6-5. Modifications complete

Click Close and then follow the next steps to add an inbound firewall
rule, allowing access to the TCP port given in the remote URL:

e Navigate to the Windows Search bar and type WE.msc.

Click “Inbound Rules” on the left pane.

e Click “New Rules” on the right pane.
e Choose “Port” in the new dialog, then click “Next”.

e Select TCP, enter port 45455 from the Remote URL
next to “Specific local ports’, and then click “Next”.

e Next, and Next (you may want to disable ‘Public’),
give it a name like ‘Conveyor: WebDev Server Access
Enabled’

¢ Click Finish.

233



CHAPTER6  DEPLOYMENT AND TESTING

Now, open Visual Studio 2017 and set MemoryGame.API as the
Startup Project. Do a clean and the rebuild, then run the application. It
should show the Conveyor window with some information including the
remote URL, just like in the following figure:

Conveyor by Keyoti
Local URL Remote URL
http://localhost:56393/ | http://192.168.0.14:45455/

Internet URL

http://localhost:56393/ | https://192.168.0.14:45456/

Email support@conveyor.cloud for help

Access over internet (beta)

Enabled: Use the Tools->Conveyor... menu item to disable it.
Figure 6-6. Conveyor Ul

Using the generated remote URL, we can now easily test the mobile
application’s whole process from different device emulators. All we need
to do now is replace the APIUri value from the GameAPI class with the
remote URL value.
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Copy the Remote URL value and stop Visual Studio debugging.
Navigate to MemoryGame.App project and open the GameAPI class
under the REST folder. Replace the value of the APIUri variable with the
value of the remote URL you copied earlier. In this example, the value of
APIUri would now become this:

privateconststring APIUri = "http://192.168.0.14:45455/api/
game/players”;

Using SharpProxy

Another option that you can use to test and debug your mobile
applications inside a simulator is a tool called SharpProxy. Here’s the
definition taken from the documentation (https://github.com/jocull/
SharpProxy):

SharpProxy is a simple proxy server developed with the intent of
being able to open up local ASP.NET development servers. This allows
you to test, hit breakpoints, and generally do development by using
other machines and mobile devices. Simply enter the local port number
of your .NET development server and map it with an external port to
host on.

Based on the preceding description, it seems like using SharpProxy is
the easiest way to test and debug the mobile application without doing a
lot of configuration. Let’s see how it does in action by following a few steps:

o Download SharpProxy from https://github.com/
jocull/SharpProxy

e Unzipp the file, and then run the SharpProxy project;
it should display the following screen:
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SharnProy

Your IP Address
192.168.0.14 v
Extemal Port
15000 |
Intemal Port

(] Rewrite host headers (IS Express)

Start

Figure 6-7. SharpProxy Ul

o Navigate to Visual Studio, right-click MemoryGame.
API on the project, and then select Properties. Click
the web item from the left pane and you should see
something like this:
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MemoryGame APl + X

Apphcation
yz N/A N/A
Build
Start action

Package/Publish Web -

(®) Current Page
Package/Publish SQL

O ific P.
Build Events L2 5paciic Bage
Resources () Start external program
wHtinge Command line arguments
Reference Paths

Werking directory

Signing
Code Analysis O Start URL

(O Don't open a page. Wait for a request from an extemal application.
Servers
EA Apply server settings to all users (store in project file)

IIS Express «  Bitness  pafayle v

el [ nttp://tocalhost: 56393/

[[] Override application root URL

http/localhost:56393
Debuggers

EA ASP.NET [[] Native Code [ SQL Server

A Enable Edit and Continue

Figure 6-8. MemoryGame.API property configuration window

o The Project Url field from the preceding figure
indicates the local URL where the API should run in
debug mode. Take the 56393 value from the URL.

o Enter the 56393 port number in the Internal Port field
of the SharpProxy UL

e Copy the IP Address generated from the SharpProxy
and the External Port number. For this example, the
values should be 192.168.0.14 for the IP address and
5000 for the external port.
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e Now, when your Android or iOS app is running in the
emulator, you can simply reference the following URL
to access your API: http://192.168.0.14:5000

o Navigate to the MemoryGame.App project and open
the GameAPI class under the REST folder. Replace the
value of the APIUri variable with the following:

privateconststring APIUri = "http://192.168.0.14:5000/
api/game/players”

Your Xamarin.Android and Xamarin.iOS applications should now be
able to access the Web API endpoints.

Simulating the Application’s Process

At this point, we are not ready to test our applications locally. Since

the application is composed of many projects and the ASP.NET.MVC
application also relies on our Web API application, we need to make the
Web API application accessible when testing the real-time leaderboard
page too. Now, you might be asking yourself how to run them altogether
at once. Typically, we would host or deploy both projects in the local IIS
web server to be able to connect between projects. Luckily, one of the cool
features of Visual Studio 2017 is to enable multiple startup projects. This
means we could run both our Web API and MVC applications as well as
the mobile application together within Visual Studio and be able to test
them right away. All you need to do is

¢ Right-click the Solution
o Select Set Startup Projects

o Select the Multiple Startup Projects radio button
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o Select “Start” as the action for MemoryGame.AP],
MemoryGame.Web, MemoryGame.App.Android,
and MemoryGame.App.iOS projects as shown in the

following figure:
N/A N/A Configuration Manager..
[ 4 Common Properties (O Current selection
o (O Single startup project

Project Dependencies

Code Analysis Settings

Debug Source Files (®) Muhtiple startup projects:
b Configuration Properties

MemoryGameApp.i0S

Project Action
MemoryGame. API Start
| MemoryGame.Web Start
MemoryGame App None
MemoryGame.App Android Start
MemoryGame App.i0S Start
oK Cancel Apply

Figure 6-9. Set multiple startup projects

e Click Apply and then OK

Now Build and press Ctrl + 5 to run all applications simultaneously.
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Android

Here are screenshots of the different views of the Xamarin.Android
application that are running within an Android device emulator:

Home Screen Congratulation Pop-up Successful Syne

A Erndani - Andovsd e ieerated o6 Covn 51 et Eroudstos  Aevdecnd o shrates 456 Creatit

Best:
Level 2

SYNC LOGOUT

Congrats! Sync

Level 1
You've got it all right Data synced!

; ! and made it to level 2.
Continue?

The light will blink on, the speaker will
beep and the device will vibrate at
different times. Try to count how many
times each one happens.

Figure 6-10. Android device emulator outputs
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Here are screenshots of the different view scenarios of the Xamarin.iOS

application that are running within an iPhone device emulator:

Home Screen

Sync Logout

Level 1

@

The light will blink on, the speaker will beep and
the device will vibrate at different times. Try to
(count how many times each one happens.

Start

Figure 6-11. iPhone device simulator outputs

Next Steps

Answer Screen

Carriar T AT PM -

How many times did the light blink, the speaker
beep and the device vibrate?

Done

Game Over Pop-up

- a ] o o

Game Over!
Your curent best is at level 1. Retry?

Mo Yes

Simulators are a good place to start deploying, testing, and debugging
an application at the early stage of development. However, users will not

consume the final application in a simulator, so applications should be
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tested on real devices early and often. For more information about Android
and iOS device provisioning, see the following:

o https://docs.microsoft.com/en-us/xamarin/ios/
get-started/installation/device-provisioning/

o https://docs.microsoft.com/en-us/xamarin/
android/get-started/installation/set-up-device-
for-development

Output

Just to give you proof that this application really runs on a real device,
here’s an actual shot of the output when deploying and running the app:

Figure 6-12. Live output
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CHAPTER 7

Pushing Your Code
to GitHub

In software development, securing your code is always a top priority.
Unexpected circumstances can occur with your development machine,
and of course, you don’t want to lose all the hard work and effort that
you put in building the software application. Even if you're just building
a simple prototype and working alone for a project, you never know
when more people might be brought onto the project. Typically, when
developing an app, here’s a common approach:

¢ You're working with some new code to get it to work

e You don’t want to break your existing code, so you copy
your current code to another folder (Folder A) and
continue working in Folder B

o Ifyou make a mistake, you just delete Folder B and
resume with Folder A
This approach is the idea behind version control. Version control is a
process that lets you keep checkpoints of your code so that you can refer
back to them if needed.
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Git is a widely used version control system used to manage code. Code
managed with Git is called a Git repository. Also, repos allow you to roll
back when you accidentally add something that doesn’t work.

This chapter talks about how to push software source code to GitHub.
GitHub is a popular hosting service for source code repositories (Git
Repo). Here’s a brief definition of GitHub from the documentation.

GitHub Inc. is a web-based hosting service for version control using
Git. It is mostly used for computer code. It offers all of the distributed
version control and source code management (SCM) functionality of
Git as well as adding its own features. It provides access control and
several collaboration features such as bug tracking, feature requests, task
management, and wikis for every project.

Microsoft announced that it reached an agreement to acquire GitHub
in June 2018 and closed the purchase at the end of the same year.

Using Visual Studio to Push Source Code
in GitHub

The first thing you need to be able to push your code in GitHub is a GitHub
account. If don’t have one, then you can register here: https://github.
com/join?source=header
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Download GitHub Extension for Visual Studio

In Visual Studio, select Tools » Extensions and Updates. Click the Online
tab in the left pane, and it should present you something like this:

Extensions and Updates ?
b Installed Sortby: Most Downloads ' Search (Ctri~E P-
4 Online o
| GitHub Extension for Visual Studio I Download
b Visual Studio Marketplace ' ;::”Qmm Extensi brings the GitHub Flow into m’:;:‘::?
b Updates (2) Rating: « e diﬂ Wotes)
b Roaming Extension Manager ? SQLite for Universal Windows Platform Release Notes

SOLite 15 3 software library that implements a self-contained, serverless, zero-

configusation, transactional SOL database engine. More Information

Report Extension to Microsalt

J: } Azure Data Lake and Stream Analytics Tools
L Anintegrated development environment for Azure Data Lake and Stream
Analytics application development.

22 Microsoft
(F, Aure Functions and Web Joks Tools L]

Tools far creating and publishing Azure Functicns and Web Jobs

5% Microsoft
H"-‘“ Microsoft Analysis Services Projects Scheduled tall
L= Microsoft Analysis Services projects provide project templates and design e

surfaces for building professicnal data models hosted in SQL Server Analysi.. Kaone

B Microsoft Scheduled For Update:
? SalLite for Windows Runtime fione

SCQlite is a software library that implements a self-contained, serverless, zero- ™ Scheduled For Uninstall:

12345 None

Change your Extensions and Updates settings

Figure 7-1. Adding GitHub extension for Visual Studio
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Click Download. You may need to reboot Visual Studio to proceed
with the installation of the GitHub extension. After a reboot, you will be
prompted with the following screen:

CHE

Scheduled tasks for Microsoft Visual Studio Community 2017:
Install
GitHub Extension for Visual Studio License

Digital Signature: GitHub, Inc. Release Notes

By clicking "Modify", you agree with the
above license terms (if any) and the | Modify | l Cancel
installation of any prerequisites.

Figure 7-2. VSIX Installer license terms agreement
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Click Modify. You may also be required to end some processes before
starting the modification.

Publishing Your Code

After the installation, navigate to the Team Explorer panel as shown in the

following figure:
Team Explorer - Connect * 3 X
DY O P
Connect | Offline >

Manage Connections
4 Hosted Service Providers

‘A' Visual Studio Team Services

Microsoft Corporation

Services to help you ship high quality
software. On time, every time. Focus on your
code. We'll simplify the rest.

Connect... Get started for free (3)
GitHub
GitHub, Inc.

Powerful collaboration, code review, and
code management for open source and
private projects,

Connect.. Signup @
4 Local Git Repositories
New v | Add « | Clone | View Options »

Add or clone a Git repository to get started,

Figure 7-3. Connecting to GitHub
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Click Connect, and you should be presented with the GitHub login
screen:

Connect To GitHub x

GitHub
Sign in

GitHub GitHub Enterprise

Ipsemameoremail @l

Password

or

Sign in with your browser [®

Don't have an account? Sign up

Figure 7-4. GitHub login screen
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Enter your GitHub account credentials to continue.
On the Solution Explorer, right-click the project Solution and select
Add Solution to Source Control just like in the following figure:

[:1 Build Solution F6 [
Rebuild Solution
Clean Solution
Analyze »
Batch Build...
Configuration Manager...
#8 Manage NuGet Packages for Solution...
[ Restore NuGet Packages
New Solution Explorer View
Calculate Code Metrics
Add ’
£} Set StartUp Projects...

+

Add Solution to Source Control...

Rename

O
¢® Open Folder in File Explorer
y

Properties Alt+Enter

Figure 7-5. Adding solution to source control
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This action creates a local git repository with .gitattributes and
.gitignore files, as shown in the following figure:

-

Name Date modified Type
MemoryGame.API 9/30/2018 4:20PM  File folder
MemoryGame.App 9/22/2018 6:04PM  File foldes
MemoryGame.Web 9/30/2018 7:.04 PM File folder
packages 9/30/2018 4:20PM File folder

[ | .gitattnbutes 9/30/2018 8:10PM  GITATTRIBUTES File

[ ] .gitignore 9/30/2018 8:10PM  GITIGNORE File

&) MemoryGame.App.sin 9/25/2018 2:26 AM  Visual Studio Solu

.gitignore ignores untracked files—those that haven’t been added
with git add; .gitattributes are for tracked files. That is, one file could be
processed with .gitattributes and two others could be ignored (just an
example).

For more information about customizing how changed files appear
on GitHub, see https://help.github.com/articles/
customizing-how-changed-files-appear-on-github/

Switch back to the Team Explorer pane, and you will see a local Git
Repository added as shown in the following figure:

4 Local Git Repositories (1)
New v | Add + | Clone | View Options

» MemoryGame.App C:\Users\user\source\repos\...

Figure 7-6. Local Git repositories

250


https://help.github.com/articles/customizing-how-changed-files-appear-on-github/
https://help.github.com/articles/customizing-how-changed-files-appear-on-github/

CHAPTER 7  PUSHING YOUR CODE TO GITHUB

Double-click the MemoryGame.App repo, and it should present you
with the following screen:

Team Explorer - Home v+ o X

Omi 0 Search Work ltem trl+ p_
Home | MemoryGame.App -

4 Project

® Changes Iv Branches
'N’ Sync |D Tags

'a- Settings

4 Solutions
New... | Open... | Show Folder View

] MemoryGame.App.sin

Figure 7-7. Sync code
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Click Sync and it should present you with the following screen:

Team Explorer - Synchronization

© O @ ¥ | & |Search Work tems (Ctl- o

Push | MemoryGame.App

Backup and share your code. Publish it to a Git
service.

4 Push to Visual Studio Team Services

Team Services
Microsoft Corporation

Unlimited free private Git repos, code review, work items,
build, and more. Learn more
Publish Git Repo

4 Publish to GitHub

GitHub
GitHub, Inc

Powerful collaboration, code review, and code
management for open source and private projects.

Publish to GitHub

4 Push to Remote Repository

There is no remote configured for this local repository.
Establish the remote by publishing to the URL of an existing

empty repository.
Publish Git Repo

Figure 7-8. Publish to GitHub
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Click Publish to GitHub. On the next screen, enter a Name and
Description for your repository just like in the following figure:

4 Publish to GitHub

This repository does not have a remote. Fill out
the form to publish it to GitHub.

GitHub -

. proudmonkey
Apress-Game-Development-Xamarin,Forms-ASPNET

Bource code for building a simple working memory

L ACD BIFT

LT Y

Private Repository

Publish

Figure 7-9. Commit publish
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Click Publish.
When successful, it should create an empty GitHub repo to your
GitHub account portal as shown in the following figure:

Team Explorer - Home * 0 X

Home | MemoryGame.App

© Install 3rd-party Git command prompt tools, x

Help | Don't prompt again
© Repository created successfully.
4 GitHub
ﬂ proudmonkey/Apress-Game-Development-Xamann....

https://qithub.com/proudmonkey/Apress-Game-De..

4 Project
(© (changes ' Branches
n Pull Requests TN sync
D Tegs A Pulse

lily Graphs @) 1ssues
EE ws £} Settings

4 Solutions
New...| Open... | Show Folder View

2] MemoryGame.App.sin

Figure 7-10. Repository created successfully
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Click the Changes item and you should be presented with this:

Team Explorer - Changes * o X
() Gj ? o Search Work Items (Ctrl+ P~
Changes | MemoryGame.App - |7l

Branch: master

Enter a commit message <Required>

Commit All | +| Actions «

4 Changes (143) + -

4 &l C:\Users\user\source\repos\MemoryGame.App =
4 | MemoryGame.AP|

4 &l API

€® GameController.cs [add]
4 &l App_Start

€* WebApiConfig.cs [add]
4 | Models

4 &l DataManager
€* GameManager.cs [add)]
4 &l DB
C* Challenger.cs [add]
€* MemoryGameDB.Context.cs [add]
B MemoryGameDB.Context.tt [add]
€* MemoryGameDB.cs [add]
C€* MemoryGameDB.Desianer.cs [add] %

Figure 7-11. Enter a commit message
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Enter a message for your first commit and then select Commit All and
Push as shown in the following figure.

Changes | MemoryGame.App

Branch: master

Initial Commit

Commit All v Actions =

. = CommitAll
= Commit All and Push

= Commit All and Sync

Figure 7-12. Commit all and push command

This command stores all your changes locally and pushes them to
your GitHub remote repository URL. The following figure shows when a
successful commit and push is done.
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Team Explorer - Synchronization * QX

Pl

S - @®¥ O

Synchronization | MemoryGame.App

w

© Successfully pushed to origin/master.
Branch: master
Sync | Fetch | Pull | Push | Actions

4 Incoming Commits
Fetch | Pull

There are no incoming commits.
4 Outgoing Commits

Push | View Su mmary

There are no outgoing commits.

Figure 7-13. Source code successful pushed to GitHub

X

To verify that your changes were really pushed to your GitHub

repository account, you can navigate to the GitHub repository URL

generated from the previous step. For this example, it generates this

remote URL:

https://github.com/proudmonkey/Apress-Game-Development-Xamarin.

Forms-ASPNET
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Here’s a screenshot of the source code repository published on GitHub:

- proudmonkey / Apress-Game-Development-Xamarin.Forms-ASPNET @Wach 1 *S 0 Yrork 0

<> Code Issues 0 Pull requests 0 Projects 0 Insights

Join GitHub today Dismiss

GitHub is home to over 28 million developers working together to host
and review code. manage projects. and build software together.

Sign up

Source code for building a simple working memory game with Xamarin.Forms and ASP.NET

{p 2 commits ¥ 1 branch » O releases &L 0 contributors
Vincent Maverick $ Durana Inmal commi Latest commit e3458a9 8 minutes ago

| MemoryGame. AP Initial commit

W MemoryGame App

Figure 7-14. GitHub public source code repository

For more information about using GitHub, see https://guides.
github.com/activities/hello-world/

GitHub Repository and Source Code

You can view and fork the source code here: https://github.com/
proudmonkey/Apress-Game-Development-Xamarin.Forms-ASPNET
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